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WARRANTY

Tektronix warrants that this software product will conform to the specifications in the documentation provided with the

product, when used properly in the specified operating environment, for a period of three (3) months. The warranty period

begins on the date of shipment, except that if the program is installed by Tektronix, the warranty period begins on the date

of installation or one month after the date of shipment, whichever is earlier. If this software product does not conform as

warranted, Tektronix will provide remedial services as described in the documentation provided with the product.

Tektronix does not warrant that the functions contained in this software product will meet Customer’s requirements or that

operation of the programs will be uninterrupted or error-free or that all errors will be corrected.

In order to obtain service under this warranty, Customer must notify Tektronix of the defect before the expiration of the

warranty period and make suitable arrangements for such service in accordance with the instructions received from

Tektronix. If Tektronix is unable, within a reasonable time after receipt of such notice, to provide remedial services,

Customer may terminate the license for this software product and return this software product and any associated materials

to Tektronix for credit or refund.

This warranty shall not apply to any software product that has been modified or altered by Customer. Tektronix shall not be

obligated to furnish service under this warranty with respect to any software product a) that is used in an operating

environment other than that specified or in a manner inconsistent with the User’s Manual and documentation or b) when

the software product has been integrated with other software if the result of such integration increases the time or difficulty

of analyzing or servicing the software product or the problems ascribed to the software product.

THIS WARRANTY IS GIVEN BY TEKTRONIX IN LIEU OF ANY OTHER WARRANTIES, EXPRESS OR

IMPLIED. TEKTRONIX AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF

MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. TEKTRONIX’ RESPONSIBILITY TO

PROVIDE REMEDIAL SERVICE WHEN SPECIFIED, REPLACE DEFECTIVE MEDIA, OR REFUND

CUSTOMER’S PAYMENT IS THE SOLE AND EXCLUSIVE REMEDY PROVIDED TO CUSTOMER FOR

BREACH OF THIS WARRANTY. TEKTRONIX AND ITS VENDORS WILL NOT BE LIABLE FOR ANY

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER

TEKTRONIX OR THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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What’s in this Manual

The CSS500 System Software is Microsoft Windows-based software to control

and display measurement results of the Cable TV CMP500 test equipment

(VM700A, TDC-10, 1450A, 2714, 2715, TV1350, Rohde & Schwarz EMFP,

and switcher). The point and click user interface makes operation easy, even for

the inexperienced user. Making a measurement is as simple as selecting a

channel and measurement type and clicking a mouse. In addition, the package

can automatically monitor all in-service baseband and RF measurements and

signal an alarm when a measurement exceeds a specified limit.

Measurement results are displayed in a table of channel vs. measurement type.

For any measurement on a particular channel, the user simply clicks the mouse

on that data cell, and a window appears with more information.

As with other Windows-based software, CSS500 data is exportable to other

Windows-based software, such as Microsoft Excel, for in-depth data analysis.

If you have any problems using this product, please call the Tektronix help line

at:

1-800-TEK WIDE (1-800-835-9433)

This manual assumes that you are familiar with Windows 3.1. Please refer to the

Windows tutorial in the Windows reference manual for more information if you

are not comfortable with Windows.

This manual is organized as three primary sections and a set of appendices. The

three primary chapters and their contents are:

@ Getting Started—which consists of a chapter on installing the software.

= Operating Basics—a tutorial for the beginning user.

TM Reference—which contains several chapters that provide detailed information

about the software. The chapters describe the CSS500 worksheet, the menu

bar and menus, and provide advanced information on setups and measure-

ments.
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The contents of the appendices are:

= A Menu Map to give you a quick overview of the CSS500 software.

m A listing of error messages.

= Anexplanation of how to use the Channel Table Editor.

TM Guidelines for using the CSS500 application to meet FCC measurement

requirements for monitoring a cable system.

= Information about the CSS500 files (how to archive worksheets, file

sizes, and other information).

= A wiring diagram to connect the test instruments to each other and to the

controlling PC.

= Anexplanation of how to control a 2714/2715 over a modem.
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This chapter describes how to install the CSS500 Cable Television Systems

software.

Contents of CSS500 Package

One 3/4 inch diskette, Tektronix part number 063-1587-02

a This manual, part number 070-8806-03

Hardware Requirements

Minimum computer requirements for CSS500 to operate properly:

MS-DOS compatible 16 MHz 386 personal computer with hard drive

(486-33 is recommended)

MS-DOS 5.0

Microsoft Windows 3.1

NOTE. Microsoft Windows NT is not recommended.

VGA display

Video Display board for View Picture Mode — Optional

(Video Blaster® recommended)

2 MB of RAM (8 MB recommended)

4 MB of free space on the hard drive

GPIB or RS-232 interface. The GPIB hardware is assumed to be National

Instruments GPIB-PCIIA with version 2.1.1 of the GPIB driver software.

(Tektronix provides an appropriate GPIB board and driver software in the

S3FG210 PC GPIB Package.) If using RS-232 ports, make sure that your

computer has enough Com Ports.

NOTE. If more than one GPIB board is installed, CSS500 must use board GPIBO.

= Mouse or other pointing device is recommended but not required
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Software Installation

If you also have CSS150 installed on your computer, please see Appendix E for

some special things to consider before installing CSS500.

Step-by-Step Procedure to Install the CSS500 Software

1. Check the README.TXT file on the distribution diskette, for any additional

information. This is important if you are upgrading from a previous version.

NOTE. If you are upgrading from a previous version, do not put the new version

in the same directory as the old version. This will make the installation go much

faster and prevent overwriting any of your customizations. If you choose not to

(or forget to) create a new directory, the install program questions you before it

overwrites a file. At that point, you can choose not to overwrite any customized

files.

When the installation is complete, you can move any of your custom files to the

new directory. These files include: CSS500.INI, *.HLP files (to the help

sub-directory), *.LIM files (to the limit sub-directory), and *.CHT files.

2. Create a directory on your hard drive where you want the CSS500 software

installed.

For example, to create the directory “CSS500” on the C drive, type:

C:<enter> (Puts you in the C drive.)

CD\<enter> (Puts you at the root of the C drive.)

MKDIR CSS500<enter> (Creates the CSS500 directory.)

CD CSS500<enter> (Changes to the CSS500 directory.)

3. Copy the files from the distribution diskette to the directory created in step 2.

For example, to copy the files from the B drive to C:\CSS500,

insert the distribution diskette into the B drive and type:

XCOPY B:*.* <enter> (Copies everything from the B drive into the

current directory C:\CSS500.)

4. Install the CSS500 software.

From the directory created in step 2, run the INSTALL.BAT batch file by

typing:

INSTALL.BAT <enter> (This batch file creates all the program files and

directories required for the CSS500 software.)

5. Create the Windows Program Group and Program Items.
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Enter Windows, then follow the Windows Program Manager instructions to

create a Program Group and Program Item for the CSS500 application

(CSS500.EXE). Optionally, a Program Item for the Channel Table Editor

(CTLOADE.EXE) can also be created.

NOTE. If you are upgrading from a previous version, you should now move your

custom files into the appropriate directory.

6. After completing the installation, you can remove the INSTALL.BAT and

SETUPCSS.EXE files to save disk space.

Results of the Software Installation®e000

ee2oe2ee0e0 0
J

eee

Windows Program Items

Directories Created

The following lists the program items, directories, and files created as a result of

the CSS500 installation.

CSS500.EXE (CSS500)

CTLOADE.EXE (Channel Table Editor)

CSS500 (or whatever you chose to call it)

m Sub-directories of CSS500:

HELP LIMITS

List of Files Table 1-1: Files contained in CSS500 directory

INSTALL.BAT EUR-BG.CHT TBPRO1W.DLL

README.TXT EUR-|.CHT TBPRO2W.DLL

SETUPCSS.EXE EUR_BG.CHT TBPRO3W.DLL

EXPORTDB.EXE EUR_I.CHT TBPROS5W.DLL

CTLOADE.EXE EUR_I1.CHT TEKIO.DLL

CSS500.EXE HRC.CHT CTLOADD.DLL

B’CAST.CHT IRC.CHT MSMT.DLL

CATV-HRC.CHT JAPAN-M.CHT MSMTSTUB.DLL

CATV-IRC.CHT JAPAN-M.CHT MSMTREAL.DLL

CATV-STD.CHT STD.CHT RELEASE.LOG

CHINA-DK.CHT STDOFST.CHT CSS500.INI

CHIN_DK.CHT STNDRD.CHT CTLOADE.INI
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LIMITS Sub-Directory NTSC.LIM PAL.LIM

NOTE. All Channel Table and Limits files provided with the CSS500 application

are Read Only.

HELP Sub-Directory = All the help files are in this sub-directory. See Appendix E for how to edit these

to fit your special requirements.

Hardware Installation

Minimum Equipment —_Not all equipment must be installed to operate CSS500. If only some of the

Installation | equipment is installed, use Table 1—2 to determine the available measurements.

Table 1-2: Equipment required to make the various measurements

Measurement BB2

Visual Carrier Level

Visual Carrier Frequency

Aural Carrier Level

Aural Frequency Offset

Second Aural Level

Second Aural Frequency Offset

Average Power

Carrier to Noise

Desired to Undesired

CSO

CTB

Cross Modulation

In-Channel Response?

Adjacent Channel Leakage

Hum/LFD

FCC Baseband a

Modulation Depth?

Aural Deviation

VIX XP XEN XEN RP LENE XEN] XN ADR
X

\

Signal to Noise nw
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Table 1-2: Equipment required to make the various measurements (Cont.)

Measurement RF! BB2

Waveform Distortion a

Multiburst a

ICPM al

Audio nw

1

2

RF equipment includes the 271X.

BB (Baseband) equipment includes: the VM700A, and the 1405A/TDC10

combination, the TV1350 Demodulator, or the Rohde & Schwarz EMFP. A

switcher is optional.

If both columns are checked, use either RF or BB equipment to make the

measurement.

Test Equipment

The following test equipment is required to complete this installation:

mTM 271X Cable TV Spectrum Analyzer (271X can be either a 2714 or a 2715. If

either instrument can be used, then 271X is called out. If something is

instrument specific, then one or the other is called out.)

m= If the 271X has option 08 installed, an RS-232 cable is required. The 25-pin

RS-232 cable is Tektronix part number 012-1380-00. The 9-pin RS-232

cable is Tektronix part number is 012-1379-00.

m= VM/700A Video Measurement Set.

@ 1450A Demodulator, aTV1350 Demodulator, or a Rohde & Schwarz EMFP.

= TDC-10 Tunable Down Converter (not required if using a TV1350 Demodu-

lator or a Rohde & Schwarz EMFP).

= Three GPIB cables are needed to connect all the equipment to the PC (only 2

cables are needed if the 271 X uses RS-232). The cables are Tektronix part

number 012-0991-01 (for 1 meter length).

= A VITS Inserter. (This may be required if you are using a switcher.)

m An Audio Generator. (May be required to make audio measurements.)

Please see Appendix F for how the equipment should be connected for proper

operation. (You can use just some of the equipment. See Table 1—2 for more

information.) See the test equipment manuals for any additional hardware

information.
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CSS500 can only use one of each type of test equipment. For example, if you

have two 271 Xs in your system, CSS500 can only use one of them to make its

measurements. Please specify the appropriate GPIB address of the particular

271X to be used.

To Install the Equipment

1-6

GPIB Board

271X

Use the following procedures to install the equipment.

Note that CSS500 forces the GPIB board (GPIBO) to have an address of 30.

Install the National GPIB hardware and Software for Windows using the

instructions provided in National’s manuals with the following settings:

Table 1-3: GPIB board settings

DMA Channel NONE

IRQ NONE

The following lists how the 271X (both GPIB and RS-232 versions) should be

configured.

Table 1-4: 271X (Option 03) GPIB

Status ONLINE

GPIB Address 11

Power On SRQ ON or OFF

EOI/LF Mode LF/EOI

Talk Only Mode OFF

1 This is restricted only in that it must be a unique

address between 0 and 29

Table 1-5: 271X (Option 08) RS232

Status ONLINE

Baud Rate 96001

Data Bits 8

Parity NONE

EOL LF

Flow Control HARD (RTS/CTS)
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Table 1-5: 271X (Option 08) RS232 (Cont.)

Echo OFF

Verbose OFF

1 Device baud rate is selectable through the CSS500

Connections menu. Other communications

parameters must be set to these values.

VM700A GPIB The following lists how the VM700A GPIB should be configured.

Table 1-6: VM700A GPIB configuration

Remote Control Port: GPIB

GPIB Device Address: 91

1 This is restricted only in that it must be a unique

address between 0 and 29

TDC-10 — The following lists how the TDC-10 should be set.

Table 1-7: TDC-10 settings

GPIB Status ONLINE

Address 3!

Other Output IF Must match that required

by the 1450A

1 This is restricted only in that it must be a unique

address between 0 and 29

1450A Front Panel The 1450A is not under direct control of CSS500, but its Detection Mode is

Settings controlled by the TDC-10.

Table 1-8: 1405A front panel settings

Detection Mode BACK PORCH

Synchronous Time Constant | NORMAL

Sound Trap IN

Internal Zero Carrier Ref. ON

10dB Attenuator OUT

20dB Attenuator OUT
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TV1350 Demodulator and

Rohde & Schwarz EMFP

Settings

Switcher Settings

Table 1-8: 1405A front panel settings (Cont.)

Auto BACK PORCH

AGC Speed FAST

The Zero Carrier Reference Pulse setting is controlled by a jumper within the

1450A. Refer to the 1450A manual for how to set this parameter.

CSS500 controls the front panel settings. Therefore, no matter what the front

panel on the instrument indicates, the actual control parameters are in the

CSS500.INI file and set by the Demodulator Setup dialog box. See Select the

Correct Demodulator and Configure the Connections, on page 1-8, for how to

set the variables.

A jumper within the TV1350 controls the Zero Carrier Reference Pulse. Refer to

the TV1350 manual for how to set this parameter.

The switcher settings must be appropriate for your switcher. Since many

different switchers can operate with CSS500, please check your switcher

documentation for the correct parameter values.

The Delay parameter is used whenever the delay flag is given in the Switcher

String, /FF and at the end of the Switcher String. The delay is given in seconds.

(Please see Appendix C for how to use the Switcher String.)

= Switcher Control Port

= Baud Rate

= Flow Control

m= Parity

= Stop Bits

= Data Bits

m Delay

Select the Correct Demodulator and Configure the Connections

1-8

CSS500 must know which kind of demodulator is connected in your system.

CSS500 will run with either a TDC-10/1450A combination, a TV1350, or an

EMEP. The first time that you run CSS500 you need to check that CSS500

knows your equipment setup.
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1. Start CSS500 by clicking on the icon (created during software installation)

or run CSS500.EXE from the command line.

When the CSS500 start-up is complete, choose Demodulator from the

Configure menu. The display will be similar to Figure 1-1. The checked

demodulator is the one selected. Choose the correct one for your system.

Worksheet |

Test ID...

nfo...

Preferences...

Measurement Sequence...

Measureme

KMeasureme

nt Limits...

nt Setups...

Connections...

Demodulator ¥TDC-10/ 14504

T¥1350...

Rohde & Schwarz EMFP...

None

Figure 1-1: The Demodulator selection, from the Configure menu

Demodulator Setups

| Attenuation] [| Sound

i @ Trap On

© Trap Off

O Sound On

© Sound Off

- Input | Level

@ 75 Ohms || @ Low

© 50 Ohms || © High

Zero Ref Pulse

@ On

© Off

Figure 1-2: The Demodulator Setups dialog box
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4. Set the demodulator parameters as required for your equipment configura-

tion. If the TV1350 is being used in a non-system M setup, you must use

SAW. See the TV1350 documentation for more information.

Now set the communication parameters for each piece of test equipment.

5. Choose Connections from the Configure menu. The Connections dialog box

looks similar to the one shown in Figure 1-3 (if TDC-10/1450A is selected

as the demodulator). Each demodulator causes a slightly different Demodula-

tor Group to be displayed in the Connections dialog box.

Connections

2714/2715 Spectrum Analyzer

@ GPIB’ GPIB Address: (0 |

© RS-232 COM Port: Baud Rate:

, ¥M 700A Demodulator ____—_—_———~TM

GPIB Address: [1 | | TDC-10 GPIB Address:

[ Switcher Control Port

COM Port: 2 | Baud Rate:

COM Pott:

Figure 1-3: The Connections dialog box when TDC-10/1450A is selected as the

demodulator

6. Enter the GPIB addresses for the VM700A, the Demodulator, and the 271X.

The allowable addresses are 0 — 29.

7. Ifthe 271X has an RS-232 connection instead of a GPIB, it must be entered

along with the baud rate and the correct Communications (Com) Port.

8. Set the Switcher Control Port and fields if applicable for your system.

9. Set the RS-232 Violations Reporting Com Port and Baud rate if you need to

have errors reported for the RS-232 Port.

10. Select OK when the dialog box has been set up correctly.
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Upgrade From the MS-DOS Based Tektronix Cable TV Software

The Data Storage

Structure

Running the Utility

If you are not upgrading from the MS-DOS based Cable TV RF Measurements

Software, skip to Basic Tutorial on page 2—1. If you are upgrading from the

MS-DOS based Cable TV RF Measurements Software, you must run the

exportdb.exe utility to transfer test results and channel tables from the MS-DOS

based Cable TV RF Measurements Software to the MS-Windows-based CSS500

software.

This utility is necessary because the DOS-based Cable TV Software stores its

data differently than CSS500 does. The Cable TV Software stores all test results

and all channel table data together in four related database files. The CSS500

software is oriented around worksheets (or spreadsheets). Each worksheet is

based on a single channel table and site combination. While several worksheets

may be based on the same channel table and site combination, a single worksheet

may not use more than one channel table and site.

This utility will scan each of the two pairs of DOS-based database files and

allow you to create data files and channel table files that are usable by the

CSS500 software.

You should run the exportdb utility from the same directory in which your

CSS500 software is installed (probably CSS500). The exported channel tables

and data files will then be placed in that directory, which is also the default

location where the CSS500 software looks for these files. To provide maximum

protection for your existing data, please perform the following operations (from

the DOS command line) to copy the four database files from the directory where

your DOS-based Cable TV Software is located to the directory in which your

CSS500 software is located. Then run exportdb.

CD C:\CSS500 (directory for the CSS500 software)

COPY C:\CATV\SARESULT.DBF (This assumes that the DOS-based )

COPY C:\CATV\SA_VALUE.DBF (CATV software is installed in the)

COPY C:\CATV\CH TBL.DBF (C:\CATV directory. If installed )

COPY C:\CATV\CHANNELS.DBF (elsewhere, use that directory )

EXPORTDB (instead.)

Since the source databases may contain a large number of channel tables and test

results, you may want to export test results only, channel tables only, or both.

The utility asks if you want to export any channel tables and then asks if you

want to export any measurement data. If you answer Y to both, then you will be

prompted whenever a new channel table is available to be exported and

whenever a new measurement data file is available to be exported. If you answer

N to either, then all prompts concerning that category will be skipped and

nothing in that category will be exported. For the categories you select, you can

also skip exporting individual channel table or data files.
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1-12

The exportdb utility then verifies the integrity of the database files. It can export

from DOS-based Cable TV Software Version 1.1 and later.

Since there are usually test results from several sites that are based on the same

channel table, the databases are sorted first by the channel table name and then

by the test site.

When channel tables are exported and a new channel table name is encountered,

you are told the channel table name and asked for the DOS file name to which

you want it exported; the default extension is .CHT. You can then type a new

name or press the ESC key to skip exporting the channel table.

As test results are exported, whenever the channel table name or the site name

changes, a new measurement data export file may be created. You are given the

channel table name and the site name on which the data is based and you are

asked for the DOS file name to which you want it exported; the default extension

is .WSR. You can then type a new name or press the ESC key to skip exporting

all data based on this channel table name and site name.

When channel tables are exported, it is possible to have channel tables available

for export that have no measurement data associated with them (in the DOS-

based Cable TV software, you can create channel tables without taking any

measurements based on them). It is also possible to have measurement data

available based on channel tables that are not available for export (in the

DOS-based Cable TV software, you can delete channel tables from the databases

after measurements based on them have been stored).

For the exported channel tables to be used by the CSS500 software, no addition-

al action is required; they will appear in the list of available channel tables. To

use the exported data, first create a new worksheet based on the same channel

table that the data was based on. Then do File Import with the CSS500 software

and select the exported file you want to import and use.

You can import and use the exported data even if the channel table it is based on

is not available for export. In order to successfully import that data, the new

worksheet must be based on a channel table that contains the same channels as

the ones the tests were done on, and these must be analog channels (the

DOS-based Cable TV software does not support digital channels). For ease of

analyzing the resultant worksheet, the channel Frequency, Program Name and

Tag fields should also be the same.
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The goal of this chapter is to familiarize you with the basic layout of a work-

sheet, show you how to set up a worksheet, and make simple measurements.

Before beginning the tutorial, please check your hardware for the proper

connections. (Appendix F gives cabling diagrams.) Double-checking the

hardware will help prevent errors that are hardware related, and make learning

how to use CSS500 that much easier.

If you want more information on an individual command, please refer to the

on-line help or Menu Bar, which begins on page 3-11.

This tutorial assumes that a mouse is available. If a mouse is not available, make

selections using ALT+the underlined letter of the command.

By the end of this chapter, you should be able to do the following:

= Select cells

= Enter Worksheet Header information

m= Make simple measurements

= Enter the Global View

= Enter the Results Detail display

= Define a Measurement Sequence

m Execute a Measurement Sequence

= Define a Measurement Sequence using the Auto Selection buttons

= View the broadcast picture on the computer monitor

= Print out assorted reports

CSS500 Cable Television System Software User Manual 2-1
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What Can CSS500 Do?

The purpose of the CSS500 application is to make the time-consuming and

tedious tasks of measuring and recording the results of measurements associated

with a cable TV system. To make a measurement on a particular channel, simply

select the cell where the channel and measurement intersect and double-click the

left mouse button. The results are printed in the cell. Print out the reports and the

job is completed. Of course, this is a cable system and there are many channels

and many measurements. CSS500 allows you to make many measurements

rapidly by selecting several channels or measurements.

Start CSS500

1. Start the Windows program.

()
Term: 2. Find the icon for CSS500 (created during installation).
C35 500

Mouse Keyboard

Double click on the icon to start the applica-

tion.

Enter the window with the CSS500 icon in it

by pressing ALT+w, highlight the correct

window, then press ENTER. Press the arrow

keys to highlight the CSS500 icon, then press

ENTER to start the application.

The initial display is called a worksheet. The worksheet will be blank except for

the measurement list running across the top row and a channel list running down

the left column.
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Description of the Worksheet

Control menu box

Figure 2-1 identifies the elements of the worksheet.

Title bar Minimize

Tektronix — CSS500 Restore or

Menu bar Configure Execute Help maximize button

: Button bar

Worksheet header — View filter status box

Measurement

header

Channel header ;

77258121

<—— Vertical scroll bar

Spreadsheet

Cell

Horizontal scroll bar

Figure 2-1: The default worksheet

Elements of the

Worksheet

The following paragraphs describe the various parts of the worksheet.

Mouse Pointer. (Not shown in figure.) The mouse pointer can take many shapes,

dependent upon the functions available. If the pointer is a cross, it selects cells. If

it is an arrow, it chooses commands. If it is an hourglass, the software is busy

and no new actions are available.

Title Bar. This shows the name of the application, “Tektronix — CSS500”.
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2-4

Elements of the

Worksheet Header

Minimize Button. Shrinks the application to an icon.

Maximize Button. Makes the application window fill the entire display area.

Restore Button. Returns the application window to its previous size.

Control Menu Box. Contains the standard Windows commands: Restore, Move,

Size, Minimize, Maximize, Close, and Switch To.

Channel Header. Lists channels by number and center frequency.

Measurement Header. Lists measurements.

Vertical Scroll Bar. Moves the spreadsheet vertically. Note that the Measurement

Header remains along the top as a reference.

Horizontal Scroll Bar. Moves the spreadsheet horizontally. Note that the Channel

Header remains along the side as a reference.

Menu Bar. Provides access to the CSS500 menus.

Button Bar. Contains the command buttons. The command buttons are shortcuts

with equivalents in the Menu Bar.

Spreadsheet. Contains all of the cells, the Measurement Header, and the Channel

Headers.

Cell. One small box on the spreadsheet — the intersection of one measurement

and one channel.

Figure 2-2 illustrates the Worksheet Header, which lists important information

about a worksheet. You can edit this information in various ways depending

upon which piece you would like to change. (See page 2—13 for how to set up a

worksheet.)
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Worksheet: <untitled> Site: <undefined> [No View Filter is On

Chan Table: std.cht Test ID: <undefined> H oMewt Emeriss’ On

Figure 2-2: The Worksheet Header

Worksheet. The name of the current worksheet. It is called <untitled> if the

worksheet has not been saved.

Chan Table. This file lists the channels in the system under test. There must be a

Channel Table or the CSS500 will not run.

Site. An additional identifier for the worksheet. Site is intended to be the location

where the measurement takes place. Only one Site is allowed for each worksheet.

<undefined> is a valid Site name.

Test ID. This is the name or ID of the person who is making the measurements,

the measurement test point, or any other identifier that might be appropriate. A

single worksheet can have multiple Test IDs. It sub-divides measurements made

at a single Site (such as Pre-converter and Post-converter). <undefined> is a

valid Test ID name.

View Filter Box. This tells how much of the spreadsheet is in view or available.

The options for the box are: “No View Filter is On” (the entire spreadsheet is in

view); “View Selected Filter is On” (display only selected measurements and

channels); “View Sequence Filter is On” (display only measurements made with

a Measurement Sequence); and “View Test ID Filter is On” (display only

measurements made with the current Test ID). Note that only channels that are

displayed are available for measurements.

Navigation

This section explains how to get around in the CSS500 software. All actions are

first explained for the mouse and then for the keyboard. If you are familiar with

Windows command selection, skip to Scroll Through the Spreadsheet on page

2-9.
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Choose from the

Menu Bar

2-6

Step | Mouse Keyboard

1 Single-click the left mouse button on the Press ALT+the underlined letter in the

desired menu from the Menu Bar. menu.

2 Single-click the left mouse button on the Press the underlined letter for the desired

desired command. command or use the arrow key to scroll,

then press Enter.

Example: Open a Worksheet

Step | Mouse Keyboard

1 Single-click the left mouse button on the

word “File” on the Menu Bar.

Press ALT+f.

This displays the drop-down File menu, as shown in Figure 2-3.

tic a
New...

Open...

Save

save As...

Import...

Export...

Print...

Print Setup...

Exit

Figure 2-3: The drop-down File menu

Step | Mouse Keyboard

2 Single-click the left mouse button on the Press o.

word “Open”.

This displays the dialog box shown in Figure 2-4.
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Directories:

c:\css500

ck

@= css500

help

5 limits

Drives:

#4 c. tektronix

Figure 2-4: The Open dialog box

Mouse Keyboard

Single-click the left mouse button on the

Cancel command button to close the Open

dialog box without opening a file.

Press ESC to close the Open dialog box

without opening a file.

Keyboard

Step

3

Choose from the Mouse

Button Bar Single-click the left mouse button on the

desired command button.

Press ALT+the underlined letter from the

command button.

or

Press TAB to place the cursor on the Button

Bar, then press either TAB or the arrow keys to

select the command button. (Be careful using

the arrow keys. They will scroll off the Button

Bar and into the spreadsheet.) Press ENTER

to choose the selected command button.

Example: Open the Test ID Dialog Box

Step Mouse Keyboard

{

Single-click the left mouse button on the

Test ID command button.

Press ALT+i.
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This displays the Test ID dialog box as shown in Figure 2-5.

All Test IDs:

<undetined>

Learner's Permit

Figure 2-5: The Test ID dialog box

Step Mouse Keyboard

2 Single-click the left mouse button on the

Cancel command button, to close the

dialog box without making any changes.

Press ESC.

Special Command Button = Many dialog boxes have two special command buttons: OK and Cancel.

Keyboard Shortcuts
To choose OK from the keyboard, press ENTER with anything highlighted

except the Cancel button.

To choose Cancel from the Keyboard, either press ESC or press TAB until the

Cancel command button is highlighted, then press ENTER.
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Scroll Through the

Spreadsheet

Mouse Keyboard

Either:

Click on the left, right, up, or down scroll

arrows in the Vertical or Horizontal Scroll Bar

with the left mouse button. This moves the

cursor one cell at a time.

or

Click on the scroll box in the Vertical or

Horizontal Scroll Bar with the left mouse

button, then hold down the left mouse button

and drag the scroll box to the desired position.

Release the mouse button.

Place the cursor in the spreadsheet. (Use the

arrow keys if you are on the Button Bar or

ESC if you are on the Menu Bar.) Use the

arrow keys to scroll the spreadsheet to the

desired position. The spreadsheet display will

move every time you move to a cell that is off

screen. The HOME, END, PAGE UP, and

PAGE DOWN are also available to move

quickly through the spreadsheet.

HOME. Moves to the first cell in the current

channel.

END. Moves to the last cell in the current row

that has a measurement made for any

channel.

PAGE UP. Moves the spreadsheet up one

page. (Measurement stays the same and the

current channel is the next channel that was

just off screen to the top.) Nothing happens if

the top channel is currently visible.

PAGE DOWN. Moves the spreadsheet down

one page. (Measurement stays the same and

the current channel is the next channel that

was just off screen to the bottom.) Nothing

happens if the bottom channel is currently

selected.

Example: Display the ICPM measurement for channel 3

Step | Mouse Keyboard

1 Click on the Horizontal Scroll Bar box with | Place the cursor on the spreadsheet.

the left mouse button. Hold down the left

mouse button and drag the cursor until itis | column is visible.

all the way to the right side of the Horizon-

tal Scroll Bar. The ICPM column is visible.

Press the right arrow key until the ICPM

2 Click on the Vertical Scroll Bar’s up arrow

with the left mouse button until channel 3

(the second channel in the example) is

visible. The spreadsheet looks similar to

below. Notice the position of the boxes in

the Vertical and Horizontal Scroll Bar.

Press the down arrow key until your

second channel (channel 3 in the example)

is visible. The spreadsheet looks similar to

Figure 2-6. The ICPM cell for channel 3 is

selected (using the std.cht Channel Table).

Notice the position of the boxes in the

Vertical and Horizontal Scroll Bar.

3 Reverse the steps to return to the spreadsheet to display the first column.
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Tektronix — CS$500

i] Worksheet: <untitled> Site:

Test ID: Learner's PermitChan Table: std_cht

Tektronix-Beaverton

Figure 2-6: The spreadsheet scrolled to the ICPM column

Select a Cell from the

Spreadsheet

2-10

Mouse Keyboard

Single-click the left mouse button on the

desired cell.

Press ESC or the arrow keys until the cursor is

in the spreadsheet. Use the arrow keys to

move the cell outline to the desired cell.

Example: Select Carrier to Noise cell for channel 3

Mouse Keyboard

Place the mouse cursor anywhere in the cell.

Single-click the left mouse button. The

selected cell is outlined.

Use the arrow keys to move the cell outline to

the desired cell.

The selected cell on the spreadsheet looks similar to Figure 2-7.
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Tektronix — CSS500

File Edit View Measure Configure Execute Help

pen || Save [Global || Results || Status | [Meas Sel_

||| Chan Table: std.cht Test 1D: Learner's Permit

Worksheet: <untitled> Site: Tektronix-Beayerton

Select a Group of Cells = Note that you can only select adjacent cells (rows, columns, or block). If

non-adjacent cells need to be measured as a group, use a Measurement Sequence

(see page 2-25).

Step Mouse Keyboard

1 Click on one of the corner cells in the

desired group.

Press the arrow keys until one corner cell

of the desired group is selected.

Hold down the left mouse button and

drag the mouse until all of the desired

cells have reversed color. (When the cell

color reverses, it indicates selection. The

first cell does not reverse color.)

Hold down the SHIFT button. Use the

arrow keys to move around the spread-

sheet until the desired group of cells has

reversed color. (When a cell reverses

color — it has been selected. The first

cell does not reverse color.)

Release the left mouse button. Release the SHIFT button.
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Example: Select channels 3-4’s carrier levels and frequencies

Step Mouse Keyboard

1 Single-click on the second channel's

Visual Carrier Level cell.

Use the arrow keys to place the cursor

around the second channel's Visual

Carrier Level cell (Channel 3).

Start the mouse pointer in the selected

cell, then hold down the left mouse button

and drag the mouse cursor until the

desired cells have reversed color.

Release the left mouse button. The

selected cells keep the reversed color,

except for the original corner cell which is

outlined.

Hold down the SHIFT key and use the

arrow keys to select the desired cells.

The selected cells reverse color, except

for the original corner cell which is

outlined.

The spreadsheet resembles Figure 2-8. Note that the selected cells have reversed

in color except for the corner cell which is outlined.

Execute Help

Worksheet: <untitled> Site: Tektronix-Beaverton

amer's Pe

Figure 2-8: A group of cells selected
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Set Up a Worksheet

Enter a Site and

Description

Selecting an Entire Row or Column

Mouse Keyboard

Single-click on the name of the measurement

or channel in the Measurement or Channel

Header.

To select an entire row, place the cursor

anywhere in the row and press SHIFT+space-

bar.

To select an entire column, place the cursor

anywhere in the column and press

CTRL+spacebar.

Select the Entire Spreadsheet. You can select the entire spreadsheet three ways:

Select the Entire Spreadsheet

Mouse Keyboard

Click on the upper left cell (where the Channel

and Measurement Headers intersect) with the

left mouse button.

Press CTRL+SHIFT+spacebar.

Select the Edit menu by pressing ALT+E, then

choose Select All by pressing S.

There are four parts to a worksheet definition: Site, Test ID, Channel Table, and

Worksheet name. The Worksheet is the main file that stores everything. Each

Worksheet may only have one Site and one Channel Table associated with it. If

the Channel Table or Site changes, CSS500 automatically gives you the option

to start a new worksheet or rename the Site in the current worksheet. You will

now create a new worksheet for practice.

1. From the File menu, select New. If there was a worksheet already defined,

the following Warning dialog box (Figure 2-9) may be displayed:

C55500 Warning ¥¥350

Figure 2-9: Warning dialog box
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2-14

2. Do not save the old worksheet — choose the No command button.

Site

Description:

| Channel T able

File Name: Directories:

| std. cht | c:\css500

eur_il.cht f ch See

hre.cht € css500
ire.cht fy hel

japan-m.cht Ms ne’p —
japan_m.cht limits ba

std.cht Drives:
stdofst.cht = -

stndrd.cht c: tektronix

Figure 2-10: The New dialog box

3. Select the Site combination box.

Mouse Keyboard

Click on the Site combo box. Press TAB until the cursor is blinking in the

Site list box.

4. Select a site name. (The example uses “Tektronix — Beaverton”.)

Mouse Keyboard

Type in your site name or click on the arrow

box to select a Site name from the combo box.

(Use a site name appropriate to your setup.)

Type in your site name or press the up or

down arrow keys to select a site name from

the combo box.
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5. Select the Description text box.

Mouse Keyboard

Click the left button in the Description text box. | Press ALT+p or TAB.

6. Enter the description: “This worksheet is for practice only.”

7. Select std.cht as the Channel Table by clicking on std.cht in the list box.

8. Leave the New dialog box and save the changes by choosing the OK

command button.

9, From the File menu, choose Save As. The Save As dialog box appears, as

shown in Figure 2-11.

Save As

File Name: Directories:

wrk c:icss500

feed. ear ck

&= css500

help

5 limits

Drives:

c: tektronix

Figure 2-11: The Save As dialog box

10. In the File Name combo box, type: “example”.

11. Choose the OK command button. The title “example.wrk” is in the

worksheet header.

EnteraTestID 1. From the Configure Menu, select Test ID or choose the Test ID command

button from the Button Bar. This displays the Test ID dialog box, as shown

in Figure 2-12.
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Attach/Change Channel

2-16

Table

TestiD

Worksheet Test IDs:

Figure 2-12: The initial display of the Test ID dialog box

2. Select a Test ID.

Mouse Keyboard

Type in a Test ID or select from the combo

box: click on the arrow in the list box (if

present) and then select one from the list. The

example uses “Learner’s Permit”.

Type in the Test ID or select one from the list

box by scrolling through the list by pressing

the down arrow key. The example uses

“Learner's Permit’.

3. Leave the Test ID dialog box and save the changes by choosing the OK

command button.

The worksheet header should look similar to Figure 2-13.

Chan Table: std.cht Test ID: Learner's Remote

Worksheet: example.wrk Site: Tektronix-Beaverton

Figure 2-13: The worksheet header after filling in all information

See Advanced Setups Tutorial on page 2-39 or Appendix C: Channel Table

Editor if the Channel Table must be changed.
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Basic Tutorial

Make Simple Measurements

One Measurement for

One Channel

You now have enough background to begin making simple measurements and

you have created a new worksheet so you won’t overwrite an existing one.

NOTE. Do not use the 2714 (and early 2715s) to take digital measurements. The

2714 will not run digital measurements (Average Power, Desired to Undesired,

and Adjacent Channel Leakage), but uses the same channel table format as the

2715. If the software attempts to take a digital measurement using the 2714,

measurements returned will be incorrect, errors will be returned, or the software

will behave unpredictably.

To make one measurement on one channel, select a cell. From the Measure

menu, choose Current Selection (or choose Meas Sel from the Button Bar) or

double-click on a cell with the left mouse button.

The measurement results appear in the cell, replacing any previous results. (The

previous results are not necessarily lost. See Measurement History Group on

page 2-52.)

Only one measurement on one channel takes place, unless you select one of the

first six measurements: Visual Carrier Level, Visual Carrier Frequency, Aural

Carrier Level, Aural Frequency Offset, Second Aural Level, and Second Aural

Frequency Offset. Select any of these cells and all six measurements are always

taken.

Example: Measure Carrier Levels and Frequencies for the First Channel

Mouse Keyboard

Select the cell by single-clicking the left mouse | Place the cursor in the spreadsheet, then use

button. the arrow keys to select the cell.

Execute the measurement.

Mouse Keyboard

Either double-click with the left mouse button,

choose Current Selection from the Measure

menu, or choose Meas Sel from the Button

Bar.

Either choose Current Selection from the

Measure menu or choose Meas Sel from the

Button Bar.
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2-18

A dialog box then appears, telling you that the software application is busy

making measurements.

Executing Carrier Levels and Frequencies

measurement on Channel 2 55.25 MHz

Figure 2-14: Measurement Execution dialog box

If you chose the wrong measurement or channel, choose the Cancel command

button to stop the measurement. (Cancel stops after the current measurement, so

it does nothing when making a single measurement.)

CSS500 might respond with a message to turn off the scrambling if that

particular channel has scrambling enabled and the requested measurement

requires it. (When all of the measurements for the channel are finished, then

another message reminds you to turn the scrambling back on.)

CSS500 might also respond with the Message box shown in Figure 2-15.

CSS500 Message

Figure 2-15: Message dialog box

This is an optional dialog box warning you to double check your equipment

setup. The measurement halts until you choose the OK command button. To stop

the measurement choose the Cancel command button. (You can turn this

message box on or off — see Configuration Preferences, page 2-51 .)

If everything is properly connected, select the OK command button.

CSS500 responds with the dialog box in Figure 2—16 to let you know that it is

working on the measurement.
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Measurement Execution

Figure 2-16: Measurement Execution Dialog box

Again, you can cancel the measurement at this point by choosing the Cancel

command button.

CSS500 fills in the first four or six cells for the selected channel. (There are only

four measurements made in the following example because std.cht does not have

the Second Aural Frequency set. If this Channel Table has a value, then the last

two measurements are available.)

Repeat this measurement for the next two channels on the list. The resulting

spreadsheet looks similar to Figure 2-17.

Tektronix — CSS500

Yiew Measure Configure Execute Help

> <untitled>

cht

Site: Tektronix-Beaverton

ffset (MHz)
4 495524

=

Figure 2-17: The spreadsheet after making a few measurements

Make Several To make several measurements: select the cells, then from the menu, choose

Measurements ata Time Current Selection (or Meas Sel from the Button Bar). If you want to make all the

measurements for a given channel, select that channel’s row. Then from the

Measure menu, choose Current Selection or double-click on the channel name in

the Channel Header. This makes all the measurements on the selected channel.
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2-20

Use the same procedure to run one measurement for all the channels: select all

the channels for that measurement, then from the Measure menu, choose Current

Selection or double-click on the Measurement Header.

Remember, you cannot use this method to make measurements on non-adjacent

cells because they cannot be selected together. Use a Measurement Sequence (see

page 2-25) to make measurements on non-adjacent cells.

Since it usually takes a little while for groups of measurements to complete, you

can switch to other Windows applications while the measurements are executing.

Example: Make FCC Baseband Measurements for Several Channels.

1. Scroll the spreadsheet horizontally to display the FCC Baseband measure-

ment column.

2. Select the first three channels for an FCC Baseband measurement. From the

Measure menu, choose Current Selection. A dialog box similar to Fig-

ure 2—18 appears.

Executing FCC Baseband measurement on Channel 2

55.25 MH

Figure 2-18: Measurement Execution dialog box

3. If you need to stop the measurement, choose the Cancel command button.

This stops after completing the current measurement. (Pressing ESC,

RETURN, or the spacebar will cancel the measurement.) Another dialog box

might appear like that shown in Figure 2-19.

C5S500 Message

Switch RF signal connection to the Demodulator.
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4. If the signal is connected to the Demodulator, choose the OK command

button. If not, connect the signal, then choose the OK button. If the signal

cannot be connected, choose the Cancel command button. The next dialog

box tells you that a measurement is going to be made on the next channel

(see Figure 2—20). This allows you to tune the external pre-selector, if

necessary.

Execution paused for next channel

Figure 2-20: Execution dialog box

5. If you need to stop the measurement, choose the Cancel command box.

This dialog box repeats three times, once for each channel.

The spreadsheet cells should look similar to Figure 2—21.

Figure 2-21: The spreadsheet cells after making a group of measurements

Note that this measurement only gives Pass/Fail results instead of numerical

results. There are several separate measurements under this Measurement Header

and there isn’t enough room to report all of the results in a single cell. The

measurements under this measurement heading are: Differential Gain, Differen-

tial Phase, Chrominance-to-Luminance Gain, and Chrominance-to-Luminance

Delay.

What if you want to see the individual results of each of these measurements?

You enter the Results Detail display.
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Results Detail Display The Results Detail display gives more information than a single cell can hold.

There are three ways to enter a cell’s Results Detail display from the worksheet:

= Single click on the cell using the RIGHT mouse button.

m Select a cell, then choose the Results command button from the Button Bar.

® Select acell, then from the View menu, choose Results Detail.

Example: Results Detail for FCC Baseband for channel 2.

1. Select channel 2’s FCC Baseband measurement cell.

2. Choose the Results command button from the Button Bar. See Figure 2—22

for the dialog box.

Worksheet Navigation Select History

Channel 2 55.25 MHz

Channel Table: std.cht FFT

Site: Tektronix-Beaverton [+]
No View Filter is On

Measurement Summary

Figure 2-22: The Results Detail dialog box

3. Scroll to the right to view the Date & Time and the Test ID for these

measurements. Choose the Close command button to return to the spread-

sheet.

There is more information on this display under Results Detail Display on

page 2-60.
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Cell Coloring

Global View

You might have noticed that the cells have different colors. They are white,

green, yellow, red, blue, or gray. These colors indicate the range of the measure-

ment results. White means that there are no limits assigned to that measurement

or no measurements have been made. Green means that the measurement is

passing. Yellow means that the measurement is in the Caution range. Red means

that the measurement has dropped into the Alarm state. The Limits File defines

these ranges. Limits are covered in Defining Limits, page 2-79. Blue indicates

that an error occurred in the measurement, making the results invalid. All of the

results in the cell must be in error for the cell to be blue, otherwise the cell will

take on the color of the worst case valid measurement. Gray cells have no

measurement results. Any cell that is grayed is not included in the transfer to the

RF instrument (that is, when the Channel Table is loaded into the instrument this

channel is not loaded. Since the channel is not loaded, no RF measurements can

be made on this channel). Therefore, they cannot have any RF results. Baseband

measurements are still available for this channel. This value is set from the

Channel Table Editor. (See Appendix C for more information on the Channel

Table Editor.)

Another way of looking at the measurement results is the Global View. This

display shows all of the measurements for many channels at a time. This view

does not give numerical results, rather only pass, warning, alarm, unknown/not

defined, or error-in-measurement indications based on the color of the cells.

Enter the Global View by choosing the Global command button on the Button

Bar or, from the View menu, choose Global View.

The display should be similar to Figure 2—23.
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No View Filter is On

Figure 2-23: The Global View of the spreadsheet

The colors tell the health of the system and can give you a good overall feel of

how the system is performing.

You can select a cell on this display and then go to the Results Detail display for

that cell by choosing the View Results Detail command button. Also, by

selecting the entire worksheet, you can go to the Status Report. If you select an

entire row, you can go to the Channel Summary. If you select an entire column,

you can go to the Measurement Summary.

Choose the Close command button to close the Global View and return to the

spreadsheet.
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Define and Use a Measurement Sequence

Define a Measurement

Sequence

Suppose you need to make several measurements on a couple of different

channels on a regular basis. These measurements and channels are not close

enough on the worksheet to select the cells and use Current Selection from the

Measure menu. You do not have to do the measurements one cell at a time.

Instead, you can use a Measurement Sequence. A Measurement Sequence is a

list of measurements that you define and run whenever you need. You can only

define one Measurement Sequence at a time, so there is no confusion about what

measurements and channels are in a Measurement Sequence.

Now define a simple Measurement Sequence to make Carrier Level and

Frequency, FCC Baseband, and Multiburst measurements for your first, third,

and fifth channels.

1. Clear the spreadsheet.

a. From the Edit menu, choose Select All.

b. From the Edit menu, choose Clear.

2. From the Configure menu, choose Measurement Sequence. The Measure-

ment Sequence dialog box appears (see Figure 2—24 and Figure 2—25).

Which Measurements Sequence dialog box appears depends on the country

specified in the Windows Control Panel.
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Auto Selection

Figure 2-24: The Measurement Sequence dialog box (if operating country is United States)
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Auto Selection

C1 Carrier Survey

Figure 2-25: The Measurement Sequence dialog box (if operating country is not United States)

3. Select the Carrier Levels and Frequencies, FCC Baseband, and Multiburst

for your first, third, and fifth channels.

Mouse Keyboard

Double-click those cells. (To deselect: double-

click on the cell again.)

Press TAB until the cursor is in the spread-

sheet. Use the arrow keys to move to the cell,

then select the cell by pressing the spacebar.

(To deselect: press the spacebar again.)

Your dialog box should resemble Figure 2-26.
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[ Auto Selection

| __24 How Test | [ FEC Post-Converter
_Eddit Time Parameters | |_OK

[Create 271472715 UDP | | Cancel |

2-28

4. Choose the Edit Time Parameters command button. The display should be

similar to Figure 2—27.

Edit Time Parameters

- Time Parameters

(JRun Continuously:

Run Immediately

Stati Day Har: Menute:

[Any ep

Run N Times: Repeat Interval:

fi | fo Hours

Figure 2-27: The Edit Time Parameters dialog box
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Run the Measurement

Sequence

5. Enter “1” in the Run N Times text box.

6. Enter “0” in the Repeat Interval text box.

7. The rest of the options in the Edit Time Parameters dialog box are gray,

indicating they are not available. Choose the OK command button to save

the changes and return to the Measurement Sequence dialog box.

8. Choose the OK command button to accept the Measurement Sequence. The

display returns to the worksheet.

1. Choose the Meas Seq command button from the Button Bar or from the

Measure menu choose Measurement Sequence. The dialog box Figure 2—28

appears.

Sequence Measurement Execution - Iteration 1

Figure 2-28: The dialog box that tells you that CSS500 is running a measurement

sequence

2. Ifyou want the Measurement Sequence to stop, choose the Cancel command

button; otherwise allow the sequence to run. The Measurement Sequence

runs through once. (It will take a while.)

NOTE. If you would like to change to another application while the Measurement

Sequence is running, size the CSS500 window so the other application icons or

windows are visible before starting the Measurement Sequence. Click on another

icon or window to change applications. You can also use ALT+TAB to change

applications. When the sequence is complete, CSS500 automatically becomes the

active window.

At the end of the Measurement Sequence, the dialog box in Figure 2—29

appears.
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CSS500 Warning Y4357

Figure 2-29: Query dialog box

3. Choose the Yes command button. Now only the measurements made with

the Measurement Sequence are visible and the View Filter box says that the

Measurement Sequence View Filter is on (see Figure 2—30). For more

information on View Filters, see page 2-73 in Advanced Measurements

Tutorial.

lees Tektronix — CSS5U0

File Edit View Measure Configure Execute Help

1/Worksheet: <untitled> Site: Tektronix-Beaverton

Chan Table: std.cht Test ID: test 43:16:35

Offset (MHz)
4.495524

4. Choose Measurement Sequence Results, from the View menu, to turn the

Measurement Sequence View Filter off and return to a normal display.
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Measurement Sequences

Using Auto Selection

You may have noticed a group in the Measurement Sequence dialog box labeled

Auto Selection. These four buttons allow you to quickly set up a Measurement

Sequence that might be run on a regular basis. The four push buttons are: FCC

Pre-Converter, FCC Post-Converter, FCC Headend Msmts, and 24 Hour Test.

You can add other measurements to the sequence, before or after choosing an

Auto Selection command button.

NOTE. Non-US countries have only the 24 Hour Test button available, because

the rest of the Auto Selection buttons are for making FCC (a US regulatory

agency) required measurements.

Table 2—1 lists the measurements available under the Auto Selection command

buttons. They all have Carrier Levels and Frequencies for all channels. Other

measurements are for user-selected channels only.

Table 2-1: Measurements executed by Auto Selection buttons

Auto Selection Button

Channels that FCC FCC FCC

are Measured Pre-Converter | Post-Converter | Headend 24 Hour Test!

All Carrier Levels Carrier Levels Carrier Levels Carrier Levels

Channels and Frequencies | and Frequencies | and Frequencies | and Frequencies

Selected ICR Carrier to FCC

Channels Noise Ratio Baseband

Selected CSO

Channels

Selected CTB

Channels

Selected Cross

Channels Modulation

Selected Hum

Channels

1 The 24 Hour Test is automatically set to run 4 times at 6 hour intervals.

Set Up an Auto Selection Measurement Sequence

1. From the Configure menu, choose Measurement Sequence. The Measure-

ment Sequence dialog box appears.

2. Choose the Clear Sequence command button to erase any old Measurement

Sequence information.
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Mouse Keyboard

Click on the Clear Sequence command button

with the left mouse button.

Press ALT+c.

3. Choose the FCC Pre-Converter command button from the Auto Selection

group. The FCC Pre-Converter Measurements dialog box appears as shown

in Figure 2-31.

FCC Pre-Converter Measurements

Carier Levels and Frequencies will be executed for All Channels.

The following measurements will be executed for the Selected Channels:

Amplitude Characteristic

©) In-Channel Response @ Multiburst

- Select Channels

Figure 2-31: The FCC Pre-Converter Measurements dialog box

4. Select the Multiburst option button for the Amplitude Characteristic group.

Mouse Keyboard

Click on the Multiburst option button with the Press ALT+m.

left mouse button.

5. Select several channels from the Available Channels list box and place them

in the Selected Channels list box.
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Mouse Keyboard

Double-click the left mouse button on the

channel name for single channels. For several

channels, click on the first channel with the left

mouse button, then hold down SHIFT and

click on the last channel in the list with the left

mouse button. Then choose the <-Select

command button.

Press TAB until the cursor is in the Available

Channels list box. Use the arrow keys to select

a channel or, to select several channels at a

time, hold down SHIFT while moving through

the list with the arrow keys. Add the selected

channel(s) to the Selected Channels list box

by pressing ALT+e.

dialog box.

Multiburst measurement.

Choose the OK command button to return to the Measurement Sequence

Add a Carrier to Noise measurement to the channels that also have a

Mouse Keyboard

Double-click those cells with the left mouse

button.

Press TAB until the cursor is in the spread-

sheet. Use the arrow keys to move to the cell,

then select the cell by pressing the spacebar.

The Measurement Sequence dialog box should look similar to Figure 2-32.
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Measurement Sequence

Auto Selection | Edit Time Parameters | | ok. |

[Create 2714/2715 UDP | | Cancel |

| Clear Sequence | |_Help |

C] Cartier Survey

vie ve Bur ur end end Ayal 08 lec Mad] Sur : ‘adie
Car] Car} Car) Car) Bur) Buri 5 ‘ : Ci Ul ge Denidevi 4 | Dis

Lev) Fig | Levi Fig} Levi Fre RE ME N

Figure 2-32: Measurement Sequence dialog box after using an Auto Selection command button and adding

additional measurements

2-34

8. Choose the OK command button to return to the spreadsheet.

Run an Auto Selection Measurement Sequence. You run the Auto Selection

Measurement Sequence in the same way that you run any other Measurement

Sequence.

Carrier Survey. The Carrier Survey check box in the Measurement Sequence

dialog box allows you to quickly select all of the Carrier Level and Frequency

measurements. See page 3-58 for more details on the Carrier Survey check box.

CSS500 Cable Television System Software User Manual @eeoeoeo eoeoeeoeeeeegee7~degeo@eese 8s @



yy »)

Basic Tutorial

Display the Picture (Optional)

Print (Optional)

There will be times that you want to be able to see what the broadcast signal

looks like while you are making measurements on it. For example, your first

channel just miserably failed its last FCC Measurements check and you would

like to see the amount of picture distortion. CSS500 has the ability to show you

the picture directly on the computer screen if you have the appropriate hardware

installed.

The Picture command displays a video picture of what is presently on a given

channel (shows a complete active picture). The channel is whatever the

demodulator happens to be tuned to at the time, or you can use the Tune to

Channel command to select a channel. To use the Picture command, you must

have a video board and software driver installed in your PC. (The CSS500

package does not include the video board and driver). The video board and driver

must be active when the Picture command is called. The default driver is the

Video Blaster. Refer to page 3-40 for information on using other drivers.

Use the following procedure to display your first channel:

1. From the control menu box, use Switch To to go to the Windows Program

Manager.

2. Start your video driver.

3. Return to the CSS500 application.

4. Configure your equipment to provide the desired video signal to the video

card in the PC.

5. From the View menu, choose Picture.

The picture is displayed on the computer screen.

6. To leave the Picture display from the control menu box in the picture

window, choose Close. Or you can hide the picture by clicking anywhere in

the CSS500 application window.

Now that you have some data to look at, it is time to print out some worksheets

and reports.

1. Check your printer setups. From the File menu, choose Print Setup. The

Print Setup dialog box appears, as shown in Figure 2-33.
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Print Setup

[PostScript (QMS) on tolpd@bv58s1@servers (LPT1:)

[ Orientation | [ Paper

© Portrait Size: [Letter 61/2 % 11 in

@L : Source: |Upper Tray

Figure 2-33: The Print Setup dialog box

This dialog box is identical to the standard Windows Print Setup dialog box.

(Use the Windows 3.1 User’s Guide and on-line help for any problems.) When

the printer is set correctly, choose the OK command button. The printer is now

ready to use.

NOTE. As a general rule, use landscape orientation for easier-to—read reports.

2. From the File menu, choose Print. The dialog box shown in Figure 2-34

appears.

Printer: Default Printer (PostScript (QMS) on
tolpd@by58s1 @servers (LPT1:))

- Print Range

@ all

© Selection

Figure 2-34: The Print dialog box
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3. Select the appropriate options and then choose OK to print.

NOTE. Before printing out a worksheet, select the View Used option from

Measurements and Channels in the View menu. This will automatically limit the

display to measurements and channels that have results.

Print Out the Worksheet = Choose the Print command button on the Button Bar. The entire worksheet

prints.

NOTE. The Print dialog box has a special check box, Expand Columns. This

option allows all of the measurements that would normally only show Pass,

Caution, or Alarm to expand, giving all of the numerical results. For example,

Audio expands to 20 columns to display all of the measurements. The columns

that expand are: CSO, CTB, Hum/LFD, FCC Baseband, Signal to Noise,

Waveform Distortion, Multiburst, and Audio.

Print Out the Results 1. Display the Results Detail for the first channel of the FCC Baseband

Detail Display measurement. (Select the cell, then click on the Results button on the Button

Bar, or click on the cell with the right mouse button.)

2. Choose the Print command button in the Results Detail Display.

3. Leave the Results Detail Display by choosing the Close command button.

End of the Tutorial

You have just completed the tutorial for CSS500. At this point, you should be

able to do the following:

® Select cells. (See page 2-10.)

= Enter worksheet header information. (See page 2-13.)

= Make simple measurements. (See page 2-17.)

= Enter the Results Detail display. (See page 2—22.)

mw Enter the Global View. (See page 2-23.)

= Define a Measurement Sequence. (See page 2—25.)

= Execute a Measurement Sequence. (See page 2-29.)
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2-38

Define a Measurement Sequence using the Auto Selection buttons. (See

page 2-31.)

View what is being broadcast on the computer monitor. (See page 2-35.)

Set up your printer. (See page 2-35.)

Print out assorted reports. (See page 2-37.)

If you don’t feel comfortable with any of the above topics, please go back and

review them before continuing.
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This chapter explains how to set up your system to give you only the information

that you want and to make the most accurate measurements. The following

topics are covered:

® Selecting and configuring the demodulator

® Reviewing the RS-232 and GPIB connections

@ Setting the 271X controls

m Setting the TDC-10 controls

m Specifying how the measurements are made

@ Setting the correct VITS locations

= Attaching a different Channel Table

@ Selecting whether or not to collect history

TM Selecting the Power Level Units

m Turning the user prompts and alarm messages on or off

Select and Configure the Demodulator

From the Configure menu, choose Demodulator (see Figure 2-35). Next, choose

either TDC-10 / 1450A, TV1350, Rohde & Schwarz EMFP, or None depending

on which demodulator is in your system. A check mark indicates the selected

demodulator.

Demodulator ¥TDC-10} 14504

T¥1350...

Rohde & Schwarz EMFP...

None

Figure 2-35: Selecting Demodulator from the Configure menu
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If the TV1350 or EMFP is the selected demodulator, then additional configura-

tion steps might be required. A dialog box appears as soon as either of these

demodulators is chosen (see Figure 2-36). Edit these parameters as required (if

the TV1350 is being used in a non-system M setup, you must use SAW). The

CSS500.INI file stores these values. (See Appendix E for more information on

the CSS500.INI file.)

Demodulator Setups

[ Attenuation] [ Sound

© Trap On

© Trap Off

Oo Sound On

© Sound Off

Figure 2-36: The Demodulator Setups dialog box

NOTE. The CSS500.INI file controls the front panel settings. Therefore, no matter

what the front panel on the Rohde & Schwarz demodulator or TV1350 indicates,

the actual control parameters are in the CSS500.INI file and are set in the

Demodulator Setup dialog box.

Configure Connections

2-40

AN

The first time you run the CSS500 application or any time that the test equip-

ment connections change, choose Connections from the Configure menu. The

dialog box looks like the one shown in Figure 2-37 (if the TDC-10/1450A

combination is the selected demodulator). Verify that CSS500 shows the correct

addresses of the test equipment.

CAUTION. To ensure proper operation and prevent software conflicts, verify that

no two instruments are assigned to the same port or GPIB address. This applies

even if an instrument is not connected or used.
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Connections

Baud Rate: | 4800

| Demodulator

GPIB Address: [a | TDC-10 GPIB Address:

- Switcher Control Port

COM Pott:

Figure 2-37: The Connections dialog box

Configure Measurement Setups

There are many different ways that your system can execute measurements. The

Measurement Setups dialog box tells CSS500 how your system needs to be set

up to make measurements and get the best results. There are setup parameters

that affect all channels and some that are channel specific.

From the Configure menu, choose Measurement Setups, or choose the Setups

command button from the Button Bar. The Measurement Setups dialog box

looks similar to Figure 2—38:
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The All Channels Group

2-42

Measurement Setups

[ All Channels

[271472715

External

Attenuation([-]/

Amplification[+)-:

T jw

Preamp: Frequency:

© On @ 60 Hz

@ of O50Hz

Carrier Levels Mode:

@ Accurate Frequency and Amplitude

© Accurate Amplitude Only

©) Fast Amplitude Only

Power Line

- Zero Carrier Pulse

- ea Preamp:Line: [13 | Field: [i | @ on

TDC-10~_ 7

© 17 aB

© 27 dB

. Selected Channels

Figure 2-38: The Measurement Setups dialog box

The All Channels group contains settings that specify how measurements are

made on all channels.

2714/2715 Subgroup

@ External Attenuation/Amplification. Enter the attenuation or amplification

(in dB) of the test point in this text box. For example: if the measurements

are being made at a 10 dB down test point, enter —10 dB.
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m= Preamp. The Preamp allows increased sensitivity when measuring low level

signals. Select the On or Off option button to match your measurement

needs. See the 2714 manual for more information on the correct settings.

NOTE. The 2715 automatically sets the preamp as required for each measure-

ment.

m Power Line Frequency. This is the power line frequency of your system.

= Carrier Levels Mode. These option buttons select how the Carrier Level

measurements are made. This includes both regular measurements and

Carrier Surveys. The options are given below:

Accurate Frequency and Amplitude (recommended)

Accurate Amplitude Only

Fast Amplitude Only

Zero Carrier Pulse Sub-Group

NOTE. This sub-group does not set the Zero Carrier Pulse for the demodulator. It

only indicates the location for the VM700A.

The Zero Carrier Pulse is available from the demodulator. The VM700A uses the

Zero Carrier Pulse as a timing reference. Make sure that the reference set here is

the same as the reference set with internal jumpers in the demodulator. For more

information, please see the demodulator manual.

Enter the Line Number, Field, and Center Location in the text boxes.

TDC-10 Sub-Group

NOTE. The TDC-10 sub-group is only available if the TDC-10 is the selected

demodulator.

= Preamp. The Preamp allows improved sensitivity when measuring low level

signals. Select the RF preamplification according to the instructions found in

the TDC-10 manual. Select the Off, 17 dB, or 27 dB option button.
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Selected Channels Group

2-44

The Selected Channels group allows you to continue customizing the measure-

ments down to the individual channel. Some of the reasons why you might want

to have different setups for different channels include: different locations of the

VITS lines, lack of VITS signals on some channels (measurements must be

made using RF methods), or inability to turn the carrier off on some channels

(need to use alternative methods to make some measurements). The sub-groups

found under Selected Channels are: Carrier to Noise, VM700A VITS, ACL,

Mod. Depth, VM700A Msmts, CSO, CTB, and In Channel Response.

Measurements are faster and record keeping is easier if the VITS signals are

correct. In both NTSC and PAL, if the locations are not correct, the VM700A

will automatically search for them at measurement time. The VM700A puts the

location of the VITS that it finds in the text boxes for future reference.

To enter the Edit Setups dialog box for channel 2: double-click on channel 2 in

the Selected Channels list box or press TAB until the cursor is in the Selected

Channels list box, then use the arrow keys to highlight the desired channel (2).

Press ALT+e to enter the Edit Setups for Channel 2 dialog box shown in Figure

2-39. (Figure 240 shows a PAL version of the dialog box.)
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© Auto with Pause

© Single Sweep

©) Gated

Test Locations (MHz):

(Rel)

(Rel)

(Rel

(Rel

| ten

| Carrier to Noise - ¥M7004 VITS

@ ‘Auto: Line Field
© Auto with Pause Multiburst: =| 17 1

OGated Meow: [|
Composite:Noise Bandendth: [a hiHz f
Combination:

[ hod. Depth ¥VM700A Msmts. 4 ; ;

© Baseband | | @ Source A.C Netse [uieth
@ RF © Source B Sin{x}/x:

; cso -CTB

@ Auto @ Auto
(> Auto with Pause

© Single Sweep

Test Locations (MHz):

[os] @ Ret O Abs

[sd @ Rel © Abs

[| @ Rel © Abs

[id ® Rel © Abs

[| @ Ret © Ads

—GetDefaults |

As Defaults

[In-Channel Response]

©) Baseband (Sin{x}/x}

@ AF _] Gated
Test Locations (MHz):
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Edit Setups for Channel 2 55.25 MHz

| Carer to Noise - ¥M 700A ¥VITS ACL

© Upper

© Lower

@ Both

©) Auto with Pause

© Gated

Noise Bandwidth: [4 MHz

| Mod. Depth VEH7O0A Msmts. 7

© Baseband | | @ Source A.C _ Save As Defaults |
@ RF <>) Source B

Edit PAL VITS |

cso -CTB [ In-Channel Response)

@ Auto ® Auto © Baseband (Sin{x)/x)
© Auto with Pause ee @ RF C] Gated

o Single Sweep Test Locations (MHz}:

© Gated

Test Locations (MHz): Test Locations [MHz]:

fo Si siz @ Rel © Abs

[Rel] [| @ Rel © Abs

[ @ Rel © Abs

. ( s @ Rel © Abs

[| fren [| @ Rel © Abs

© Auto with Pause

© Single Sweep

Figure 2-40: The Edit Setups dialog box for channel 2 (PAL)

Carrier To Noise Group. Select the Auto, Auto with Pause, or Gated (the 2715

calls this “in service” measurements) option button. Auto with Pause expects the

carrier to be turned off and will prompt the operator to do so. Gated (Gated

measurements are only available for the 2715) allows you to make the measure-

ments on a “quiet” or unmodulated line (the quiet line is found in the Channel

Table. See Appendix C, page C—30, for more information.). This allows you to

make the measurements without taking the system out of service.) Enter the

bandwidth for the noise calculation in the Noise Bandwidth text box.

Modulation Depth Group. Select how to make the Modulation Depth measure-

ment. The options are to use RF (the 2714/2715) or baseband (VM700A).
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VM700A Measurements Group. Select the input for the VM700A. It can use either

Source A, C or Source B.

NOTE. The ICPM measurement cannot be made if Source B is selected.

VM700A VITS Group. Enter the locations of the various VITS lines in the Line and

Field text boxes. The VITS signals needed to make the measurements in the

NTSC measurement list are: Multiburst, Composite, Combination, Quiet Line,

and Sin(x)/x. You don’t have to enter the VITS locations; the VM700A will

search for them whenever they are required to make a measurement.

If the Channel Table for the current worksheet uses PAL as the video standard,

then there is a command button in this group. The command button allows you

to go to the PAL VITS dialog box. (There are more VITS signals in PAL and

they will not all fit in the available space.)

CSO Group. The measurement options are: Auto, Auto with Pause, Single Sweep,

or Gated. Auto performs this measurement without turning the carrier off. Auto

with Pause expects the carrier to be turned off and will prompt the operator to do

so. Single Sweep also expects the carrier to be turned off and will prompt the

user to turn it off. It also performs all of the measurements in one sweep, instead

of one sweep for each test location. Gated means that the measurement is made

on a “quiet” (unmodulated) line. This is only available for the 2715.

Enter the frequency locations (relative to the visual carrier) where this measure-

ment should be made.

See Distinguishing 2714 CTB and CSO Measurements on page 3-75 for a

discussion of how the CSO and CTB measurements are calculated.

ACL Group. Measures the power in the channels adjacent to the channel under

test. This is a headend test with the 2715 connected to the test port of the

modulator. Select Upper to measure the power in the upper adjacent channel

only, Lower to measure the lower adjacent channel only, or Both to measure both

the upper and lower channels.

CTB Group. The measurement options are: Auto, Auto with Pause, or Single

Sweep. Auto performs this measurement without turning the carrier off. Auto

with Pause expects the carrier to be turned off and will prompt the operator to do

so. Single Sweep also expects the carrier to be turned off and will prompt the

user to turn it off. It also performs all of the measurements in one sweep, instead

of one sweep for each test location.
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Enter either the absolute or relative frequency locations (relative to the visual

carrier) where you want this measurement made.

See Distinguishing 2714 CTB and CSO Measurements on page 3—75 for a

discussion of how the CSO and CTB measurements are calculated.

In-Channel Response Group. Make the In-Channel Response measurement using

either baseband or RF methods. Therefore, if the VM700A or the Sin(x)/x signal

is not available, make this measurement using the 271X.

Enter the frequencies (relative to the visual carrier) where you want the

measurement calculated (up to 6 locations for RF and 7 locations for baseband)

in the Test Locations text boxes.

If it is using the RF method the signal could also be gated. (Gated means that the

measurement is made on a test line and the carrier does not need to be turned

off.) The 2715 is the only instrument that can perform gated measurements.

Command Buttons for the Edit Setups for Channel XX Dialog Box. There are three

special command buttons located in the Edit Setups for Channel XX dialog box.

They are Get Defaults, Save as Defaults, and Copy to All Channels.

= Get Defaults. The Get Defaults command button takes the default Measure-

ment Setup values from the CSS500 initialization file and places them in the

text boxes. It also sets the option buttons to the default values. You select

which groups of default values you want loaded using the check boxes as

shown in Figure 2-41.

Get Defaults

[_] Modulation Depth

CJ ¥M700A Measurements

Figure 2-41: The Get Defaults dialog box
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Leave the Measurement

Setups Dialog Box

m= Save as Defaults. This command button takes the current entries in the text

boxes and selections of the option buttons and stores them as the default

Measurement Setup values in the CSS500 initialization file. It only saves as

defaults, the groups selected in the check. The rest keep the current defaults.

When a new worksheet starts, these defaults load automatically. You can also

load these defaults into selected channels using the Get Defaults command

button when editing the setups for those channels.

= Copy to All Channels. The Copy to All Channels command button takes the

settings on the current Edit Setups for Channel dialog box for the selected

groups and copies them to all of the channels. However, if the current

channel is digital, CTB and CSO setups are copied only to digital channels.

Similarly, if the current channel is analog, CTB and CSO setups are copied

only to analog channels.

NOTE. For both Save As Defaults and Copy to All Channels, the changes that

they make take place immediately. You don’t need to wait until you exit the

dialog box.

Leave the Edit Setups for Channel XX Dialog Box. Save all of the changes and

leave the Edit Setups for Channel XX dialog box and return to the Measurements

Setup dialog box by choosing OK.

Save all of the changes, leave the Measurement Setups dialog box and return to

the spreadsheet by choosing the OK command button.

Attach a Different Channel Table

NOTE. The CSS500 only recognizes a Channel Table by its name, not its

contents. It will not load a changed Channel Table into an instrument if it

already has a Channel Table by that name.

There will always be a Channel Table associated with a worksheet (the default),

so you can make measurements without changing the Channel Table. (If the

default Channel Table is corrupt or not available, the system will always try to

load the std.cht Channel Table.) Please see Appendix C or the on-line help for

more information about the Channel Table Editor (CTLOADE.EXE). This

section only deals with changing from one Channel Table to another.

1. Choose Worksheet Info from the Configure menu. The Worksheet Info

dialog box appears (see Figure 2-42).
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Worksheet Info

Site: [Tektronix - Beaverton

Description:

. Channel Table

File Name: Directories:

| std.cht | c:\css500

cS e:4

@= css500

help

9 limits

Drives:

| c: tektronix

eur_il.cht

hre.cht

irc.cht

japan-m.cht

japan_m.cht

std.cht

stdofst.cht

stndrd_cht

Figure 2-42: The Worksheet Info dialog box used to change the Channel Table

2. Select a Channel Table file from the list.

3. Choose OK to save the changes and exit the dialog box. The Warning in

Figure 2-43 may appear if there are measurements in the current worksheet.

This is to remind you that you are creating a new worksheet whenever you

change the Channel Table. (Only one Channel Table is allowed in each

worksheet.)
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CSS500 Warning W350

Figure 2-43: Warning message that the worksheet has changed

4. Choose the Yes command button to save the old worksheet. The new

worksheet, with the new Channel Table, is <untitled>.

You are now ready to make measurements using the new Channel Table and

worksheet. If this Channel Table does not exist in the instruments (by name),

CSS500 will automatically load it as soon as it is needed.

The exception is the TV1350 and EMFP Demodulators. They load the frequen-

cies from the channel table only as needed. They do not load the Channel Table

into their own memories.

Configuration Preferences

There are several ways to configure the CSS500 application that are not directly

related to making measurements. These options are located in the Configure

menu under Preferences.

From the Configure menu, choose Preferences. The Preference dialog box looks

like Figure 2-44.
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ae Preferences

| Measurement History

®Keep Last Result Only:

©) Collect History

- Power Level Units

@ dBmy¥

©) dBu¥

| Measurement Execution

O Pause on New Channel

Exec. ¥VH700A

Pause Execution Report out RS-232 Function

C] On Caution L] On Caution (] On Caution

CJ On Alarm CJ On Alarm [] On Alarm

CJ On Error (| On Error [] On Esror

Figure 2-44: The Preferences dialog box

There are three Preferences groups. They are: Measurement History, Power Level

Units, and Measurement Execution.

Measurement History — This group allows you to collect history or keep only the results of the last

Group _ measurement. If you choose to collect history, the previous results are saved but

not visible on the spreadsheet. The spreadsheet is actually three dimensional (the

three dimensions are Channel, Measurement, and Time) but only two dimensions

are visible (Channel and Measurement). Only the top (most recent) measurement

of the time stack is visible on the spreadsheet. The three-dimensional spreadsheet

structure is illustrated by Figure 2-45.
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Figure 2-45: A three-dimensional view of a spreadsheet.

When Collect History is selected, measurement results are saved beginning with

the current measurement (what is currently in the spreadsheet).

An example of why you would want history collected on a measurement is the

24 Hour variation test. This measurement is performed by running the Carrier

Levels and Frequencies four times in a 24 hour period and comparing the

collected results. Another example is a measurement that is failing sporadically.

By taking the measurement over a period of time and collecting the history, a

trend might become evident.

The way that the history is saved is best illustrated by an example of the life of a

cell, as shown in Figure 2-46.

Turn history on.

Make 2 more measurements

Stack after 4 more

measurements

Turn history off here

Measurements

in the “stack”

Figure 2-46: The effect of turning Collect History off and then on
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Power Level Units Group

Measurement Execution

2-54

Group

The first column in Figure 2-46 shows three measurements made with Collect

History turned on. After the third measurement, the history is turned off and four

more measurements are made (for a total of seven). The results are shown in the

second column. You still have the first three measurements stored in history,

measurements four through six have been written over, and measurement seven

is presently displayed in the cell. After the seventh measurement, Collect History

is turned back on and two more measurements are made (for a total of nine). The

results are shown in the third column. The first three measurements are still there

and seven through nine are added to the history stack.

If you want to view the history of a measurement, one way is to look at the

Results Detail display. In this display, you can flip through the results to see

what the measurement results were in the past (a lot like flipping through sheets

in a log book).

The option buttons select between Visual Carrier Level and Average Power

Level units in dBmV (referenced to 1 mV) or dBuV (referenced to 1 uV).

These check boxes select:

whether or not to prompt the operator to make the required equipment

connections before a requested measurement is executed

= whether or not to pause on a new channel

m the type of action to take (if any) if a measurement falls into an alarm or

caution range or has some type of error

Prompt for Signal Connection. An example of this type of prompt is a dialog box

requesting the operator to properly connect the signal under test to the test

equipment. You must choose the OK button before the measurement will

continue. This allows the operator to manually switch the RF signal between the

271X and demodulating equipment using one RF signal tap rather than requiring

a splitter.

If this option is checked and a measurement is executed that requires both RF

and baseband testing, all of the RF measurements are done first. Then all of the

baseband measurements, so the connection only needs to be changed once.

Pause on New Channel. If you want to be informed that measurements are ready

to begin on a new channel, select this check box. If it is turned on, the measure-

ments stop whenever a new channel is encountered until you choose the OK

button. One of the things this allows you to do is tune an external preselector to a

new channel.
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Alarm, Caution, or Error Conditions. These check boxes allow you to be notified

in several ways if an error, alarm, or caution flag occurs during a measurement.

Three different actions can occur: a report can go out the RS-232 port, the

VM700A alarm function can operate, or the CSSS00 can stop making measure-

ments and post an alarm message. You can use any combination of these options.

The Pause Execution check boxes stop the measurements if a measurement is

encountered that is in Alarm (cell is red), Caution (cell is yellow), or Error (cell

is blue) until the user chooses the OK command button. It is useful for system

monitoring because it forces you to become aware of bad or non-standard

conditions. It also sends a CSS500~ALARM_OFF function to the VM700A.

Report out RS-232 sends a Violations Report out a Com Port (set with the

Connections dialog box). Based on the selections, the following information is

sent: Site Name, Measurement Column Heading, Channel Number, Program,

Condition Type (alarm, caution, or error), and Date/Time. This information is

tab-delimited and packetized. (For more information on intercepting an alarm,

see Measurement Execution on page 3-54.)

Execute VM700A Function calls a VM700A function when the selected

conditions occur. When this is enabled and a condition occurs, a specific internal

VM700A function is executed. It is CSS500~ALARM_ON. This activates the

alarm. This default function is loaded in the VM700A as required. First CSS500

attempts to play back the appropriate function. If there is no function by that

name, then the default function loads into the VM700A. This function controls

the relay switch located on the back of the VM700A between the two RS-232

ports. CSS500~ALARM_ON closes the relay. (CSS500~ALARM_OFF opens

it.) You can create your own function by the same name. CSS500 will not

overwrite the function if it already exists in the VM700A. The functions created

by the user can perform any type of action. This can be printing messages on the

printer or even dialing a personal pager by way of a modem attached to one of

the VM700A Serial Ports. See the VM700A manuals for more information on

how to write your own functions.

NOTE. Pause Execution sends the CSS5|00~ALARM_OFF VM700A function. The

default CSSSO0~ALARM_OFF function opens the relay on the rear of the

VM7O0A. (This is the same relay that the CSS5SOO~ALARM_ON function closes.)
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Set the Preferences

Make Measurements

Using the Defined

Preferences

Set the Preferences to:

Collect History

dBmvV Power Level Units

Prompt for Signal Connection

Pause on New Channel

Pause Execution — On Alarm

Select the first two channels’ Carrier Levels and Frequencies.

From the Measure menu, choose Current Selection. First, you are prompted

to connect the 2714/2715 (see Figure 2-47). If necessary, connect the input

signal to the 2714/2715, then choose the OK command button to continue.

(The Cancel command button will stop the measurement and return you to

the spreadsheet.)

CSS500 Message

Figure 2-47: Prompt to connect the input signal to the 2714/2715

The software pauses at the next channel, as shown in Figure 2-48.

CSS500 Message

Execution paused for next channel

Figure 2-48: Message box stating that the measurements are paused.
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3. If necessary, tune the preselector to the channel, then choose the OK

command button to continue. If any of your measurement results fall into the

Alarm range, Figure 2-49 is displayed.

Alarm generated for current measurement

Figure 2-49: The message box displayed when a measurement result falls into an

Alarm range

4. Choose the OK command button to continue making measurements. (You

have another option. You could choose the Cancel command button to stop

making measurements and handle the measurement alarm.) When the

measurements are finished with the first channel, the Paused for Next

Channel message is displayed, as shown in Figure 2—50.

CSS500 Message

_ Execution paused for next channel

Figure 2-50: Message box stating that the measurement is paused

5. If necessary, tune the preselector, then select the OK command button to

finish making the measurements.
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Review

2-58

Now that you have completed this chapter you should be able to do the

following:

= Pick and set up the correct demodulator. (page 2-39)

mTM Review the RS-232 and GPIB connection setups. (page 2-40)

m Set how measurements are made. (page 2-41)

m= Set the measurement setups for the 271X. (page 2-42)

m Set the TDC-10 controls. (page 2-43)

= Set the correct location of the VITS. (page 2-47)

= Change to a different Channel Table. (page 2-49)

m= Select whether or not to collect history. (page 2-52)

@ Select the Power Level Units. (page 2-54)

= Turn on or off the user prompts. (page 2-54)
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Viewing the history of a measurement

Copying data to other Windows applications

Viewing violations

Using the various View Filters

Changing and defining limits

Defining a User Defined Program (UDP)

Loading the results of a UDP back into the application

Reset the Preferences and Worksheet for this Chapter

1.

Make Measurements to 1.

Collect History

Make a new worksheet and call it “example.wrk”. (Overwrite any old

worksheets.)

From the Configure menu, choose Preferences. Set Preferences to:

B Collect History

= dBmV Carrier Amplitude Units

= No Prompt for Signal Connection (unless necessary for your equipment

setup)

= No Pause on New Channel (unless necessary for your equipment setup)

= No Pause on Alarms, Cautions, or Errors

From the Configure menu, choose Measurement Setups. Make the appropri-

ate selections for your system.

From the Configure menu, choose Worksheet Info. Select the std.cht

Channel Table (or other appropriate Channel Table). Select a Site name. (The

examples use Tektronix — Beaverton.)

Select the first two channels’ Hum/LFD and FCC Baseband.

From the Measure menu, choose Current Selection or choose Meas Sel from

the Button Bar.
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3.

Results Detail Display

Repeat three or four times to collect history for these measurements.

We have collected some history and are ready to view the Results Detail display.

Enter the Results Detail Display for your first channel HUM/LFD:

1.

2.

Select the Hum/LFD cell of your first channel.

Choose the Results command button on the Button Bar; or click on the cell

with the right mouse button; or, from the View menu, choose Results Detail.

The Results Detail dialog box is shown in Figure 2-51.

Results Detail far HUMILED

Channel 2 55.25 MHz

Channel Table: std. cht

Site. Tektronix-Beaverton

He View Filter is On

[ Worksheet Navigation Select History }

Prey

Measurement Summary

Measurement
» | ¥iolated | Violated

Result Lower | Upper
Limit Limit

3

Figure 2-51: The Results Detail dialog box for the HUM/LFD measurement

Note that the Select History Next command button is gray but the Prev button is

black. This indicates that you are looking at the most recent measurement results

and there is history on that measurement.

3

4.

Look at the History of this 1.

Measurement

2.

2-60

Scroll the Results Detail dialog box horizontally to display the Date/Time

and Test ID. Note the time of the measurement.

Scroll back to the far left of the Results Detail dialog box.

Choose the Prev command button. Note that this information is from the

previous time you made this measurement. Confirm this by scrolling

horizontally to the Date/Time column.

Choose the Prev command button again.
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Repeat until the Prev command button is gray. You are now at the first

measurement for this cell on this worksheet.

Choose the Next command button until you are back to the most recent

measurement. (The Next command button is gray.)

Move Around inthe You use the Worksheet Navigation arrows to move between channels and

Results Detail Display |= measurements without leaving the Results Detail Display.

1.

Results Detail for FCC Baseband

Channel: 2 55.25 MHz

Channel Table: std cht

Site: Tektronix-Beaverton

No View Filter is On

Worksheet Navigation Select History

Measurement Summary

Figure 2-52: The Results Detail dialog box for the FCC Baseband measurement for the first channel

2. Move to the FCC Baseband measurement for your second channel. Choose

the Worksheet Navigation down arrow. Note that the channel number

changes.

3. Move to the Hum/LFD measurement for your second channel. Choose the

Worksheet Navigation left arrow.

4. Move back to where you started (Hum/LFD for the first channel). Choose

the Worksheet Navigation up arrow.
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NOTE. The equipment making the measurements places the information that you

see in the Notes Field. Please see Notes under Measurement Summary on

page 3-33 for how to decode this information.

5. Choose Close to leave the Results Detail Display and return to the work-

sheet.

NOTE. The active cell in the worksheet is the last cell navigated to in the Results

Detail Display.

Status Report and View Violations Displays

2-62

The Status Report is available to give an impression for how the system is doing

as a whole. The Status Report lists all of the measurements and channels with the

worst measurement results (based on the active View Filter). The Violations

Display is available from the Status Report and it lists all of the measurement

Cautions and Alarms.

1. Make all of the measurements for the first three channels. The worksheet

looks like Figure 2-53.

NOTE. In older 2714 firmware versions, anytime you are making a CSO

measurement, a message that the 2714 is executing a CTB measurement appears

on the 2714's display. Although unexpected, it is correct and only an artifact of

the method that older firmware versions of the 2714 use to measure CSO.
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Tektronix — CS8500

1| Worksheet: <untitled> Site: Tektronix-Beaverton

{Chan Table: std.cht Test ID: test 43:16:35

Visual

m5 15.9 4.504287

4.495698

Figure 2-53: The worksheet after making all of the measurements for the first three channels

2. To display the Status Report choose either the Status button from the Button

Bar or Status Report from the View menu. This displays the Status Report

dialog box as shown in Figure 2-54. The measurements are in the same

order as they are in the spreadsheet with the addition of the Visual Carrier

Level (Adjacent) results. The worst case is listed for each measurement.

Lee status Report

Channel Table: std.cht

Site: Tektronix-Beaverton

No View Filter is On

Measurement Summary

Visual Carier Level [dBm¥]

Aural Carer Level (dBc) _Max

Max Dey » 64.495Aural Frequency Offset (MHz) _

Figure 2-54: The Status Report dialog box

3. Choose the View Violations display command button to see all of the

measurement results that are either in Caution or Alarm states. (See
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Figure 2-55.) The Violations are first sorted by Alarms and Cautions

(Alarms first), then by channel number (same order as the spreadsheet), and

finally by the measurements. In the View Violations dialog box shown in

Figure 2-55, all of the measurement alarms for channel 2 are first, then

channel 3, and so forth. From the View Violations dialog box, you can go to

the Results Detail display.

View Violations

Channel Table: std.cht

Site: Tektronix-Beaverton

No View Filter is On

‘Violated
Lower _

Limit

Aural Frequency Offset (MHz)

Aural Carrier Level (dBc)

Aural Frequency Offset (MHz)

isual Carrier Level Adj. (dB)

Visual Carmier Frequency (MHz)

Aural Carrier Level (dBc)

Aural Frequency Offset (MHz)

Visual Carrier Level Diff. (dB)

Visual Carrier Frequency (MHz)

Aural Carrier Level [dBc]

Aural Frequency Offset (MHz)
Visual Carer Frequency (MHz) = -55.237924

isual Fr 2) 7.258121

Figure 2-55: The View Violations display

4. Goto the Results Detail display for your first measurement in the View

Violations dialog box. (In this case it is Aural Carrier Level for Channel 2.)

5. Place the cursor somewhere in the first row.
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6. Either double-click the left mouse button in that cell, single-click with the

right mouse button, or choose the View Results Detail command button (see

Figure 2-56.) This is the same Results Detail display that you would access

by selecting that channel and measurement cell from the spreadsheet and

then either clicking the right mouse button or choosing the Results command

button from the Button Bar.

Channel: 2 55.25 MHz

Channel Table: std cht

Site: Tektronix-Beaverton

No View Filter is On

Measurement Summary

Figure 2-56: The Results Detail display

7. Close this display and return to the View Violations display.

8. Close the View Violations dialog box. You are now back to the Status

Report. Notice that you can enter the Results Detail display from this dialog

box.

9. Enter the Results Detail display for your first entry in the Status Report.

(Place the cursor anywhere in the first row. Either double click with the left

mouse button, single click with the right mouse button, or choose the Results

Detail command button to enter the Results Detail Display.)

10. Close the Results Detail display. You are back to the Status Report.

11. Close the Status Report and return to the spreadsheet.

Quick Summary of the — The Status Report and View Violations display are two nested reports or

Status Report and View measurement summaries of what is going on in the worksheet. Either can access

Violations the Results Detail display for any measurement result of interest.
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Copy and Export

Copy to the Clipboard

2-66

Print any of these by choosing the Print command button from the dialog box.

The View Filter also affects these displays. (See page 2-73 for more information

on the View Filter.)

If the Include History check box is selected, the results include all of the

measurement results collected. If it is not checked, then only the most recent

measurement results are included.

You know how to collect measurement results and one way to display history.

What if you want to take results that you have collected and use them for reports

or to graph trends? You can transfer the data to other programs such as Excel or

Word, through either the Copy or Export commands.

Copy and Export are the two ways of getting data out of the spreadsheet and into

other Windows applications for additional processing or to include information

in reports. Copy moves the data to the Windows Clipboard, while Export saves

the data as a results (*.wsr) file.

There are many reasons why you might want to move a few cells of data from

the CSS500 application into some other Windows application. You might want

to average some of the measurements or make a graph of some channels that

seem to be deteriorating or paste them into a report. The easiest way of getting a

few cells of data is to copy them to the Clipboard using Copy from the Edit

menu.

Copy Cells to the Clipboard

1. Select the Carrier to Noise cell for the first channel and make that measure-

ment several times.

2. With that cell still selected, from the Edit menu, choose Copy. The Copy

dialog box appears as shown in Figure 2—57.
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No View Filter is On

© As Displayed

@ Export Format

Figure 2-57: The Copy dialog box

3. Select the Export Format option button and the Include Measurement

History check box.

4. Select the OK command button. The information from the spreadsheet is

copied to the Clipboard.

Paste the Clipboard Data 1. Use Switch To, from the CSS500 Control Box, to start the Excel application.

into Excel (Either go to the Program Manager to start it or go to Excel directly if it is

already running.)

2. Select the first cell in the Excel sheet.

3. From the Excel Edit menu, choose Paste. This loads the new data into the

sheet. (You may need to change the format width of the columns in order to

read the data.) The resulting spreadsheet looks similar Figure 2-58.
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Microsoft Excel - Sheet!

File Edit Formula Format Data Options Macro Window

Figure 2-58: The results of pasting the Clipboard data into Excel

4. Use Switch To, from the Excel Control Box, to return to the CSS500

application.

NOTE. If you try to copy an entire row filled with measurements into Excel, the

operation will fail, there are more columns than Excel can handle. It is strongly

suggested that you separate the Audio measurement results and put them in a

different Excel file.

Use the Copy As Displayed Format. There is a difference between copying data As

Displayed and in Export Format. The As Displayed format will not copy any

history or header information such as Site or Test ID. In this format, only the

Measurement and Channel Header information follow the cell data. This is

useful if you only want to process the data and don’t want any additional

information.
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Paste the Clipboard Data

Select the Carrier to Noise cell for the first four channels and make some

measurements.

With those cells still selected, choose Copy from the Edit menu. The Copy

dialog box appears as shown in Figure 2-59.

No View Filter is On

| include Meaamemert History

Figure 2-59: The Copy dialog box

Select the As Displayed option button.

Choose the OK command button. The information from the spreadsheet is

copied to the Clipboard.

Switch to the Excel application.

into Excel ;
Select a cell in the spreadsheet.

From the Edit menu, choose Paste. This loads the new data into the

spreadsheet. Figure 2-60 shows the results. Notice the differences between

the two spreadsheets (see Figure 2-58 and Figure 2-60).
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icrosoft Excel -

Figure 2-60: The result of the Copy As Displayed pasted into Excel

2-70

4. Use Excel to make a graph of the measurement results’ trend, similar to the

one shown in Figure 2-61.
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70

60

50

40 +

dp 30 +

20 +

10 +

55.3 61.3 67.3 77.3

Channel (MHz)

Figure 2-61: Data for the Carrier to Noise Ratio for four channels

5. Switch back to CSS500.

Using Export — Use Export when you want to save the results to a file instead of just to the

clipboard. This is useful for archiving the measurement results without needing

to save all of the files necessary to archive an entire worksheet.

1. Select the desired cells.

2. From the File menu, choose Export. The Export dialog box looks similar to

Figure 2-62.

CSS500 Cable Television System Software User Manual 2-71



Advanced Measurements Tutorial

2-72

File Name: Directories:

[try ST | c:\css500

(> ec:

@ css500

& help

2 limits

Drives:

1c: tektronix

Figure 2-62: The Export dialog box

3. The worksheet name with a “.wsr” extension is automatically inserted in the

File Name combo box. If you want a different filename, type it in the combo

box.

4. Select Include Measurement History.

5. Choose the OK command button to export the data to a file.

NOTE. You cannot import a *.wsr file into Excel. It has more columns than Excel

supports. If you want to load data into Excel, use Copy — Export Format and

select only a few measurement columns at a time.

6. Clear the worksheet (including history) to be ready for the next exercises.
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View Filters

Measurements and

Channels View Filter

There may be times when you do not want to see the entire list of measurements

and channels on the spreadsheet, rather only the few that you are working with at

the moment. You can simplify the spreadsheet down to only the interesting cells,

through the use of three View Filters. They are: Measurements and Channels,

Sequence Results, and Test ID. These filters hide any measurements results that

you are not currently interested in. The View Filters affect most of the other

displays such as Global View and Results Detail. These displays only show the

same measurement results as the main spreadsheet.

The View Filter affects Copy operations; if you cannot see it, you cannot select

it. Export always sends the entire worksheet to the *.wsr file, regardless of the

View Filter Status.

Only one View Filter can be on at a time and the filter that is on is displayed in

the View Filter Status Box in the Worksheet Header.

If a View Filter is on, many other operations are locked out. For example, if

Measurement Sequence View Filter is on, Meas Sel from the Button Bar is

unavailable.

Set the View Filter so that only the first four measurements for the first two

channels are in view.

1. Select the Carrier Level and Frequency measurements for the first two

channels. Make the measurements.

2. From the View menu, choose Measurements and Channels. The Measure-

ments and Channels dialog box appears as shown in Figure 2-63.
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Measurements and Channels

| View Measurements

Selected Measurements Available Measurements

Visual Carrier Level

Visual Carrier Freq

Aural Canter Level

Aural Canier Freq

2nd Aural Canier Level

2nd Aural Canier Freq

Average Power

Carrier to Noise

Desired to Undesired

cso

CIB

Visual Canter Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

2nd Aural Carrer Level

2nd Aural Carrier Freq

Average Power

Carrier to Noise

Desired to Undesitred

cso

CIB

| View Channels

@ All Channels

©) Selected Channels

Selected Channels Available Channels

2-74

Figure 2-63: Measurements and Channels View Filter dialog box

Under the View Measurements group, select the Selected Measurements

option button.

Select everything except Carrier Levels and Frequencies (Visual Carrier

Level, Visual Carrier Frequency, Aural Carrier Level, and Aural Carrier

Frequency) from the Selected Measurements list box. (Hint: select 2nd Aural

Carrier Level, then scroll to the bottom of the list. Hold down the SHIFT key

and click on the last measurement.)

Choose the Unselect command button to remove all of these measurements.

(The only measurements left in the Selected Measurements list box are

Carrier Levels and Frequencies.)

Under the View Channels group, select the Selected Channels option button.
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Select everything except the first two channels from the Selected Channels

list box.

Choose the Unselect command button to remove these channels. (Only the

first two channels, 2 and 3, remain in the Selected Channels list box.) The

Measurements and Channels dialog box now resembles Figure 2-64.

Measurements and Channels

| View Measurements

Selected Measurements Available Measurements

Yisual Carrier Level

Visual Carrier Freq

Aural Camier Level

Aural Carnier Freq

Visual Carrier Level

Visual Carrier Freq

Aural Carrier Level

Aural Carrier Freq

2nd Aural Cartier Level

2nd Aural Carer Freq

Average Power

Carrier to Noise

Desired to Undesied

cso

CIB

[ ¥iew Channels

© All Channels

@) Selected Channels

Selected Channels Available Channels

2

3

Figure 2-64: The Measurement and Channels dialog box

9. Choose the OK command button to save the changes and leave the dialog

box. The spreadsheet looks similar to the one shown in Figure 2-65.
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Edit View Measure

Tektronix — CSS500

Configure Execute HelpFile

Worksheet: <untithed> Site:

1] Chan Table: std.cht Test ID: test 43:16:35

Tektronix-Beaverton

atrier eq |
Ley {dBc} | Offset [MHz]

143

Figure 2-65: The Spreadsheet with the Measurement and Channels View Filter on

Measurement Sequence

2-76

Results View Filter

NOTE. Notice that although the first six measurements are tied together under

most circumstances, the View Filter allows them to be viewed separately. If you

request one of these measurements, CSS500 will try to make all six even if they

are not in view. (It cannot make the Second Aural Measurements if they are not

enabled in the Channel Table.)

10. Return to the full spreadsheet. From the View menu, choose Measurements

and Channels. The view automatically switches back to the full display. You

can toggle between the filtered and full view by selecting/deselecting

Measurements and Channels from the View menu.

If you only want to see the results from the last Measurement Sequence, use the

Measurement Sequence Results View Filter. At the end of every Measurement

Sequence execution you are prompted if you want this filter turned on.

For example: define a Measurement Sequence, run it, and then display only its

results using the View Filter.

1. Clear the present spreadsheet. (From the Edit menu, choose Select All. Then

from the Edit Menu, choose Clear and select the check boxes to delete

Current Values and Measurement History.)

2. From the Configure menu, choose Measurement Sequence. (You are now in

the Measurement Sequence dialog box.)

3. Choose the Clear Sequence command button to clear the Measurement

Sequence.
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4. Select the following measurements for the first four channels:

= Carrier Levels and Frequencies

mTM FCC Baseband

= Waveform Distortion

= = Multiburst

5. Choose the Edit Time Parameters command button. (You are now in the Edit

Time Parameters dialog box.)

6. Select the Run Immediately check box and make sure that the Run Continu-

ously check box is not checked.

7. Choose the OK command button to save the changes and leave the Edit Time

Parameters dialog box. (You are back to the Measurement Sequence dialog

box.)

8. Choose the OK command button save the changes and leave the Edit

Measurement Sequence dialog box. (You are back to the spreadsheet.)

9. Select the Meas Seq command button on the Button Bar to run the Measure-

ment Sequence. At the end of the Measurement Sequence, a dialog box

similar to Figure 2—66 is displayed.

CS35500 Warning W357

Figure 2-66: The prompt to turn on the Measurement Sequence Results filter given

at the end of a Measurement Sequence

10. Choose Yes to turn on the Measurement Sequence View Filter. The

spreadsheet looks similar to the one shown in Figure 2—67. Notice that there

are no Second Aural measurements. They are not enabled in this Channel

Table.

CSS500 Cable Television System Software User Manual 2-17



Advanced Measurements Tutorial

ee Tektronix — CSS508

File Edit View Measure Configure Execute Help

Dp

Worksheet: <untitled> Site: Tektronix-Beaverton

Chan Table: std.cht Test ID: test 43:16:35

‘requen

| Offset {MHz}

159 4504297

-15.5 4.495698

11. Turn off the Measurement Sequence Results filter. From the View menu,

choose Measurement Sequence Results. This toggles the View Filter off. You

are back to the standard spreadsheet display.

NOTE. If you went in and defined a new Measurement Sequence and ran it, then

turned on the Measurement Sequence Results filter, you will see only the results

from the last Measurement Sequence — not the old one.

Test ID Results View Filter | There are times when you only want to see a subset of the measurements made at

a particular site. This is when the Test ID Results View Filter is useful. For

example, if Pre-Converter and Post-Converter measurements are made under

different Test IDs, then they can be viewed separately using the Test ID Results

View Filter.

You have been operating under the Test ID “Learner’s Permit.” Now change your

Test ID, make a few measurements under that ID, and look at the results using

the Test ID View Filter.

1. Choose the Test ID command button on the Button Bar.

Type: “Training Wheels” in the text box.2.

3. Choose the OK command button.

4. Select the ICPM measurement for the first four channels.

5. From the Measurement menu, choose Current Selection.
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6. From the View menu, choose Test ID Results. The results should be similar

to Figure 2-68.

jo Tektronix — CSS508

File Edit View Measure Configure Execute Help

Meas Seal|T

Worksheet: <untitled> Site: Tektronix-Beaverton

Chan Table: std.cht Test ID: Training Wheels9eoeooeesd? ®@
Figure 2-68: The results of turning on the Test ID Results filter\ I q

7. Choose the Test ID command button on the Button Bar.

8. Display the selection of Worksheet Test IDs and select “Learner’s Permit”.

(The Worksheet Test IDs are the Test IDs used in the current worksheet. The

other list is all of the Test IDs ever used.)

9. Choose the OK command button to save the change and exit the Test ID

dialog box. You will only see the measurements that you made under the

Learner’s Permit Test ID — not the ICPM measurements.

10. From the View menu, choose Test ID Results to turn the View Filter off and

return to the normal spreadsheet with measurements collected from both Test

IDs displayed.

Defining Limits

Limits files determine how to characterize your measurement results. Results can

be passing, in alarm, in caution, or have no limits defined. You can change the

range of these values to suit your own application. In fact, you can have a

different set of limits for every channel. For example, the premium and the

public access channels may have their own unique Limits files.

Edit a Limits File —_ First, enter a Limits file to see the information contained there.
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that Limits file.

J CAUTION. When you edit a Limits file, the changes affect all worksheets using

Chan # = Limits File

ntsc.lim

ntsc.lim

ntsc.lim

ntsc.lim

ntsc .lim

ntsc .lim

ntsc.lim

ntsc.lim

ntsc .lim

ntsc .lim

ntsc.lim

ntsc.lim

ntsc.lim

ntsc .lim

ntsc .lim

ntsc.lin

1. Choose the Limits command button on the Button Bar, or, from the

Configure menu, choose Measurement Limits. This displays the Measure-

ment Limits dialog box, as shown in Figure 2-69.

Measurement Limits

Sema *)| Clear Limits File || Clear Audio Limits |
SystemTMDefa |

SystemTMDefd | | <-- Select Limits File
SystemTMDefa | — :

SystemTMDefd |

SystemTMDefa | ;
bedefSustemTM’Defa | F ae a

SyustemTMDefa | LongH aul

ES ShortHaul

xyzdef

| Select Audio Limits | | Cancel |

SustemTMDefa |

SystemTMDefq |

SustemTMDefd |

SystemTMDefa |

SystemTMDef¢

SyustemTMDefa +:

[ Summary Limits

Figure 2-69: The Measurement Limits dialog box

2-80

In the present setup, all of the channels have the same Limits file associated with

them, “ntsc.lim”. Now take a look at the contents of this file (or whatever Limits

file you might like).

2. Select a Limits file from the Limits file combo box (the example uses

ntsc.lim).

3. Choose the Edit Limits File command button. Figure 2-70 shows the Edit

Limits File — ntsc.lim dialog box.
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Figure 2-70: The Edit Limits File - ntsc.lim dialog box

Three of the columns (Range Lower Limit, Range Upper Limit, and Units)

define the allowable ranges. These columns are not editable. The other four

columns define the Alarm and Caution ranges.

The Caution and Alarm columns define the way the measurement results are

categorized. See Figure 2—71 for an example of the three types of measurements

and the different limits that they require. The Aural Frequency Offset requires

both upper and lower limits. The Carrier to Noise Ratio has only lower limits.

The ICR has only upper limits.
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Aural carrier frequency

Upper and lower
Alarm Caution Good Caution Alarm fimits

=>

-5 -3 3 5 kHz

Carrier to noise

Alarm Caution Good Only lower limits

———_>

43 45 dB

ICR

Good Caution Alarm Only upper limits

<__

1.5 2 dB

Figure 2-71: How limits work

If you attempt to enter an Upper or Lower Limit outside the ranges defined, you

receive an error message (as shown in Figure 2—72) that the value is out of range

and are returned to that cell to re-enter an acceptable value.

CSS500 Error E315

Figure 2-72: An example of an error message

You can edit the Alarm and Caution ranges to as tight or loose a specification as

desired as long as the value is in the acceptable range and maintains the

relationship:

Alarm Lower Limit < Caution Lower Limit < Caution Upper Limit < Alarm

Upper Limit

Note that there are different measurements in the Limits file depending on the

video standard (NTSC or PAL). The video standard is set in the Channel Table.

Practice editing the Limits file by tightening the Alarm and Caution limits on a

few measurements and then save it as a new Limits file. (Remember, any change

that you make to a Limits file affects all channels and worksheets using that file.)
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CAUTION. When you edit a Limits file, the changes affect ALL worksheets using

| that Limits file.

Edit the Limits File 1. Choose the Clear Limits command button. This erases all of the old limit

values.

2. Choose the Get Defaults command button. This loads the limit values

corresponding to the default Limits file.

3. Select the Visual Carrier Frequency measurement—Caution Lower Limit cell.

(Present value is —5 in the example.)

Type “—4”. (Values automatically overwrite.)

Move the cursor to the Caution Upper Limit cell.

Type “4”.

Select the Visual Carrier Frequency measurement—Alarm Lower Limit cell.

Enter “—20”.a i Press TAB to move to the Alarm Upper Limit.

10. Enter “20”.

11. Choose the Save As Limits File button to save the file.

12. Save this as a new file.

13. You are prompted for a new name and the cursor is already in the list box.

Type in “learners”.

14. Choose the OK command button, to leave the Edit Limits dialog box. You

are back to the Measurement Limits dialog box.

Attach a Limits Filetoa 1. Select the first channel on the list. (In the example, it is channel 2.)

Channel . ae
2. Select your file “learners.lim” from the Limits list box. The selected file

appears in the box at the top of the list box.

3. Attach the file to the channel. Either double click on the file name with the

left mouse button or choose the Select Limits File command button.

The Limits file for channel 2 is now “learners.lim’’.

Remove a Limits File from 1. Select your second channel. (In the example, it is channel 3.)

a Channel
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Return to the Spreadsheet

to See the Results

Audio Limits

Summary Limits Group

2-84

2. Remove the Limits file associated with that file. Choose the Clear Limits

File command button. Channel 3 no longer has a Limits file associated with

it and the Limits File column is blank. (You know that a measurement has no

defined limits when the results are in white cells on the spreadsheet.)

= Choose the OK command button to save the changes and return to the

spreadsheet. Notice that the Alarm and Caution ranges have tightened (and

may have changed colors) and that all measurements in the second channel

are now in white cells.

2. Choose the Limits command button from the Button Bar to return to the

Measurement Limits dialog box.

3. Change your first two channels back to their previous Limits file, “ntsc.lim”.

4. Choose the OK command button to save the changes and return to the

spreadsheet.

Audio Limits are attached to the channels in the same manner as the normal

Limits file. There are a few important differences to note. You can only edit the

Audio Limits file at the VM700A. Use the Get Audio Limits command button to

retrieve Audio Limits from the VM700A and make them available to CSS500.

Once a measurement is made using the selected Audio Limits, the measurement

results are always tagged with the selected Audio Limits file. For example, you

make some audio measurements and they come back in alarm. You go to the

VM700A and loosen the Audio Limits file so that the results should now pass.

You return to the worksheet and the measurement results are still shown in

alarm. For more information on the Audio Limits, see page 3-68.

The Summary Limits affect all of the channels and are not associated with any

particular Limits file. Edit the Visual Carrier Level Difference and the Adjacent

Visual Carrier Level Difference like any other text box. Click on the text box and

enter a number between 0.0 and 40.0 to set the Alarm and Caution flags.

The results of these limits are not available on the main spreadsheet, but rather in

the reports (such as the Status Report and the Measurement Summary for the

Carrier Levels and Frequencies).

Visual Carrier Level Difference. These calculated results look at the results of the

Visual Carrier Level measurements to find the highest and lowest level across all

channels. The difference between them is the result.

Adjacent Visual Carrier Level Difference. These are calculated results that show the

difference in Visual Carrier Level between two channels that are adjacent in

frequency.
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NOTE. If you have a View Filter on so that not all channels are displayed, the

calculated results do not comply with FCC requirements, because CSS500 only

looks at the displayed channels. Make sure no View Filters are on when you

want to check these results.

Set the Summary Limits. Choose the Limits command button from the Button

Bar. Figure 2—73 shows a portion of the Measurement Limits dialog box.

Lower Upper Lower Upper

Caution Caution Alam Alarm Range

Visual Carrier Level Difference dB}. -- [6 =| {0 - 40)

Adjacent Visual Carier Level Difference (dB): --- o-- [3 {0 - 40)

Figure 2-73: The Summary Limits (located at the bottom of the Limits dialog box)

Edit the text boxes as required.

Choose the Parameters command button to set the window for adjacent channels.

This dialog box (see Figure 2-74) defines what constitutes an adjacent channel.

Any “adjacent” channels that are outside of this frequency window are not

included in the calculations. Select what is required for your system and then

choose OK.

Parameters

Adjacent Channel Window: MHz
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Choose the OK command button to save the changes to the measurement limits

and exit the Measurement Limits dialog box.

The 2714/2715 User Defined Program (UDP)

2-86

Define a UDP

There are many times when tests need to be run at a remote location away from

the convenience of the computer running the CSS500 application, but you still

want incorporate the data into the spreadsheet. The answer is to generate a User

Defined Program (UDP). A UDP is basically a Measurement Sequence run on

the 2714/2715 at a remote location. When the remote testing is completed, return

the results to the CSS500 application and the spreadsheets and reports are very

similar to the data collected directly with the CSS500 application. For example:

a worksheet is used to generate a UDP for the 2714/2715. The 2714/2715 is

removed and taken to various field test locations, using the UDP for measure-

ment results gathering.

Remember that the UDP carries not only the Measurement Sequence instruc-

tions, but also much of the header and configuration information. Table 3—7, on

page 3-61, gives a complete list. It is important to check the following dialog

boxes to make sure that they describe the way that you want the UDP to operate:

= Worksheet Info, from the Configure menu (the Channel Table)

m Test ID

= Measurement Setups, from the Configure menu

m Preferences, from the Configure menu

= Edit Time Parameters (from the Measurement Sequence dialog box)

A good example of a typical UDP is a 24 Hour Test with a few extra measure-

ments specific to your application.

The following procedures describe how to define a UDP.

Define a Worksheet, Channel Table, and Test ID

1. Choose New from the File menu.

2. Inthe Description group, type “This worksheet is only for practicing writing

and retrieving data from UDPs.”

3. Select the std.cht from Channel Table in the list box.

4. Select <undefined> from the Site combo box. (There is no need to define the

Site — that information is not transferred to the 2714/2715.)
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10.

11.

Choose the OK command button to save the changes and return to the

spreadsheet.

From the File menu, choose Save As.

Enter the new worksheet name “remote.wrk”.

Choose the OK command button to save the worksheet and return to the

spreadsheet.

From the Configure menu, choose Test ID.

Type “Learner’s Remote” in the text box.

Choose the OK command button to save the change and return to the

spreadsheet. The Worksheet Header looks similar to Figure 2—75.

Worksheet: remote.wrk

Chan Table: std.cht

Site: <undefined>

Test ID: Learner's Remote
No View Filter is On |

Figure 2-75: Worksheet header after being edited for the UDP

Define the Measurement Setups and Preferences

1.

2.

From the Configure menu, choose Measurement Setups.

Set the 2714/2715 Power Line Frequency and Preamp option buttons to

match your system (at the remote location).

Enter the External Attenuation/Amplification in the text box to match the

remote location. (The TDC-10 and Zero Carrier Pulse groups do not matter

for UDPs since they are only significant for baseband.)

Select a channel from the list box, then choose the Edit Setups command

button.

Make the appropriate selections from the various groups.

Choose the OK command button to return to the Measurement Setups dialog

box. Repeat as necessary for all channels.

Choose the OK command button to save the changes and return to the

spreadsheet.

From the Configure menu, choose Preferences.

Select the Collect history option button.

10. Do not select any of the check boxes.

CSS500 Cable Television System Software User Manual 2-87



Advanced Measurements Tutorial

2-88

Run the UDP

11. Choose the OK command button to save the changes and return to the

spreadsheet.

Define the Measurement Sequence

1.

2.

From the Configure menu, choose Measurement Sequence.

Choose the Clear Sequence command button to remove any previous

Measurement Sequence.

Choose the FCC 24 Hour Test Auto Selection command button.

Choose the Create 2714/2715 UDP command button. The dialog box

appears as shown in Figure 2-76.

UDP Title:

[Remote]

Figure 2-76: The Create 2714/2715 UDP dialog box

=

Enter “Remote” in the text box.

Accept this UDP title (the same as the worksheet) by choosing the OK

command button. The UDP “Remote” is generated and loaded into the

2714/2715. This title appears in the 2714/2715’s USER DEF menu.

The Create 2714/2715 UDP dialog box goes away if the UDP was successful

in loading; if it fails an error message appears. The most common error is

having more than nine UDPs defined in a single instrument. At the

instrument, delete one or more UDPs and then try again.

Take the 2714/2715 to the remote location and connect it to the test point.

Define the 2714/2715 SITE parameter. “Beaverton — Remote 1” is the

example. The Site name is not defined in the UDP, therefore it must be done

on location in the 2714/2715.

Execute the UDP using the 2714/2715 front panel keys (see the 2714/2715

“USER DEF” menu). Allow the 2714/2715 to run until all measurements are

collected. (This will take 24 hours to complete — but it can be stopped after

one iteration.)
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Now that you have gathered the data, it needs to be loaded back into a CSS500

worksheet.

Get Stored Results from the 2714/2715

This menu item retrieves all the measurement results currently stored in the

NVRAM of the connected 2714/2715. The results are not erased from the

2714/2715 memory after they are retrieved. Results are only erased using

specific 2714/2715 front panel keystrokes. It is a good practice to always Import

into a new worksheet or one set up specifically for importing, so that no

information in the current worksheet is inadvertently overwritten.

1.

2

3.

4

From the File menu, choose Open.

Select the remote worksheet used to define the UDP.

Choose the OK command button.

From the Measure menu, choose Get Stored Results from the 2714/2715.

Figure 2-77 shows the dialog box.

Within the dialog box, the results are grouped according to Site and Channel

Table name. Ordering within the directory is alphabetical by site name.

Count is the actual number of measurement results contained in the group

specified by the Site and Chan Table columns. Results File is the name of

the results file to which a particular group of results has been exported.

Note that in Figure 2-77 there is no results file for the selected site. This is

because the data has not yet been exported to a results file. Before results can

be imported into CSS500 it must first be exported into a *.wsr file.
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Chan T able Count Hesults File

$itesss

WVU || (238

Figure 2-77: The Get Stored Results dialog box.

5. Choose the Export Results button to export some results (the example uses

Site 888) into a *.wsr file. Figure 2-78 shows the Export dialog box.

File Name: Directories:

| bringin. wWsr c:\css500

Heer, BSE i ck

& css500

€5 help

3 limits

c: tektronix

Figure 2-78: The Export dialog box

6. Enter a name for the destination file in the File Name combo box. The

example uses the name “bringin.wsr”.

7. Select the OK command button. You are returned to the Get Stored Results

dialog box as shown in Figure 2-79. Notice that the Site 888 now has the

bringin.wsr results file associated with it and the Export button is disabled.
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Chan Table Count Results File

S$itess8s 128 bringin.wsr

STL LTR ROR RRR A ROR RTL LL LL LAR RR RE OLLI LO LOLOL 238

Figure 2-79: The Get Stored Results dialog box after the selected site results have been exported to a results file

8. Choose the Import Results command button to load the information into the

current worksheet. Because no Site name is defined for this worksheet, the

Site name in the exported file does not match and a message box like the one

shown in Figure 2-80 appears.

CSS500 Warning W354

Import site: Site688

does not match worksheet site: <undefined>

Figure 2-80: A warning that the site name does not match the current site name in

the worksheet

9. Choose the Yes command button to continue importing the results. The

Warning shown in Figure 2—81 then appears.
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CSS500 Vrarning W355

Figure 2-81: Warning that the current site name does not match the imported site

name

10. Choose the Yes command button to change the worksheet site name to the

site from the 2714/2715. Choosing No will attribute the imported measure-

ment results to the Site name currently in the worksheet even if it is

undefined. If the Channel Table in the worksheet does not match the one

from the 2714/2715, the warning shown in Figure 2—82 appears.

CSS500 Warning W356

Import channel table: mystd

® does not match worksheet channel table: std

Figure 2-82: Warning that the 271X and worksheet Channel Tables do not match

11. Choose the Yes command button. The dialog box shown in Figure 2—83

appears. This dialog box is the result of a mismatch in the Channel Table.

There will always be mismatches in the Channel Table because the 2714 (or

2715) stores only the channel number as the channel ID, while CSS500

stores channel number, tag, program name, and nominal visual carrier.
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Import Results

A mismatched channel has been found

in the import Results File:

| t Results Fil
Worksheet Channel eo channel m

Number: 2 2
Letter: <blank> <blank>

Program: <blank> <blank>

Frequency: 55.25 <blank>

| Import Channel Criteria

Figure 2-83: The Import Results dialog box

12. Select “Use blank channel information as wildcards” in the Import Channel

Criteria sub-group.

Note that there are three Import Channel Criteria option buttons:

@ Exact channel information match only

mTM Use blank channel information as wildcards

= Verify mismatched channel information

Generally, when using Import to get results from a 2714 (or 2715) into a

worksheet, “Use blank channel information as wildcards” is the most

efficient option, since there will never be an exact match. Although you

could go through and verify each channel to make sure that the channel

numbers match, using the “Use blank channel information as wildcards”

selection is the most efficient way to load the data, because it reduces further

prompts.
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2-94

NOTE. Results for Channel Numbers not in the Worksheet’s Channel Table are

always ignored. You are notified that they were not loaded at the end of the

import process. Any cell without results data or in error condition will not be

imported. Cells that have more than one measurement will have all valid data

imported and the Error data results left blank. Results from a channel table that

his mismatches in the channel header, no destination channel, an inactive

destination cell, or a user requested skip will not be imported.

13.

Keep in mind that the destination channel must also be of the same type

(analog or digital) as that of the imported data. For example, suppose the

imported data has an Average Power result on channel 63; this means that

channel 63 is a digital channel. If channel 63 in the worksheet is an analog

channel, the Average Power destination cell is inactive; thus, the channel 63

Average Power result will not be imported.

Import complete. 16 results imported.

The following meast ts were not imported for the given reason:

Measurement Channel Reason

No errors or warnings detected

Figure 2-84: Message box that tells you that the import procedure is finished
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This section contains several chapters that describe the CSS500 software in

detail. Three chapters (Parts of the Worksheet, Control Menu Box, and Menu

Bar) provide in-depth descriptions of all the menu commands available in the

CSS500 software.
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Parts of the Worksheet

This chapter describes the various parts of the CSS500 worksheet. Each of the

parts of the worksheet are identified in Figure 3-1.

Control menu box Title bar Minimize

. —— Restore or

Menu bar | Ei w Measure Configure maximize button

= Button bar

Worksheet header View filter status box

Measurement

header

© 61.237924 ;

(<— Vertical scroll bar

77.258121

Spreadsheet

Channel header < Cell

Horizontal scroll bar

Figure 3-1: Parts of the CSS500 worksheet

Title Bar

The Title Bar displays the name of the application that created the window. The

active application’s Title Bar is highlighted. The Title Bar is also a handle for

moving the window. (Click on the Title Bar then hold down the left mouse

button to move the window to the desired position.)
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Parts of the Worksheet

Minimize Button

Maximize Button

Restore Button

The Minimize button quickly shrinks the application to an icon, same as the

Menu Control Box command, Minimize. (See page 3-10.)

The Maximize command makes the application window fill the entire display.

(The Restore button replaces it when the window is at its maximum size.) This is

the same as the Maximize command from the Menu Control Box. (See

page 3-10.)

The Restore button quickly returns the application window to it previous size.

This is the same as the Menu Control Box command Restore. (The Maximize

button replaces it whenever the window is not at its maximum size.) ( See

page 3-9.)

Worksheet Header

The worksheet name, Channel Table, Site, Test Id and View Filter status are all

listed in the Worksheet Header (see Figure 3-2).

Wokshest cal.enk a. The.

Cc
No View Filter is On

3-4

Worksheet

Chan Table

The worksheet name generally ends in “.wrk”. (It is good practice to make sure

that it ends in .wrk for file organization.) Change using the Save As command

(in the File menu; refer to page 3-13). This stays with the worksheet whenever it

is saved.

The Channel Table determines what channels are available. Edit using the

Create/Edit Channel Table command button in Worksheet Info, from the

Configure menu (see page 3-49) or Channel Table Editor from the Execute menu

(see page 3-84). If you change the Channel Table name, CSS500 asks if you

CSS500 Cable Television System Software User Manual C0OCOCCCCHCCCOCCCCeCeCeeee



ee2ee2e0020080800800
Parts of the Worksheet

Site

Test ID

View Filter Status Box

Channel Header

CSS500 Cable Television System Software User Manual

want to save the worksheet as a new one because only one Channel Table is

allowed for each worksheet. The Channel Table file should end in “.cht”.

NOTE. Use care when editing the Channel Table. See the warnings and

explanations in Appendix C: Channel Table Editor for more information.

Site specifies the location where the measurements take place, but there are no

defined values that this space must have. Change using the Configure menu,

Worksheet Info (see page 3-49). If you change the Site, you are asked if you

want to create a new worksheet because only one Site name can be associated

with any worksheet. If you choose not to create a new worksheet, all of the

measurement results are then associated with the new Site name.

This could be a person’s name, operator number, test session identification, or

whatever is the most appropriate for your particular application. CSS500 allows

multiple Test IDs for each worksheet. An example of why multiple Test IDs

would be appropriate for one worksheet is to separate the Pre-converter,

Post-converter, and 24 Hour results from the same Site.

This box tells if a View Filter is on. The choices are: No View Filter is On, View

Selected Filter is On, View Sequence Filter is On, and View Test ID Filter is On.

Enable the View Filters through the View menu, see page 3—26.

This is the list of channels defined by the Channel Table. Change using the

Create/Edit Channel Table command button (from the Configure menu,

Worksheet Info, see page 3-49). There are up to four fields in each Channel cell.

They are: Number, Tag, Visual Frequency, and Program.

= Number. The number by which this channel is commonly known.

m Tag. A 3-character designation for the channel, such as “AAA” or “2-B”.

= Program. A 6-character identifier for the channel, usually used for the

channel’s call letters or abbreviated name.

@ Visual Frequency. The frequency of the visual carrier.

You can edit which fields are displayed using the Row Header Fields from the

View menu (see page 3-44).

The Channel Table Editor defines these fields; see Appendix C.



Parts of the Worksheet

Measurement Header

The Measurement Header is the measurement list. The measurement list includes

(additional measurements made under this Header are in parentheses):

Visual Carrier Level

Visual Carrier Frequency

Aural Carrier Level

Aural Frequency Offset

Second Aural Carrier Level

Second Aural Offset Frequency

Average Power

Carrier to Noise

Desired to Undesired

CSO

CTB

Cross Modulation

Adjacent Channel Leakage

In-Channel Response

HUM/LFD

FCC Baseband or Primary Baseband (if non-US)

(Chrominance/Luminance Delay, Chrominance/Luminance Gain, Differen-

tial Gain, and Differential Phase)

Modulation Depth

Aural Deviation

Signal to Noise

(if NTSC: S/N NTC-7 Unweighted and S/N NTC-7 Lum Weighted

if PAL: S/N 567 Unweighted and S/N 567 Lum Weighted)

Waveform Distortion

(for NTSC: Line Time Distortion, Pulse-to-Bar Ratio, Short Time Distortion,

2T K-Factor, Luminance Nonlinear Distortion, Chrominance to Luminance

Intermodulation (IRE), Chrominance Phase (Deg), Chrominance Gain

20 IRE, Chrominance Gain 80 IRE.

For PAL: Line Time Distortion, Pulse to Bar Ratio, 2T K-Factor, Luminance

CSS500 Cable Television System Software User Manual
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Vertical Scroll Bar

Horizontal Scroll Bar

Non-Linear Distortion, Chrominance Amplitude Maximum, Chrominance

Amplitude Minimum, Chrominance Gain Maximum, Chrominance Gain

Minimum, Chrominance Intermodulation Packets #1 — #3.)

= Multiburst

(If NTSC: Multiburst ICR, Multiburst Flag (% Carr), Multiburst Flag

(%Bar/IRE), Multiburst Packet #1, Multiburst Packet #2, Multiburst Packet

#3, Multiburst Packet #4, Multiburst Packet #5, and Multiburst Packet #6

If PAL: Multiburst ICR, Multiburst Flag (% Bar), Multiburst Flag (% mV),

Multiburst Packet #1, Multiburst Packet #2, Multiburst Packet #3, Multi-

burst Packet #4, Multiburst Packet #5, and Multiburst Packet #6)

= ICPM

= Audio

(Left and Right Insertion Gain Error, Left and Right Sweep Maximum Gain,

Left and Right Sweep Minimum Gain, Left and Right Polarity, Left and

Right Stereo Channel Assignment, Left and Right SNR weighted, Left and

Right Maximum THDW, Left and Right Maximum THD+N 10dB, Left and

Right Maximum THD+N 15dB, Left and Right Maximum Crosstalk, Gain

Difference, and Phase Difference.)

NOTE. The Short Time Distortion measurement, under Waveform Distortion

Measurement Header, requires a IT pulse not normally found in the Composite

VITS signal. (It is available in the NTC-7 VITS signal.)

When it is available, note that the IT pulse distorts after a very short cable run.

Use this measurement primarily for in-house measurements.

The Vertical Scroll Bar moves the spreadsheet up and down, allowing access to

all channels. You can either click on the up or down arrow boxes to move one

step at a time, or click and hold the box, dragging it to the desired position.

The Horizontal Scroll Bar moves the spreadsheet right and left, allowing access

to all measurements. To use the Horizontal Scroll Bar, either click on the right or

left arrows to move one step at a time, or click and hold the box, dragging it to

the desired position.
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Cursor

The cursor can take on one of several shapes depending upon the functions

available to it.

It is a cross when it is in the spreadsheet. From there it can select cells, request a

measurement on a selected cell, or go to the Results Detail display.

It is an arrow if it is in the menu portion of the display. From there it moves

through the menu.

It can also be an hourglass. If the cursor is an hourglass, CSS500 is busy

processing a command. You cannot request any more actions until it turns back

into either an arrow or a cross.

It can be a two-or four-headed arrow for sizing the application window.

If no mouse is available, the cursor is either a box around a cell or command

button, reversed text on the command line, reversed cells in the spreadsheet, or a

two-or four-headed arrow for sizing the window.

CSS500 Cable Television System Software User Manual
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Restore

Move

CSS500 Cable Television System Software User Manual

The Control menu box contains standard Windows commands used to manipu-

late the application window and change to other applications (see Figure 3-3).

Close Alt+F4

Switch To... CtrltEsc

Figure 3-3: The Control menu box

The Restore command returns the CSS500 application window to its previous

size and position. It is often used to change an icon back into a window. It will

also toggle the window between two different sizes and positions. It performs the

same functions as the Restore command button (small box with both up and

down arrows) on the upper right hand corner of the worksheet. (See page 3-4.)

Move allows different placements of the CSS500 window. This is equivalent to

clicking on the Title Bar and holding down the left mouse button to reposition

the display. The Move command is only available if the application window is

not at its maximum size (when the Maximize button, in the upper right comer, is

available).

To use Move with the keyboard:

1. Choose Move. (Press ALT+spacebar, then type m.)

2. Press the arrow keys until the window is in the desired position.

3. Press Enter to place the window in the new position or press ESC to stop

moving the window.



Control Menu Box

Size

Minimize

Maximize

Close

Switch To

3-10

Size allows you to change the size of the application window. Size is not

available when the application window is maximized. (See the Windows

manual.)

To change the size of the window using the keyboard:

1. Press ALT+spacebar to enter the Control menu box.

2. Press s to choose Size. The cursor changes to a 4—headed arrow.

3. Press the arrow keys to change the size of the window. The cursor changes to

a 2—-headed arrow.

4. Press Enter to accept the new size or press ESC to cancel changing the size

of the window.

The Minimize command changes the application to an icon. The application is

still running but it is no longer the active window. CSS500 stays in the same

operating state as when it was converted to an icon. This performs the same

function as the Minimize button (small box with the down arrow) on the upper

right corner of the worksheet. (See page 3-4.)

The Maximize command changes an icon to an active window. This also changes

a sized window into one that fills the entire display. Maximize performs the same

function as the Maximize command button (small box with an up arrow) on the

upper right corner of the worksheet. (See page 3-4.)

Close halts any Measurement Sequence in progress, closes the CSS500

application window and exits the application.

The Switch To command changes from one running application to another. This

enables you to change from CSS500 to Excel (to process the data) and then back

to CSS500 (to get more data) without closing the CSS500 application.
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File

New

The Menu Bar lists the available menus. There are seven menus: File, Edit,

View, Measure, Configure, Execute, and Help. If you are using a mouse, click on

the word with the left mouse button to open the drop down menu associated with

each. If a mouse is not available, then press ALT+the underlined letter of the

selected menu item to make the drop-down menu available. For example: to get

the File menu, press ALT+f. The following sections describe each menu item.

The File menu is used to open, save, import, export and print files (see Fig-

ure 3-4).

oa
Open...

Save

Save As...

Export...

Print...

Print Setup...

Exit

Figure 3-4: The File menu

New creates a new worksheet. New automatically sets all Measurement Setups

and Limits files to defaults, not what is in the current worksheet. All results in

the current worksheet are either saved to that worksheet or deleted. New also

erases any Measurement Sequences that may have been defined.

There are three fields in the New dialog box; see Figure 3-5. The fields are: Site,

Description, and Channel Table.
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Menu Bar

Sel [Tektronix - Beaverton

Description:

| Channel T able

File Name: Directories:

| std.cht c:\css500

eur_il_cht fe> co:

hre.cht @ css500
irc. cht

japan-m.cht aa help
japan_m.cht (2 limits

std.cht Drives:
stdofst.cht

stndrd_cht c: tektronix

Figure 3-5: The New dialog box

m Site. Site specifies the location where the measurements take place. The Site

field has a default value of undefined; the Site field can remain undefined.

= Description. Fill this field with anything that may be relevant to this

worksheet. For example, how certain measurements are made and the serial

numbers of the test equipment. You can copy this information to the

Windows’ Clipboard and then attach it to an Excel spreadsheet. Carriage

returns are allowed in this field.

= Channel Table. This field specifies the Channel Table for the worksheet. The

Channel Table defines the channels available, their frequencies, and other

important information. You can change or edit the current Channel Table by

using the Create/Edit Channel Table command button. Editing the Channel

Table without changing the name is not recommended. Please see Appen-

dix C for more information about editing a Channel Table.
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There are two command buttons in the Channel Table field; the command

buttons are Create/Edit Channel Table and Save As Default.

@ Create/Edit Channel Table. This command button launches the Channel

Table Editor. Use the Channel Table Editor to add, delete, or change

information in a Channel Table. See Appendix C for more information on

the Channel Table Editor.

mTM Save As Default. This command button allows you to save the current

Channel Table as the default. This will cause the selected Channel Table to

automatically load every time the CSS500 software starts.

Open Opens an existing worksheet. (See Figure 3-6.)

File Name: Directories:

lz wrk) | c:\css500

9 limits

Drives:

c: tektronix

Figure 3-6: The Open dialog box

Save The Save command saves the changes made to the present worksheet.

Save As The Save As command saves the present worksheet under a new name. The

worksheet name has the same naming restrictions as any other MS-DOS file (no

more than 8 characters; some names such as LPT] and GPIB1 are not allowed;

etc.) See Figure 3-7 for an example of the dialog box. Notice that existing

worksheet names appear in gray.
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3-14

Import

Save As

File Name: Directories:

fF wrk] | c:\css500

examples wrk feS och
PoMOyE WE @ css500

tre] werk © help

3 limits

Drives:

Figure 3-7: The Save As dialog box

CAUTION. There are restrictions on the acceptable worksheet names. You cannot

use any name that is also used by IBCONF. (IBCONF is the configuration

program used by the GPIB card.) For example, if you have a GPIB device named

“2715,” you cannot have a worksheet called “2715.wrk”. This will cause an

error.

The Import command brings in data from another source (see Figure 3-8). An

acceptable source is results data previously exported from CSS500. Import can

be used to load data collected at remote locations such as the 271 X’s UDPs (User

Defined Program). If the Channel Table or Site does not match the present

worksheet, you are asked if you want to continue importing the results. If the

Channel Table does not match and you continue to import, the results will map

to the Channel Number, skipping any channel not in the worksheet’s Channel

Table. If the Site does not match, you have the option to choose if you want to

use the worksheet Site or the imported data’s Site.

It is good practice to import into a blank worksheet to minimize the possibility

of conflicts and unexpected data placement. If you don’t write to a blank

worksheet, Import will not overwrite your work. History is automatically turned

on before an Import takes place, and turned off again when Import is complete.

For example, you have data in one cell. Import data into that cell (with Keep

only Last Result set in the Preferences menu). Your data is still there and the

imported data falls into its place in the history stack (either before or after the

current results).

The data is stored in the worksheet according to Date/Time. If the data that you

are importing is older than the current data in the worksheet, then the imported
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Menu Bar

data is not visible in the worksheet. It is available in Results Detail with View

History turned on.

Any cell that has no results data or is in Error condition does not get imported.

Cells that have more than one measurement will have all valid data imported and

the Error data results left blank. Also, results from channels that are not in the

worksheet’s Channel Table are ignored.

The destination channel must also be of the same type (analog or digital) as that

of the imported data. For example, suppose the imported data has an Average

Power result on channel 63; this means that channel 63 is a digital channel. If

channel 63 in the worksheet is an analog channel, the Average Power destination

cell is inactive; thus, the channel 63 Average Power result will not be imported.

File Name: Directories:

fF .wst c:tcss500

2 limits

Drives:

Figure 3-8: The Import dialog box

CSS500 Cable Television System Software User Manual 3-15



Menu Bar

Export The Export command (see Figure 3-9) sends the results worksheet data out to a

“\wsr” file, so that other applications, such as Excel, can process the data.

File Name: Directories:

*_WSI c:\css500

baanaen west c:\

help

limits

Drives:

c: tektronix

Figure 3-9: The Export dialog box

The export file includes all Worksheet Header information.

If only certain cells need to be exported, use Copy (under Edit; see page 3-23)

and copy the data to the clipboard.

The main difference between using Copy from the Edit menu (Export Format

option) and using Export is that Export sends data to a named file while Copy

copies the data to the clipboard.
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The Print command sends the spreadsheet to the printer. (See Figure 3-10.)

Within the Print dialog box, the Setup command button is identical to choosing

Print Setup from the File menu.

Printer: Default Printer (PostScript (QMS) on
tolpd@by58s1@servers (LPT1:))

| Print Range

@ all

Print Quality: | Copies: [i]

_] Print to File CL] Collate Copies

Figure 3-10: The Print dialog box

The Print dialog box allows you to choose if you are going to print out the

worksheet as it appears in the display or with certain columns expanded to

display additional information.

If you do not use the Expand Columns option, CSS500 prints out the measure-

ment results cells just as they are shown in the worksheet. The main concern

with using this method is that some cells will only display PASS, CAUTION, or

ALARM. You may need more information.

Printing using Expand Columns fills in all cells with detailed measurements that

would otherwise print only pass/fail. The columns that expand are: FCC

Baseband, Signal to Noise, Waveform Distortion, Multiburst, and Audio. A

concern with using this format is that it produces long reports. (See Table 3-1.)

What is printed from each cell in the expanded mode is all of the results that you

would normally find in the Results Detail display. For example, the single Audio

column in the display format grows to 22 columns when it is printed out with

expanded columns. Since printing using Expand Columns creates such a long

printout, you should use the Measurements and Channels View Filter from the

View menu to limit the measurements printed in each worksheet. For example, to

print out all of the information from a worksheet in a more useful format, you

might print one expanded worksheet of the RF measurements, one for the

Baseband measurements, and one for the Audio.
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NOTE. To print some reports (ones with many columns), you may want to change

from portrait to landscape orientation. Use the Print Setup command to make

the required changes.

You can save paper if you only print out measurements and channels that have

results associated with them. Use the View Used command button from

Measurements and Channels dialog box in the View menu. (See page 3-40 for

more details.)

Table 3-1: The measurements under each measurement header

Measurement header Measurements under the measurement header

Visual Carrier Lev (dBmV) Visual Carrier Level (dBmV)

Visual Carrier Freq (MHz) Visual Carrier Frequency (MHz)

Aural Carrier Lev (dBc) Aural Carrier Level (dBc)

Aural Frequency Offset, (MHz) Aural Frequency Offset (MHz)

2nd Aural Carrier Lev (dBc) 2nd Aural Carrier Level (dBc)

2nd Aural Frequency Offset (MHz) | 2nd Aural Frequency Offset (MHz)

Average Power (dBmV) Average Power (dBmV)

Carrier to Noise (dB) Carrier to Noise (dB)

Desired to Undesired Desired to Undesired (dB)

CSO CSO Loc 1 (dBc)

CSO Offset 1 (MHz)

CSO Loc 2 (dBc)

CSO Offset 2 (MHz)

CSO Loc 3 (dBc)

CSO Offset 3 (MHz)

CSO Loc 4 (dBc)

CSO Offset 4 (MHz)

CSO Loc 5 (dBc)

CSO Offset 5 (MHz)
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Table 3-1: The measurements under each measurement header (Cont.)

Measurement header Measurements under the measurement header

CTB CTB Loc 1 (dBc)

CTB Offset 1 (MHz)

CTB Loc 2 (dBc)

CTB Offset 2 (MHz)

CTB Loc 3 (dBc)

CTB Offset 3 (MHz)

CTB Loc 4 (dBc)

CTB Offset 4 (MHz)

CTB Loc 5 (dBc)

CTB Offset 5 (MHz)

Cross Modulation Cross Modulation (dBc)

Adjacent Channel Lkg. (dBc) Adjacent Channel Leakage (dBc)

In-Channel Response In-Channel Response (dB)

HUM/LFD Hum/LFD (%)

Hum/LFD Fundamental (%)

Hum/LFD Second Harmonic (%)

FCC Baseband Chroma-Luma Delay (ns)

NTSConly) Chroma-Luma Gain (%)
Differential Gain (%)

Differential Phase (Deg)

Primary Baseband Chroma-Luma Delay (ns)

Pal) Chroma-Luma Gain (%)
Differential Gain (%)

Differential Phase (Deg)

Modulation Depth (%) Modulation Depth (%)

Aural Deviation (kHz) Aural Deviation (kHz)

Signal to Noise S/N NTC7 Unweighted (dB)

INTE) S/N NTC7 Weighted (dB)
Signal to Noise S/N 567 Unweighted (dB)

APR) S/N 567 Lum Weighted (dB)
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Table 3-1: The measurements under each measurement header (Cont.)

Measurement header Measurements under the measurement header

Waveform Distortion

(NTSC)

Line Time Distortion (%)

Pulse to Bar Ratio (%)

Short Time Distortion (%SD)

2T K-Factor (%Kf)

Lum Non-linear Distort (%)

Chrom. to Lum. Intermod (IRE)

Chrominance Phase (Deg)

Chrominance Gain (20 IRE)

Chrominance Gain (80 IRE)

Waveform Distortion

(PAL)

Line Time Distortion (%)

Pulse to Bar Ratio (%)

2T K-Factor (%Kf)

Lum Non-linear Distort (%)

Chroma Amp Max (%)

Chroma Amp Min (%)

Chroma Gain Max (Deg)

Chroma Gain Min (Deg)

Chroma Intermod Pkt #1 (%)

Chroma Intermod Pkt #2 (%)

Chroma Intermod Pkt #3 (%)

Multiburst Multiburst ICR (dB)

Multiburst Flag (% Carr)

Multiburst Flag (%Bar/IRE)

Multiburst Packet #1 (%Flag)

Multiburst Packet #2 (%Flag)

Multiburst Packet #3 (%Flag)

Multiburst Packet #4 (%Flag)

Multiburst Packet #5 (%Flag)

Multiburst Packet #6 (%Flag)
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Table 3-1: The measurements under each measurement header (Cont.)

Measurement header Measurements under the measurement header

ICPM ICPM (Deg)

Audio Left Insertion Gain Error (dB)

Right Insertion Gain Error (dB)

Left Sweep Max Gain (dB)

Right Sweep Max Gain (dB)

Left Sweep Min Gain (dB)

Right Sweep Min Gain (dB)

Left Polarity

Right Polarity

Left Stereo Channel Assignment

Right Stereo Channel Assignment

Left SNR weighted (dB)

Right SNR weighted (dB)

Left Max THD+N (%)

Right Max THD+N (%)

Left Max THD+N 10dB (%)

Right Max THD+N 10dB (%)

Left Max THD+N 15dB (%)

Right Max THD+N 15dB (%)

Left Max Crosstalk (dB)

Right Max Crosstalk (dB)

Gain Difference (dB)

Phase Difference (dB)

CSS500 Cable Television System Software User Manual 3-21



Menu Bar

Print Setup _—_Sets up the printer so that it can properly print worksheets and reports. (See

Figure 3-11.) This is identical to the standard Windows’ printer setup. Please see

the Windows User’s Guide or on-line Help for more information.

Print Setup

[ Printer

@ Default Printer

©) Specific Printer:

(currently PostScript (QMS) on tolpd@by58s1 @servers (LPT1:))

[PostScript (QMS) on tolpd@byv58s1@servers (LPT1:)

[ Orientation

© Portrait

Paper

Size: _|Letter 81/2 x 11 in

Figure 3-11: The Print Setup dialog box

NOTE. Most worksheets and reports are more readable if printed using Land-

scape orientation.

Exit Exit closes the CSS500 application.
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Edit

The Edit menu is used to manipulate the contents of selected cells (see Fig-

ure 3-12).

Eat i
Copy... Ctrl+C

Clear... Del

Select All

Figure 3-12: The Edit menu

Copy The Copy command (see Figure 3-13) copies the contents of the selected cells to

the Windows Clipboard. CSS500 asks if you want the cells in Export format or

As Displayed. If you select Export format, you also have a choice of whether to

include the measurement history. In Export format, not only is the displayed cell

data copied to the clipboard, but also the Results Detail information. If you chose

the As Displayed format, only the data in the selected cells along with the

Measurement and Channels Headers are copied to the clipboard. The result of

copying one cell with history (using export format) into Word for Windows is

given in Table 3-2.

No ¥iew Filter is On

o) As Displayed

® Export Format

Figure 3-13: The Copy dialog box
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Table 3-2: The results of copying one cell with history into Word for Windows

Worksheet | Site

File

Tektronix

Beaverton

Channel | Video Aural

Table Standard | Offset

2715.cht | NTSC 5

Channel | Freq Program | S/N Viol LL UL S/N Viol LL UL Notes | Date/ Test ID

Unweighted Weighted Time

(dB) (dB)

2 25 A} “ 8 TM 6/7/1995 | Training

13:44:35 | Wheels

2 25 a io 6/7/1995 | Training

13:44:22 | Wheels

2 25 7 3 6/7/1995 | Training

13:44:18 | Wheels

2 25 4 7 6/7/1995 | Training

13:42:53 | Wheels

Below is a description of how Table 3—2 was created:

1. Select one cell from the worksheet.

2. Choose copy from the Edit menu.

3. Select Export format and include measurement history.

4. Choose OK.

5. Open the desired Word for Windows document.

6. Place the cursor in the desired location in the Word document.

7. From the Edit menu, choose Paste. All the cell information is placed in the

document.

8. Select all of the data that was just pasted into the document.

9. From the Table menu, choose Convert Text to Table.

10. Select “Tabs” as the column spacer.

11. Choose OK.

12. Adjust the column width as necessary.
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Clear

Select All

NOTE. Both Word and Excel have a limited number of columns. Word’s limit is 31

columns. Excel's limit is 256 columns. Each cell will produce a large number of

columns; see the example in Table 3-2 above. Take this into consideration when

copying data into these applications.

The As Displayed format only copies the displayed cell contents and Channel

and Measurement Headers associated with the selected cells to the clipboard.

The results of copying one cell using the As Displayed format are shown in

Table 3-3.

Table 3-3: The results of copying one cell using the As

Displayed format

Carrier to Noise (dB)

2.55.25 41**

The Clear command (see Figure 3—14) deletes the current value and/or all history

for the selected cells. There is always a warning to verify that you really want to

delete the contents of the cells. Select CANCEL if you do not want results

deleted.

NOTE: The following results for all selected

cells will be deleted when you select OK.

Select Cancel if you do not want results deleted.

CL] Measurement History

Figure 3-14: The Clear dialog box

The Select All command selects all of the cells in the spreadsheet. If you are

using a mouse, you can obtain the same results by clicking the left mouse button

on the upper left corner of the spreadsheet.
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View

The View menu (see Figure 3-15) allows you to see the spreadsheet data

presented in several different ways, such as filtered or consolidated into reports.

Status Report...

Results Detail...

Global View...

2714/2715 Screen

Picture

Measurements and Channels...

Measurement Sequence Results

Test ID Results

Row Header Fields...

Figure 3-15: The View menu

Status Report Choosing Status Report from the View menu (see Figure 3-16) is the same as

choosing the Status command button on the Button Bar (see page 3-86). A

shortcut for getting to this display is to click the right mouse button on the upper

left corner of the spreadsheet. Any of these methods displays the Status Report

for the current worksheet.
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= Status Report

Channel Table: std.cht

Site: Tektronix-Beaverton

No View Filter is On

Visual Carrier Level [dB mv)

_|Visual Carrier Level Diff. (dB)

Visual Carrier Level Adj. [dB] Max

Visual Carer Frequency [MHz]

Aural Carier Level [dBc} Max

Figure 3-16: The Status Report

Chroma-Lum Gain (%] Max

Hin

Hax-Min |

Max Dev |

Hin

Aural Frequency Offset (MHz) Max Dev

Carrier to Noise [dB] Kin

4CS0 (dBe} hax

iCTB (dBe] Max -53.3

_j| Cross Modulation [dBc] Max

_|In-Channel Response (dB) Max

_jHum/LFD (2) _ Max

Chroma-Lum Delay {nS} Max

hin

61.225

7

4.495

43

Upper
Limit

10

3

51

-54

The Status Report lists the extremes for all of the measurement results. It is

basically a summary of all Measurement Summaries (see page 3-36). Table 3-4

lists the measurement results given in the Status Report. If there are no results

for a measurement, it is skipped in the Status Report. You can limit the channel

and measurements in the Status Report by using the View Filters (see Measure-

ments and Channels on page 3-40). Optionally, you can include the measure-

ment History.

Table 3-4: The Measurement summaries in the status report

Max- Max Max

Measurement Max Min Min Dev Abs

Visual Carrier Level (dBmV or dBuV)! X X

Visual Carrier Level Diff (dB)? X

1 Absolute power level.

2 Difference between the maximum and minimum values over all the channels
measured.
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Table 3-4: The Measurement summaries in the status report (Cont.)

Max- | Max Max

Measurement Max Min Min Dev Abs

Variation (dB)$ x

Visual Carrier Level Adj. (dB)4 x

Visual Carrier Frequency (MHz)5 Xx

Aural Carrier Level (dBc) Xx Xx

Aural Frequency Offset (MHz)® Xx

2nd Aural Carrier Level (dBc) X X

2nd Aural Frequency Offset (MHz) X

Average Power (dBmV or dBuV)! x x

Carrier to Noise (dB) Xx

Desired to Undesired (dB) x

CSO (dBc) X

CTB (dBc) Xx

Cross Modulation (dBc) X

Adjacent Channel Leakage X

In-Channel Response (dB) X

Hum/LFD (%)? X

Chroma-Luma Delay (nS) X x

Chroma-Luma Gain (%) x Xx

Differential Gain (%) Xx X

Differential Phase (Deg) Xx Xx

Modulation Depth (%) X X

Aural Deviation (kHz) X Xx

3 If four or more Visual Carrier Levels measurements are being summarized for a

single channel. Difference between the maximum and minimum values for the

several measurements done over time on a given channel. (Variation appears only if

Collect History is selected in the Preferences dialog box.)

4 Maximum difference between and two adjacent channels. See Summary Limits

Group (page 2-84 ) to set these summary limits, a definition of Adjacent, and for

types of channels to include.

5 Maximum deviation from nominal as defined in the Channel Table. The value shown

is the measured frequency, the violated limits are shown as nominal + limit offset as

defined in the Limits file. Variations always include both current and all previous

data, whether history is selected or not.

Maximum deviation from nominal as defined in the Channel Table.

7 Total Hum.
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Table 3-4: The Measurement summaries in the status report (Cont.)

Measurement Max Min

Max-

Min

Max

Dev

Max

Abs

S/N NTC7 Unweighted (dB)®

S/N NTC7 Weighted (dB)8

S/N 567 Unweighted (dB)2

S/N 567 Lum Weighted (dB)?

Line Time Distortion (%)

Pulse to Bar Ratio (%)

Short Time Distortion (%SD)8: 10

2T K-Factor (%Kf)

Lum Non-linear Distortion (%)

Chroma to Luma Intermod (IRE)®

Chrominance Phase (Deg)®

Chrominance Gain (20 IRE)®

Chrominance Gain (80 IRE)®

Multiburst ICR (dB)

ICPM (Deg)

Left Insertion Gain Error (dB)

Right Insertion Gain Error (dB)

Left Sweep Max Gain (dB)

Right Sweep Max Gain (dB)

Left Sweep Min Gain (dB)

Right Sweep Min Gain (dB)

Left Polarity

Right Polarity

Left Stereo Channel Assignment

Right Stereo Channel Assignment

Left SNR Weighted (dB)

Right SNR Weighted (dB)

Left Max THD+N (%)

Right Max THD+N (%)

8 NTSC systems only.

9 PAL systems only.

10° EEE 511
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3-30

Table 3-4: The Measurement summaries in the status report (Cont.)

Max- Max Max

Measurement Max Min Min Dev Abs

Left Max THD+N 10 dB (%) X

Right Max THD+N 10 dB (%) x

Left Max THD+N 15 dB (%) x

Right Max THD+N 15 dB (%) X

Left Max Crosstalk (dB) Xx

Right Max Crosstalk (dB) X

Gain Difference (dB) X

Phase Difference (dB) X

The Result column (see Figure 3—16 on page 3-27) is color coded in the same

manner as the worksheet: green is passing; yellow is Caution; red is Alarm; and

white is no limits defined or no measurements made. Blue is an error.

Blue indicates that an error occurred in the measurement, which makes the

results invalid. The cell will be blue only if all of the results in the cell are

invalid. If any of the results are valid, the cell takes on the color for the worst

case valid measurement. If a measurement is invalid, <undefined> is loaded in

the Results Displays.

The * and ** column replaces the color information on a monochrome display.

The * symbol means that the measurement was in the caution range, while **

means that the measurement was in the alarm range.

Violated Lower Limit is filled in with the lower limit if it was exceeded or

Violated Upper Limit is filled in with the upper limit if the Upper limit was

exceeded.

The 24 Hour Carrier Level Variation is in the Status Report only if there are at

least 4 measurements in the last 24 hours on a single channel, whether or not

history is selected. This is the channel with the worst 24 hour Carrier Level

variation.

There are two command buttons: View Violations and View Results Detail. The

View Violations display is explained next. (Results Detail is explained on

page 3-32.)

View Violations. Display the View Violations dialog box by choosing the View

Violations command button on the Status Report. This dialog box shows all the

measurements and channels that are in error. (They have either a single or double

asterisk, * or **.) Only the individual measurements are in this display (see
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Figure 3-17). Passing measurements are not shown here, as they are not in

violation.

This display is sorted by Alarm/Caution, then channel number, and finally by

measurement.

This display can also go to the Results Detail display for a selected cell by using

the View Results Detail command button or clicking the right mouse button on

the desired cell. (Results Detail is explained on page 3-32.)

Return to the Status Report dialog box by choosing the Close command button.

View Violations

Channel Table: std.cht

Site: Tektronix-Beaverton

No View Filter is On

(CSO (Be)
{Differential Phase (Deg)

iS/N NIC? Unweighted [dB

{S/N NTC? Lum Weighted (dB)

Line Time Distortion [%]

iPulse To Bar Ratio [2]

{Short Time Distortion (25D)

Figure 3-17: View Violations dialog box
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Results Detail for FCC Baseband

Channel: 2 55.25 MHz

Channel Table: std.cht

Site: Tektronix-Beaverton

No View Filter is On

Worksheet Navigation

Measurement Summary

Figure 3-18: Results Detail dialog box

You can get to the Results Detail dialog box many ways:

Click the right mouse button on a cell in the spreadsheet.

Press the Results command button on the Button Bar.

Choose Results Detail from the View menu.

Choose the View Results Detail command button in the Status Report.

Click the right mouse button on a cell in the Status Report.

Choose the View Results Detail command button in View Violations.

Click the right mouse button on a cell in View Violations.

Choose the View Results Detail in the Global View.

Click the right mouse button on a cell in Global View.

Worksheet Navigation. Use the four arrows to move around in the spreadsheet

while staying in Results Detail. The type of View Filter determines where the
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channel and measurement the navigation arrows take you. You cannot move to a

channel or measurement that is not displayed.

Up arrow. Moves up a channel while staying in the same measurement.

Down arrow. Moves down a channel while staying in the same measurement.

Left arrow. Stays in the same channel but moves one measurement to the

left.

Right arrow. Stays in the same channel but moves one measurement to the

right.

Select History. Use these command buttons to display measurement history:

Prev. This command button selects the previous measurement results

(history).

Next. This command button selects the next most recent measurement

(history).

Measurement Summary. The summary lists the results for each measurement:

Measurement. Lists the measurements contained under the Measurement

Header in the spreadsheet. For example, FCC Baseband has Chrominance to

Luminance Delay, Chrominance to Luminance Gain, Differential Gain, and

Differential Phase.

Result. Lists the numerical results of a measurement.

* ** Flags whether a given measurement was in violation of either the

Caution limits (*) or the Alarm limits (**).

Violated Lower Limit. If the results violated the lower limit defined by the

Limits file, then the limit is printed in this column.

Violated Upper Limit. If the results violate the upper limit defined by the

Limits file, then the limit is printed in this column.

Date/Time. Date and time of the measurement. This comes from the internal

clock of the instrument making the measurement, unless the measurement is

invalid (an error), then the time comes from the PC. (Use the horizontal

scroll bar to view this column.)

Test ID. The Test ID when the measurement was made. (Use the horizontal

scroll bar to view this column.)

Notes. Notes from the test equipment about how a measurement was made.

Only one note is available for each cell, so it is replicated for each measure-

ment within a cell. Table 3—5 lists the notes that the instruments (either the
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271X or the VM700A) place in the Notes field for each of the different

measurements.

If the measurement cannot be made, the instrument name, a colon and an

event number (error number) appears in the Notes field (that is,

271X E:###). Use the event number to cross reference to the instrument

documentation (the 27/4 and 2715 Spectrum Analyzer Programmer Manual)

to find out what failed during the measurement.

Table 3-5: Explanation of the Notes Field notes

Measurement Notes field! Meaning

Visual Carrier Level sddd.d dB ext ofst? External attenuation or amplification in
dB

Visual Carrier Frequency | —

Aural Carrier Level —

Aural Frequency Offset

Average Power sddd.d dB ext ofst2 External attenuation or amplification in
dB

Carrier to Noise sddd.dZ ddd.dZ +3 Noise Bandwidth and Noise Frequen-
cy (in Hz) and 2 dB flag*
G if gated

Desired to Undesired ddd.dZ +3 Noise Bandwidth (in Hz) and 2 dB flag

CSO #Loc « #Loc +* Stored only

Example: 1A* 3R* 4R+?

#Loc #Loc #Loc +% Interactive only

Beat number, location type, and 2 dB

flag’

CTB Same as CSO Beat number, location type, and 2 dB

flag

Cross Modulation _

Adjacent Channel +3 2 dB flag

Leakage

In-Channel Response® sddd.dZ/sddd.dZHz RF(or | Min/Max Frequency Offset and signal
BB) G###6 type (RF or Baseband)

G### is the line number of the test

line

Hum/LFD 60 Hz (or 50 Hz) Power Line Frequency

FCC Baseband _ Any note is from the VM700A

Modulation Depth RF (or BB) Signal Type

Aural Deviation -

Signal to Noise _ Any note is from the VM700A
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Table 3-5: Explanation of the Notes Field notes (Cont.)

Measurement Notes field! Meaning

Waveform Distortion _ Any note is from the VM700A

Multiburst Multiburst NTC-7 Combo —_| The VM700A either used the NTC-7

or FCC Multiburst Combination signal or the FCC

Multiburst signal to make this mea-

surement

ICPM _ Any note is from the VM700A

Audio — Audio Limits file selected in the

VM700A unless there is a note from

the VM700A

1s =sign (+ or -)

d = decimal number

Z or ZHz = frequency (Hz) in engineering notation (kHz or MHz)

#=1-5

Loc = A(bsolute) or R(elative)

RF or BB = signal Type RF or Baseband

2 This note is not available for stored measurements retrieved from the 271X.

3 If an asterisk is present, the measured value is within 2 dB of the analyzer noise
floor. The actual value may be better than the one indicated.

4 The results of the Carrier to Noise and CSO measurements may be 1000 larger than

measurement. This indicates that the Quiet Lines measured were no longer quiet at

the end of the test. The true answer may be better than the one indicated.

The results of the Carrier to NOise and CSO measurements may also be 2600 larger

than measured. This indicates that the mixer level was raised above the optimum to

allow the video modulator board to work. The true answer may be better than the one

indicated.

Note also that the 1000 and 2000 flag are additive, so the result could be 3000 above

what was measured indicating that both conditions occurred.

5 The RF or BB signal type indicator may not appear if both offset frequencies are
negative. The In-Channel Response Frequency range is not available for stored

measurement retrieved from the 2714.

6 — G### is only inserted from the 2715.

Exceptions. The Results Detail display generally only gives the results for a

single cell; the exception to this is for the first six cells: the Visual and Aural

Carrier Levels and Frequencies. These measurements are grouped together into

one Results Detail display. Also if there are four or more of the measurements

made in the last 24 hours, then a summary of the Carrier Levels measurements

over the past 24 hours is provided. The summary includes the total visual carrier

level variation and each individual measurement value with a Time/Date stamp.

(See Figure 3-19.)
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Figure 3-19: The 24 hour Carrier Summary display

Measurement and

Channel Summaries

3-36

Select an entire spreadsheet row or column, choose the Results command button

(or click on the Measurement or Channel Header with the right mouse button),

then you can access special displays called Channel Summary (row selected) or

Measurement Summary (column selected). (A right mouse click on the Channel

or Measurement Header name also accesses these reports.) These displays are a

cross between Status Reports and Results Detail displays. The View Filter affects

these displays. Information in hidden rows or columns is not contained in the

Measurement or Channel Summaries. The results contained in the measurement

history can also be incorporated into these summaries.

The Channel Summary (see Figure 3-20) displays violations for the selected

channel. You can move to a different channel by using the Select Channel

navigation arrows. You can also select a cell and view the Results Detail for the

measurement for that channel.
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Channel Summary for Channel 3

Channel Table: std.cht _ View : ul Detail || | Close 4
Site: Tektronix-Beaverton = [include History a

View Sequence Filter is On -

All Violations

Visual Carrier Level Variation (24 Hour}

Figure 3-20: Example of a Channel Summary

The example in Figure 3—20 gives the Visual Carrier Level Variation. This

information is always present in a Channel Summary if there are four Visual

Carrier Level measurements in a 24 hour period, regardless of whether or not

Include History is selected.
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The Measurement Summary (see Figure 3—21) gives the Status Report informa-

tion for just the selected measurement. You can move to other measurements

using the Navigation arrows. The View Violations command button will go to

the View Violations display for only the selected measurement. The View

Results Detail command button goes to the Results Detail display for the

selected channel measurement. If the Include History check box is checked, then

the worst case of the measurement in this worksheet is displayed. Otherwise, the

worst-case current measurement results are displayed.

———=i=sC=CsCOMeasurement Summary for Carrier Levels and Frequencies _

Channel Table: std.cht aasigaean _View Results Detail | |_C
one: Petrone heaverton | View Violations

View Sequence Filter is in i

i (-] include History

x | Violated ; Violated

Channel Measurement Type Result = Lower Upper

Lismit Limit

4 Visual Carrier Level [dB m¥] Max 43.2

3 Hin 7.3

43 Visual Carrier Level Diff. {dB} Max-Min 10

5 Variation {dB} Max 8

3.4 Visual Carrier Level Adj. [dB] Max 3

3 Visual Carrier Frequency (MHz} Max Dev 61.275

2 Aural Carter Level {dBc} hax

5 Min “TF

2 Aural Frequency Offset [MHz] Max Dev 4.505

None @nd Aural Level {dBc} Max

Hone Hin

2nd Aural Frequency Ofiset [MHz] Max Dev
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Global View This is a condensed view of the standard spreadsheet display (see Figure 3-22).

All of the measurements and channels are in the same order as the spreadsheet.

This view allows for a quick overview of how the system is doing as a whole.

White blocks indicate that there are no defined limits, or no measurement results.

Green blocks mean the measurement is passing. Yellow blocks indicate that the

measurement is in the Caution range. Red blocks indicate that the measurement

has violated the Alarm limits. Blue means that an error occurred in making the

measurement and the results are invalid. Gray means that the measurements are

not permitted because that channel was not included in the Channel Table

transfer to the instrument (RF measurements are not permitted if a channel is not

included in the transfer) or the measurement cannot be performed on that channel

(analog—only measurement cannot be taken on digital channels and digital—only

measurements cannot be taken on analog chanels). Please see Appendix C,

Channel Table Editor, for more details on this Channel Table field.

No View Filter is On

Figure 3-22: Global View dialog box

Access the Result Detail display along with the Channel and Measurement

Summaries (see page 3-32) from the Global View by selecting a cell, a row, or a
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column and clicking the right mouse button. You could also use the View Results

Detail command button.

Access the Status Report from the Global View by clicking the right mouse

button at the intersection of the Measurement and Channel header.

2714/2715 Screen = The 2714/2715 Screen command displays a copy of what is presently on the

Picture

Measurements and

Channels

271X screen. This includes displayed traces and readouts.

NOTE. Place the analyzer in Single Sweep mode and be sure the current sweep is

complete before requesting a 2714/2715 Screen. If the analyzer is not in Single

Sweep mode and the current sweep is not complete, there may be inconsistencies

between the marker readout text, the marker positions, and the waveforms,

because the analyzer updates these values asynchronously with respect to the

query for the values.

The Picture command displays a video picture of what is presently on a given

channel (shows a complete active picture). To use the Picture command, you

must have a video board and software driver installed in your PC. (The CSS500

package does not include the video board and driver). This default driver is the

Video Blaster. The video board and driver must be active when the Picture

command is called. The displayed picture is the video source connected to the

video board.

The CSS500.INI file must be edited if any driver other than the Video Blaster is

used. The line “Video Driver=XXXXXX” in the CSS500.INI file must have the

XXXXXX changed to match the title that appears in your video driver’s Title

Bar.

Any other details about the operation of Picture are controlled by your video

driver.

Use ALT+TAB to jump between the video driver application and CSS500.

This is a View Filter that determines which channels and measurements are on

the spreadsheet (see Figure 3-23). There are All and Select options for both

measurements and channels. You can select whatever measurements and

channels are important to view at the moment without “losing” any measure-

ments. This allows you to configure the spreadsheet to show only what you need

to see at the moment and eliminate all extraneous information without deleting

anything. All View Filters are mutually exclusive.

CSS500 Cable Television System Software User Manual

ee eo eoedeede?ese@ @
@9eeoeoees?d se



eee dgodeedeedeee@e@e@ee@eeese @
@ @

Menu Bar

Measurements and Channels

> All Measurements

‘@ Selected Measurements

Selected Measurements Available Measurements

Visual Carrier Level ea | sgeey 4 |¥Visual Carrier Level

Visual Carrier Freq ss is 3 |¥Visual Carrier Freq

Aural Carrier Level Aural Carrier Level

Aural Carrier Freq Aural Carrier Freq

2nd Aural Carrier Level

2nd Aural Carrier Freq

Average Power

Carrier to Noise

Desired to Undesired

cso

CIB

View Used |
[ View Channels

© All Channels

@ Selected Channels

Selected Channels Available Channels
> —

3

Figure 3-23: The Measurements and Channels dialog box

The View Filter status box displays the following message when this filter is on:

View Selected Filter is On. The spreadsheet looks like Figure 3-24 when the

Measurement and Channel View Filter is selected as shown in Figure 3-23.
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View Measure Configure Execute Help

Tektronix — CSS500

Tektronix-Beaverton

Test ID: Leamer's Remote

Figure 3-24: Worksheet with Measurements and Channel View Filter on

3-42

To turn this View Filter off, select the Measurements and Channels command

from the View menu.

NOTE. You cannot select a measurement or channel unless it is viewable.

Therefore, if only some channels and measurements are in view and the Select

All command (from the Edit menu) is used, the “hidden” measurement cells are

not selected. The exception to this rule is the Carrier Level and Frequency

measurement. If you select one of the six measurements, all these measurements

are made, whether they are visible or not.

If you select all channels, by clicking on one of the Carrier Level and Frequency

Measurement headers and the Average Power header, you are still given the

option to do a Carrier Survey, even if all channels are not viewable.

When you return to All for the Measurements and Channels options, the list of

selected measurements and channels remains. You can toggle between the

filtered and full display quickly.

If the View Filter is on and you are trying to Import results that would enter a

hidden row or column, you are warned that all of your imported results are not

immediately viewable.

You can switch to any other View Filter by choosing it from the View menu.

There is a special command button, View Used, for this dialog box. This

command allows you to automatically filter off all channels and measurements

that have no results. View Used is particularly useful for printing out worksheets.

CSS500 Cable Television System Software User Manual

eee eoedoedededees?d 8 ®@
eeeoeoe0ece



ee eo eoede@ed9e9@sde @
9e@eoeoeed?e 8 @

Menu Bar

Measurement Sequence

Results

Use this command button immediately before printing reports to minimize the

amount of blank space.

NOTE. The View Filters also affect the Status Report, Measurement Summaries,

Channel Summaries, and the Results Detail display.

When this filter is active, only those measurements made with the most recent

Measurement Sequence execution are on the spreadsheet. The measurements

displayed are not necessarily the current Measurement Sequence. (See page 3-56

for how to define a Measurement Sequence.) For example, if you have defined

and executed a Measurement Sequence that only measures the Signal to Noise

Ratio for four select channels, then only those four channels’ S/N measurements

are displayed on the spreadsheet when this View Filter is on. The rest of the

measurements are only hidden. They are still part of the worksheet and are

available as soon as the Measurement Sequence Results filter is switched off.

If no measurements on the worksheet are associated with a Measurement

Sequence, then you will get a warning message (see Figure 3—25) telling you that

there are no measurement results associated with a Measurement Sequence and

therefore the View Filter will not be applied.

There are no measurements for the selected view.

Figure 3-25: Warning message

The View Filter status box has the message View Sequence Filter is On, and

there is a check mark in front of Measurement Sequence Results in the View

menu. To turn the View Filter off, just choose Measurement Sequence Results

from the View menu again, or choose any other View Filter.

The following is a list of commands that are disabled when the Measurement

Sequence View Filter is on:

= Import, from the File menu

= Current Selection from the Measure menu and Meas Sel from the Button Bar
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Test ID Results

Row Header Fields

@ Double click on a cell to make a measurement

TM Get Stored Results from the 2714/2715, from the Measure menu

These commands are disabled because the results are not immediately viewable.

You can switch to any other View Filter by choosing it from the View menu.

This View Filter only displays cells that have measurements tagged with the

currently displayed Test ID. Therefore, if only a few of the measurements on the

current worksheet were made under the current Test ID, then only those few

measurements are displayed. If no measurements on the worksheet were made

under the current Test ID, then CSS500 displays a warning message that there

are no measurements with that Test ID and will not apply the Test ID filter. (This

is the same warning message as Measurement Sequence Results.) Select the

Test ID using the Configure menu. (See page 3-52.)

If the Test ID View Filter is on, then the View Filter Status Box contains the

message View Test ID View Filter is On. There is also a check mark in front of

Test ID Results in the View menu. To turn the Test ID View Filter off, choose

Test ID Results from the View Menu again or choose another View Filter.

If the Test ID Results View Filter is on and you are trying to import results that

would enter a hidden row or column, you are warned that all of your imported

results are not immediately viewable.

You can change which Test ID you are viewing. In the Test ID dialog box, select

one of the Used in Worksheet Test IDs and the View Filter will automatically

switch to that Test ID. You can only select from the Used in Worksheet Test IDs.

The Row Header Fields command allows you to select what information is given

in the Channel Header (see Figure 3-26). You can display the Channel Number

& Tag, the Program Name, and/or the Channel Frequency. You must select at

least one. Initially all three options are always chosen. When all three are

selected, the Header column width is slightly larger than if one or two of the

options is selected.

Row Header Fields

-J Channel Number and Tag:

EX] Channel Frequency

Figure 3-26: The Row Header Fields dialog box
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Menu Bar

Measure

Current Selection

NOTE. There is no Program Name for any channel in any Channel Table as

shipped from Tektronix. Use the Channel Table Editor to add the Program

Names as needed.

The Measure menu (see Figure 3—27) is used to make measurements, tune the

demodulator and the 2714/2715 to a specific channel, and recall results from

2714/2715.

Measure

Current Selection

Sequence

Tune to Channel

Get Stored Results from 2714/2715...

Figure 3-27: The Measure menu

The Current Selection makes the measurements for the selected cells. This is true

with the exception of the Visual, Aural Carrier Level, and Frequency cells. Select

any of these measurements and all six are performed for the channel. To perform

all measurements for a single channel, select the entire row. Conversely, if you

want one measurement for all channels, select the entire column. This is the

same as Meas Sel from the Button Bar (see page 3-86). For a single cell, you

can achieve the same result as Current Selection by double-clicking on the cell

with the left mouse button. For a single row or column, you can achieve the

same results by double-clicking on the measurement or channel name.

If at least one of the Carrier Levels and Frequencies measurements (Visual

Carrier Levels, Visual Carrier Frequency, Aural Carrier Level, Aural Frequency

Offset, Second Aural Carrier Level, or Second Aural Frequency Offset) is

selected for all analog channels and Average Power measurements are selected

for all digital channels, CSSSO0 presents a message to allow the user to do a

Carrier Survey instead of a series of individual carrier level and Average Power

measurements. The advantages and disadvantages of selecting the Carrier Survey

are:

Advantage:

m Faster measurement execution
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Sequence

Tune to Channel

Get Stored Results from

2714/2715

Disadvantages:

m= The Pause For New Channel preference will not pause for new channels

within the survey

= All measurement results are tagged with the same date and time

= The CSS500 display is not updated until the survey is finished. (You might

think that the software has crashed.)

Whether you select individual measurements or the survey, the measurements

will still be made in the mode specified in the Measurement Setups dialog box.

If a Measurement Sequence is available (see Measurement Sequence, page 3-56)

then selecting Sequence performs the Measurement Sequence. This is the same

as the Meas Seq command button on the Button Bar (see page 3-86).

Note that the computer is not strictly dedicated to CSS500 while performing a

Measurement Sequence. You can switch to other applications while a Measure-

ment Sequence is running by sizing the CSS500 window so that other applica-

tion icons are visible. Start the Measurement Sequence then click on another

icon. If you select a DOS-based application that does not share memory, the

sequence will not be able to run until you exit that application.

For example, you can size the CSS500 window so that it only takes half of the

window and Excel so that it takes up the other half. You can run a Measurement

Sequence in one half and process results from a previous Measurement Sequence

on the other half while monitoring the results from the current Measurement

Sequence.

Tune to Channel tunes the selected demodulator and the 271X to the selected

channel. It will also set the Channel Table in the instrument, if it is not already

active. Select the channel by selecting a cell from the desired channel, then

choose Tune to Channel. It will report an error if the channel cannot be tuned.

Use this menu item (see Figure 3—28) to retrieve all the CATV measurement

results currently stored in the NVRAM of the connected 2714 or 2715. The

Notes field is not as complete as if it was done directly from the CSS500

application. The results are not erased from the 271X memory after they are

retrieved. Results can only be erased using specific 271X front panel keystrokes.
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Chan Table Count RFesults File

WWW a =| 6238

Figure 3-28: The Get Stored Results dialog box

Since results from the 271 X can come from multiple Channel Tables and Sites,

the measurement results are grouped according to Site and Channel Table name.

Ordering within the directory is alphabetical by site name. Count is the actual

number of measurement results contained in the group specified by the Site and

Chan Table columns. Results File is the name of the results file to which a

particular group of results has been exported.

Use the Export Results command button to export the results from the instru-

ment’s NVRAM into a results file, *.wsr. Use the Import Results command

button to bring the results file into a CSS500 worksheet.

When the Export is complete there will be a “.wsr” file in the Results File

Column in the Get Stored Results dialog box. This file is ready to be imported

into a worksheet.

The Import Results dialog box (see Figure 3—29) gives several choices of how

the data is imported into the worksheet:

@ Exact channel information match only

@ Use blank channel information as wildcards

= Verify mismatched channel information
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Import Results

A mismatched channel has been found

in the import Results File:

I t Results Fil
Worksheet Channel ee Channel” m

Number: 2 2

Letter: <blank> <blank>

Program: <blank> <blank>
Frequency: 55.25 <blank>

[ Import Channel Criteria

Figure 3-29: The Import Results dialog box

The top two choices will automatically load as much data as it can without any

user intervention. The last option allows you to check and verify all information

before loading any data.

Generally, when using Import to get results from an instrument into a worksheet,

“Use blank channel information as wildcards” is the most efficient option since

there will rarely be an exact match. This is because the instrument only stores the

channel number as the channel ID, while CSS500 stores the channel number,

program name, and nominal visual carrier. You could go through and verify each

channel if desired, to make sure that the channel numbers match, but generally,

the “Use blank channel information as wildcards” selection would be the most

efficient way to load the data, because it will reduce further prompts.

NOTE. If any of the results that you are importing contain results from CSO or

CTB measurements, you may end up importing more results than listed in the

results column because of the way that CSS500 distinguishes results. (True with

older firmware versions of the 2714.)

Any cell without results data or in Error condition will not be imported. Cells

that have more than one measurement will have all valid data imported and the

Error data results left blank.

If you are Importing results from a Channel Table that has mismatches in the

Channel Header, you are flagged during the import process so that you are aware
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Configure

Import complete. 0 results imported.

The following measurements were not imported for the given reason:

Measurement Channel Reason

Canier Levels and Frequencies

All Measurements on channel

All Measurements on channel

All Measurements on channel

All Measurements on channel

All Measurements on channel ON te Go Oo PD
inactive destination cell

user requested skip

user requested skip

user requested skip

no destination channel

channel header mismatch

VYorksheet Info...

Test ID...

Preferences...

Measurement Sequence...

Measurement Limits...

Measurement Setups...

Connections...

Demodulator

CSS500 Cable Television System Software User Manual

Figure 3-30: Imported results messages

TDC-10 } 14504

T¥1350

Rohde & Schwarz EMFP

v None

Figure 3-31: The Configure menu

of any problems and can fix them. The only exception to this is if the Channel

Number does not exist in the import worksheet Channel Table. In this case, you

are warned at the end of the import process with the message given in Fig-

ure 3-30.

If you are importing results from a channel table that has mismatches in the

channel header, no destination channel, an inactive destination cell, or a user

requested skip, you are warned at the end of the import process as shown in

Figure 3-30.

Use the Configure menu (see Figure 3—31) to set up worksheets, measurements,

and test equipment.
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Worksheet Info Worksheet Info edits the Site, Channel Table, and description for the current

worksheet. (See Figure 3-32.)

Worksheet Info

Site: [Tektronix - Beaverton

Description:

| Channel Table

File Name:

std. cht

Directories:

eur_il_cht

hre.cht

ire.cht

japan-m.cht

japan_m.cht

std. cht

stdofst.cht

stndrd_cht

Drives:

#] c: tektronix

Figure 3-32: The Worksheet Info dialog box

3-50

Site. The Site combo box defines the location where the measurements are made.

Only one Site is allowed per worksheet. If you change the Site, you are queried

whether you want to save the worksheet under a new name or overwrite the old

Site name. If you choose to overwrite the old name all of the history previously

collected under the old Site name will now be tagged with the new Site name.

<Undefined> is an acceptable Site name. “Blank” (nothing in the field at all) is

not acceptable and an error message will appear if “blank” is in the Site field.

Channel Table. This associates a certain Channel Table with a worksheet. The

Channel Table is a list of all of the available channels, their frequency, their

program name, etc. Only one Channel Table is allowed per Worksheet. If you

want to change the Channel Table, start with an empty worksheet.
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Create/Edit Channel Table. See Appendix C for more information on editing the

Channel Table. Edit the Channel Tables with caution; see the warnings in

Appendix C.

Save as Default. This command button allows you to save the Channel Table in

the combo box as the default Channel Table. When starting the CSS500

software, the default Channel Table loads automatically.

Description. Put any information that might be relevant into this field. How the

measurements were made, the serial numbers of the equipment used, who did the

measurements, and the dates are examples of things that you might want to load

into this field. This field is limited to 500 characters. Carriage returns are

allowed.

Use this field is to meet the FCC documentation requirements by entering:

= Identification of instruments (make, model, most recent calibration date)

= Description of procedures utilized

= Statement of qualifications of the person(s) performing the tests

The field is fully editable. The information can be copied to the clipboard using

CNTRL+INSERT or CNTRL4+4C, and then attached to the worksheet name cell

in Excel as a text note.
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Test ID

All Test IDs:

Use the copyThe Test ID is the name of the operator, test point, or whatever

identifier is most appropriate. The Test ID dialog box consists of a combo box

and a list box: All Test IDs and Worksheet Test ID (see Figure 3-33). All Test

IDs lists all of the Test IDs that have ever been used. Enter new Test IDs here.

Worksheet Test IDs are the IDs used in the current worksheet.

Test (ID

[Learner's Remote
<undefined>

Bruce

1H.

Learner's Permit

Learner's Remote

SUE

Figure 3-33: The Test ID dialog box

Preferences

3-52

Use this field to flag certain measurements and then use the View Filter, so only

cells that have a measurement associated with the selected Test ID are displayed.

To quickly change the Test ID you want to filter, select the Test ID from the

Worksheet Test IDs group and the View Filter will switch to that Test ID.

Also change the Test ID using the Test ID command button from the Button Bar

(see page 3-86).

This dialog box (see Figure 3-34) sets the way results are collected and

displayed.
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Preferences

| Measurement History

o Keep Last Result Only

[ Power Level Units

@ dBm¥

© dBu¥

| Measurement Execution

C] Pause on New Channel

Pause Execution Report out RS-232

[] On Caution [1] On Caution

[| On Alarm L] On Alarm

LJ On Error L] On Error

Exec. VM 700A

Function

C] On Caution

[] On Alarm

[] On Esror

Figure 3-34: The Preferences dialog box

Measurement History. History (the previous measurement results) can be

collected or only the most recent measurement saved. If History is turned off and

then turned back on, the measurements are saved beginning with the current

measurement displayed on the worksheet. Turning history off does not erase any

results previously stored when history was on. For an illustration of how this

works, see Figure 3-35.

Turn history on.

Make 2 more measurements

Stack after 4 more

measurements

Turn history off here

[3 |
[2 |

Measurements

in the “stack” [1 |

Figure 3-35: How measurements are saved when history is turned off, then on
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Power Level Units. Choose one of the two formats to display the Visual Carrier

Level and Average Power units:

dBmV [referenced to 1 mV (10-3 volts)]

dBuV [referenced to 1 uV (10~ volts)]

Measurement Execution. These check boxes determine whether the measurements

will stop and flag certain conditions, and how you are notified of these condi-

tions.

The first option is Prompt for Signal Connection. It is used if your RF feed to the

test equipment is on a switch instead of a splitter. If it is on a switch you need to

be able to switch the RF feed into either the 271 X or the TDC-10 (TV1350 or

EMPF) as needed. If this check box is selected, CSS500 also changes the

measurement order from: left to right then top to bottom — to: left to right and

top to bottom for the RF measurements, then left to right and top to bottom for

the baseband measurements. This is done so that the user only has to change the

connection once.

The second option is Pause on New Channel. It is used when the pre-selector

needs to be tuned for each channel or some other manual adjustment needs to be

done whenever the channels change.

The third option is a set of options that determine how non-standard conditions

are treated. The “non-standard” conditions include: measurement results in

Caution, Alarm, or Error. The Caution and Alarm conditions are set through the

limits file that is associated with a particular channel. The Limit files are set

using the Measurement Limits command from the Configure menu. See

page 3-64 for more information on the Measurement Limits. The Error condition

only occurs if a measurement cannot be made or the measurement results from

the instrument are out of the allowable range.

The ways these “non-standard” conditions could possibly be handled include:

Report out RS-232, Execute VM700A Function, or Pause Execution.

Pause Execution is appropriate for user interactive measurements. You can watch

it make the measurements and fix any problems that occur. If the measurements

are stopped because this is set, you have two choices: OK continues making

measurements; Cancel drops out.

The Execute VM700A Function calls one VM700A function:

CSS500~ALARM_ON. When this is enabled and a flagged condition occurs, a

specific function within the VM700A is executed for alarm activation,

CSS500~ALARM_ON. This default function is loaded in the VM700A as

required. First, CSS500 attempts to play back the appropriate function. If there is

no function by that name, then the default function is loaded into the VM700A.

The default function controls the relay switch located on the back of the

VM700A between the two RS-232 ports. CSS500~ALARM_ON closes the

relay.
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NOTE. Older versions of the CSS500 software did not have as many options for

non-standard conditions, so some things were treated differently. If Pause on

Alarm was selected in these versions, two VM700A functions were called:

CSS500~ALARM_ON and CSS500~ALARM_OFF. The newer versions of the

software only calls CSSSOO~ALARM_ON. The older versions called

CSS500~ALARM_OFF when the user “un-paused” the system after an alarm.

Therefore, when upgrading to a new version make sure that you manually reopen

the relay on the VM700A, if you are using the default function. The other option

is to use a Pause On Alarm, Caution, or Error. When you select the OK for the

resulting dialog box, the CSSSOO~ALARM_OFF function is called.

You can create your own function by the same name. CSS500 will not overwrite

the functions if they already exist in the VM700A. The function you create can

perform any type of action. This can be printing messages on the printer or even

dialing a personal pager by way of a modem attached to one of the VM700A

Serial Ports. See the VM700A manuals for more information on how to write

your own functions.

NOTE. A VM700A measurement result does not need to be the cause of an

Execute VM700A Function. “Non-standard” measurement results from any

instrument can cause a call to the VM700A function.

Report out RS-232 sends a Violation Report out the Com Port (set with

Connections, from the Preferences menu). Based on the conditions selected, the

following information is sent: Site Name, Measurement Column Heading,

Channel Number/Tag/Program, Condition Type (alarm, caution, or error), and

Date/Time. This information is tab delimited and packetized ASCII text. Each

Violation Report is one packet and each packet consists of:

= Aone byte Byte Count that gives the number of bytes in the Violation

Report (this includes the checksum)

# The Violation Report in ASCII text

= Aone byte checksum (simple addition, including the Byte Count)

An additional reporting option is to broadcast a message to all active Windows

applications that have registered to intercept this message. This function allows

you to perform additional processing when an alarm occurs. To receive these

messages, your Windows application must execute the following line of code:

nAlarmMsg = RegisterWindowMessage("WM POST ALARM MESSAGE") ;
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Measurement Sequence

3-56

The variable nAlarmMsg represents the unique Windows message number. To

intercept it, simply test for nAlarmMsg in the main messaging loop. The severity

of the nonstandard condition is indicated by msg.lParam (Action = 1, Alarm = 2,

and Error = 3). For example:

MSG msg;

while (getMessage(&msg, NULL, 0, 0))

{
if (msg.message == nAlarmMsg)

{
if(msg.1Parm == 1)

MessageBox(NULL, "Got Caution Message!", NULL, MB OK);

else if (msg.1Parm == 2)

MessageBox(NULL, "Got Alarm Message!", NULL, MB OK);

else if (msg.1]Parm == 3)

MessageBox(NULL, "Got Error Message!", NULL, MB OK);

NOTE. This option is not “set” anywhere. It is automatically available whenever

an alarm, caution, or error result is encountered.

The Measurement Sequence menu (see Figure 3—36) allows you to program a set

of measurements to execute every time the Meas Seq command button (see page

3-86) or Measurement Sequence command (under the Measure menu, see page

3-45) is chosen. This allows a regularly used set of measurements to be invoked

with a single mouse click instead of running each individual measurement one at

a time.
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Auto Selection

| 24 Hour Test
| Edit Time Parameters | | OK |

[Create 2714/2715 UDP || Cancel |

_ Clear Sequence || | Help |

win F

CSS500 Cable Television System Software User Manual

An “X” in a cell indicates that the channel and measurement are part of the

Measurement Sequence. Select as many or few cells as needed to define a

Measurement Sequence. When all of the desired cells are selected, choose the

OK command button; the Measurement Sequence immediately loads and is

stored under the Meas Seq command button.

To speed up the process for likely groups of measurements, there are four

predefined “Auto Selection” Measurement Sequences. They are: FCC Pre-and

Post Converter Measurements, FCC Headend Measurements, and 24 Hour

Measurements. If the country is not United States, then only the 24 Hour Test

automatic selection button is available. The Country is selected from the

Windows Control Panel, International icon. Table 3-6 give a list of measure-

ments included in the Auto Selections. These measurements are executed on the

channels selected by the user. Whenever one of these Auto-Selection command

buttons is chosen, it loads the measurements immediately into the Measurement

Sequence. Additional measurements are then added or deleted as desired by the

user to complete a Measurement Sequence.
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Table 3-6: Auto Configure buttons

Auto Selection Button

FCC FCC FCC

Channels Pre-Converter | Post-Converter | Headend 24 Hour Test!

All Channels Carrier Levels Carrier Levels Carrier Levels Carrier Levels

and Frequencies | and Frequencies | and Frequencies | and Frequencies

Selected ICR or Carrier to FCC

Channels Multiburst Noise Ratio Baseband

Selected CSO

Channels

Selected CTB

Channels

Selected Cross

Channels Modulation

Selected Hum

Channels

1 The 24 Hour Test automatically includes 4 repetitions at 6-hour intervals.

There are other options on the Measurement Sequence menu. They include:

Carrier Survey, Edit Time Parameters, Generate 2714/2715 UDP, and Clear

Sequence.

If you want to make the Carrier Levels and Frequencies measurements (Visual

Carrier Levels, Visual Carrier Frequency, Aural Carrier Level, Aural Frequency

Offset, Second Aural Carrier, and Second Aural Frequency) and Average Power

measurements on all channels in the Measurement Sequence, then you can do a

Carrier Survey instead of a series of individual measurements. (A carrier survey

makes all of the Aural, Visual Carrier Amplitude, Frequency, and Average Power

measurements first, and then the rest of the selected measurements.) The

advantages and drawbacks of selecting the Carrier Survey are as follows:

Advantages:

= Faster measurement execution

= Smaller UDP size (allows for more measurements to be loaded before

exceeding the UDP size limit)

Disadvantages:

m= The Pause For New Channel preference will not pause for new channels

within the survey

= All measurement results are tagged with the same date and time
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Whether you select individual measurements or the survey, the measurements

will still be made in the mode specified in the Measurement Setups dialog box.

The Edit Time Parameters dialog box tells the sequence when to start, and how

many times to run. (See Figure 3-37.)

Edit Time Parameters

- Time Parameters

Bun Immediately

Stari Dae Heer Mmuate:

[Any [i | [x |

Run N Times: Repeat Interval:

Figure 3-37: Edit Time Parameters dialog box

Run Continuously runs the Measurement Sequence in an infinite loop. It runs

through the entire Measurement Sequence and then starts over again until you

choose the Cancel command button.

Run Immediately starts the Measurement Sequence whenever the Meas Seq

command button (or equivalent) is chosen.

If the Run Immediately check box is not selected, then the Start Day needs to be

selected from the list box. Your options are Any or a particular day of the week.

Any means “today.” If a specific day of the week is selected, then the Measure-

ment Sequence will not start until the computer’s internal clock reaches that day.

Enter the starting Hour and Minute (in 24-hour time) that you want it to start in

the Hour and Minute text box.

Please note that the Start Time is only defined by the internal clock for the PC

running CSS500, if the Measurement Sequence is run directly from CSS500. If a

UDP is generated and the Measurement Sequence is run from a remote location,

then the 271X’s internal clock is used as the timing reference. (All time/date

stamps for a measurement are from the 271X’s internal clock.)

Use the Run N Times text box, if you want the Measurement Sequence not to

run continuously. You enter the number of times in the Run N Times text box

and the Repeat Interval in its text box. If you only want the sequence to run

once, enter “1” in the Run N Times box and “0” in the Repeat Interval text box.
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If you are running a Measurement Sequence several times and the Measurement

Sequence is longer than the Repeat Interval, the Measurement Sequence will

simply start the next run as soon as the previous one completes.

The Repeat Interval must be an integer number of hours. The Repeat Interval

counts from the Measurement Sequence start time.

Create 2714/2715 UDP. If a Measurement Sequence is being defined for a 271X to

use at a remote location, then you use the Create 2714/2715 UDP (User Defined

Program) command button. This command button converts the CSS500

Measurement Sequence into a UDP and immediately loads it into the 271 X. The

instrument can then use the UDP to make measurements later at a remote

location. You can load the results back into the CSS500 application using the Get

Stored Results from 2714/2715 command (located in the Measure menu, see

page 3-46).

Up to nine UDPs can be stored in each 271X. If the 271X will not load a UDP, it

may already have nine UDPs. CSS500 allows up to 28 characters with no

commas or semicolons for the UDP title (see Figure 3-38).

Generate 2714/2715 UDP

UDP Title:

Figure 3-38: Generate 2714/2715 UDP dialog box

When running a UDP, the preferred amplitude units may not be reflected on the

271X display. This does not make a difference, since the units convert to the

desired value when the results load into the CSS500 worksheet.

Be careful when defining a Measurement Sequence for a UDP. Remember that

all header and preference information must be correct before the UDP is loaded

into the 271X. The information sent includes: Channel Table, Measurement

Execution Preferences (Pause on New Channel and Prompt for Signal Connec-

tion), Start Day and Time, Repeat Interval, Repeat Count (Run N Times), Visual

Carrier Level Units, and Test ID (Operator Field in the 271 X —not editable at the

271X). See Table 3-7 for a complete list of what is loaded into the 271X when a

UDP is created.
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Table 3-7: Information loaded into the 271X during the creation of an UDP

Parameter Where Edited

Title User entered at the Generate 2714/2715 UDP prompt

Run N Times The Edit Time Parameters, from the Measurement

Repeat Interval Sequence dialog box (Configure menu)

Start Day

Start Hour

Start Time

Prompt for Signal Connection From Preferences in the Configure menu

Pause on New Channel From Preferences in the Configure menu

Channel Table From the Worksheet Info dialog box (Configure menu)

Test ID From Test ID (Configure menu)

Reference Level Units From Preferences (Configure menu)

Measurement Setups! From the Measurement Setups dialog box (Configure

(for the individual channels) menu)

Power Line Frequency From the Measurement Setups dialog box (Configure

menu)

External Attenuation/Amplification | From the Measurement Setups dialog box (Configure

menu)

Preamp From the Measurement Setups dialog box (Configure

menu)

Measurements on Channels? From the Measurement Sequence (Configure menu)

1 [If the Gated option is selected for one or more measurements and you are trying to

send the UDP to a 2714, you are given a warning that Gated is not supported and

allowed to continue with Auto mode.

2 If adigital measurement (Average Power, Desirable to Undesirable, or Adjacent

Channel Leakage) is selected for one or more channels and you are trying to send

the UDP to a 2714 or 2715 that does not support digital measurements (2715 if

firmware version 09-30-94 or earlier) a warning is displayed that digital measure-

ments are not supported and will be skipped.

If a baseband video test is selected and you are trying to create a 271X UDP, you are

given a warning that baseband video tests (FCC Baseband, Signal to Noise,

Waveform Distortion, Multiburst, ICPM and Audio) are not supported by the 2714 or

2715, and the tests will be skipped.

If any of the conditions described in notes 1 or 2 were encountered, a summary of

the warnings is displayed. You will be given a chance to continue generating the

UDP, with the problems handled as indicated, by pressing OK, or you can quit

generating the UDP by pressing CANCEL.
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UDPs are not necessarily fully automated. Many measurements require operator

input to collect results. Table 3-8 lists the measurements that may require

operator input, the type of input required, and the circumstances that cause the

operator input to be required.

Table 3-8: Measurements that require operator input

Operator Input Required

Turn Carrier Turn Modulation On/ | Turn Scrambling Turn On/Off

Measurements On/Off Off On/Off Test Signal

Carrier to Noise | 6

Desirable to Undesirable 2

CSO 1 6

CTB 1

Cross Modulation 2

ICR 6 5

Hum/LFD

Modulation Depth 3 (RF only)

Aural Deviation

Audio 7

ALL 4

Explanations 1. Auto with Pause or Single Sweep only. (Change via Measurement Setups from the Configure menu.)

2. Always prompts.

3. Only prompts if the channel is flagged as scrambled in the Channel Table.

4, Always prompts you to turn off scrambling as soon at it reaches a measurement that requires the

scrambling turned off. Will also prompt you to turn the scrambling back on after making all measure-

ments for that channel.

5. Only if this measurement is not made using Gated.

6. Only if this measurement is made using Gated and the channel is flagged as scrambled in the

channel table.

7. Audio measurements may require that the ASG100 Test Sequence be started.

To generate a user defined program (UDP) that will run unattended, select the

measurement modes shown in Table 3—9. Desired to Undesired and Cross

Modulation always require user intervention; they cannot be run unattended in a

UDP.
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Table 3-9: Modes for unattended UDPs

Measurement Mode

Carrier Levels and Frequencies Any mode

Average Power Accurate Amplitude

Carrier to Noise Auto or Gated!

CSO? Auto? or Gated!

CTB Auto3

Adjacent Channel Leakage Any mode

In-Channel Response Gated!

Hum/LFD Any mode4

Modulation Depth Any mode

Aural Deviation Any mode

1 For Gated mode to work without user intervention in Carrier to Noise and CSO
measurements, the channel must not be scrambled. If the channel is scrambled,

Carrier to Noise and CSO must be run in Auto mode to avoid user intervention.

2 On digital channels, CSO and CTB always run in Auto with Pause mode. This mode

requires user intervention. To avoid user intervention, make sure CSO and CTB are

not selected for digital channels.

3 Measure Beat in an empty adjacent channel.

4 If the channel is scrambled, ICR, Hum/LFD, and Modulation Depth cannot be run

without user intervention.

The selected Channel Table must exist in the instrument when the UDP is run or

an error message will occur. The Channel Table is not loaded into the instrument

by the UDP. Use the Channel Table Editor to load the Channel Table into the

instrument. (See Appendix C.)

The Site is not part of the UDP and it is the operator’s responsibility to correctly

load it into the instrument before the UDP is run. This way the same UDP can be

run at several Sites.

Measurement Sequences in Non-US Countries. If you are using CSS500 in a

country other than the US, your Measurement Sequence dialog box will look

different. See Figure 3-39. (The country is defined in the Windows Control

Panel using the International icon. The first line in the International dialog box is

the Country. ) The differences are due to FCC (a US regulatory body) require-

ments. If you want to use the FCC Auto Selection buttons, change your country

from the Windows Control Panel to United States, and restart the CSS500

application.
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LJ Canier Survey

Measurement Limits The Measurements Limits file defines the alarm and caution levels for the

measurement results. There is a default Limits file that comes with the CSS500

application, but you can edit the file to conform to your needs. Each channel can

have a different Limits file assigned (for example, one for premium channel, one

for local, and one for cable access) or one Limits file for all the channels. Attach

a Limits file to a channel using the <-Select Limits File command button. See

Figure 3-40.
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ntsc.lin

ntsc.lin

ntsc.lim

ntsc.lim

ntsc.lim

ntsc.lim

ntsc .lim

ntsc.lim

ntsc.lim

- Summary Limits

eat Audio Limits _

SystemTMDef4 | Select Audio Limits
SystenTMDer4 Eiiaaion PEIDES

SystemTMDefd |

SystemTMDefa.

SystemTMDefa _ ans
SustemTMDef LongHaul

SyustemTMDefa. ShortH aul

SystemTMDefa xyzdef

SyustemTMDef¢

SystemTMDefd

SystemTMDefa |

SustemTMDeFf 4

SystemTMDefq |

SystemTMDefd + | Get Audio Limits |

Visual Canier Level Difference {dB}: = --- [6 | -

Adjacent Visual Carrier Level Difference (dB}: —---

Lower Upper Lower Upper

Caution Caution Alarm Alarm Range

(0-40

(0-40
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Clear Limits File. The Clear Limits File command button removes the limits file

from selected channels. CSS500 can still make measurements and save results

without a Limits file, but there will be no Caution, Alarm, or Passing flags in the

results. As soon as a Limits file is attached to a channel all of the measurement

results made for that channel are flagged according to that Limits file.

<—Select Limits File. This command button attaches the selected Limits File in

the Limits file combo box to the selected channel. All results for that channel are

flagged according to the new Limits file (including all history).

Edit Limits File. This command button allows you to edit the selected Limits file

from the Limits File list box shown in Figure 3-41.

YAN CAUTION. Any changes made by editing a Limits file affect all worksheets using

that Limits file, not just the current worksheet.
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Figure 3-41: The Edit Limits File dialog box

NOTE. The Visual Carrier Frequency, Aural Frequency Offset, and Second Aural

Frequency Offset are specified in deviation from nominal.

If you want to edit a Limits file, start by renaming a copy of one of the provided

Limits files and edit that file rather than one of the provided files. To rename the

file select the Save As Limits File command button, enter a new name for the

Limits file, and then select the OK button. This way, the original file will remain

uncorrupted (in case any errors occur during editing). The files provided with

CSS500 are read-only. If you choose to edit them, you must change the

read-only attribute first or you cannot save any changes.

The Limits file must be in the Limits sub-directory under the directory that

contains the CSS500.EXE file. The Limits file should end in “.lim” to help

simplify your file management.

You can’t edit the Range columns or the Units (they are shown for user

information only), but the Limits columns are editable. Figure 3-42 shows how

the Upper and Lower Limits work to flag measurement results. Those four
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columns are editable, but they are limited by the Range Limits. If you attempt to

enter a value outside those defined by the Range limits then you will get an error

message, that cell will be highlighted, and it will expect a correct value to be

entered.

Aural carrier frequency

Alarm Caution Good Caution Alarm ieee ae Wit
<=>

-§ -3 3 5 kHz

Carrier to noise

Alarm Caution Good — Only lower limits

——_>

43 45 dB

ICR

Good Caution Alarm Only upper limits

<<¢——

1.5 2 dB

Figure 3-42: How the upper and lower limits work

The command buttons in the Edit Limits File dialog box are:

= Open Limits File. The Open Limits File command button allows you to

select a different Limits File to edit. The name of the Limits file that you are

currently editing is in the Title Bar for the Edit Limits dialog box.

m Save As Limits File. Save As Limits File command button saves any

changes made to the current Limits file (the one whose name is in the Title

Bar). Don’t forget that any changes made to this Limits file are reflected in

every worksheet that uses that Limits file.

= Get Defaults. Get Defaults places all of the default values into the Edit

Limits dialog box.

m Save As Defaults (See Figure 3-43). This command button takes all of the

current values in the Limits file and saves them to a new Limits file which is

then used as the default Limits file. The default Limits file values are loaded

into the current Limits file using the Get Defaults command button. It also is

used as the Limits file for all channels whenever a new worksheet is defined

or you start making measurements without defining any worksheet. This new

Limits file can have the same name as the file you were editing but it would

help your file management to call it, “Default” or something similar, so that

you can remember what you are using as the default Limits file.
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Save As Defaults Limits

File Name: Directories:

[defaults tim c:\css500\imits

PaSy. hw

test ign

Figure 3-43: The Save As Defaults dialog box

= Clear Limits. This command button clears all of the limits from all of the

measurements. If this is done by accident, you can recover by choosing the

Cancel Command button.

= Audio Limits. When you execute an audio measurement, the Audio Limits

file specified for the channel is activated in the VM700A. If it is not present,

an error message is displayed and the measurement terminated. If no audio

limit was assigned to the channel, then the default VM700A Audio Limits

file is used, SYSTEM~DEFAULT. If you want to change the default Audio

Limits file, you must make the change in the CSS500.INI file. (See The

CSS500.INI File on page E—6 for how to make this change.)

Limits for audio measurements are not stored in the CSS500 Limits file, since

many are graphical in nature and cannot be represented by individual values.

There are two main consequences. First, changing the Audio Limits file (this can

only be done from the VM700A) has no effect on previous measurement results

flagging (unlike the rest of the Limits files which change all the measurement

results that use that limit file). Second, the measurement limits have those

numbers available at all times. The audio limits only have numbers available

when a measurement fails.
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| Summary Limits

NOTE. Audio limits are different from video limits in several important ways:

B® Audio limits come from the VM700A.

@ You cannot edit the audio limits with CSS500. That must be done at the

VM700A.

mg Audio limits stay with measurement results forever. Even if you change the

Limits file associated with a particular channel older results do not change

their alarm, caution, or error State.

Clear Audio Limits. Remove the Audio Limits file from the selected Channel(s).

Select Audio Limits. Sets the current channel to the currently selected audio

limits.

Get Audio Limits. Reads the list of available audio limits from the connected

VM700A and places them in the audio limits list box.

Summary Limits. The Summary Limits at the bottom of the Limits window are

global parameters in that they apply to all channels (see Figure 3-44).

Visual Carier Level Difference {dB}: = --- [fei -- (0 - 40)

Adjacent Visual Carrier Level Difference (dB: -- [2 | -- [3 | (0-40)

Lower Upper Lower Upper

Caution Caution Alarm Alarm Range

Figure 3-44: Summary Limits (part of the Measurement Limits dialog box)

Visual Carrier Level Differences defines the range that the Visual carrier can vary

across all channels. Adjacent Visual Carrier Level Difference is the amount of

variation in amplitude between two channels that are next to each other in

frequency. The Adjacent results may be misleading if a View Filter is on because

channels next to each other in the worksheet are not necessarily next to each

other in frequency.
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Measurement Setups

NOTE. If a View Filter is on, some measurement results can be misleading. Take

note of the View Filter Status when interpreting results.

These parameters are not visible on the worksheet; rather they are part of the

Status Report, Results Detail, and Measurement Summary.

The Get Defaults command button loads the default values into the Summary

limits. The Save As Defaults button sets the current values as the defaults.

Choose the Parameters command button to set the window for adjacent channels.

This dialog box (see Figure 3-45) defines what constitutes an adjacent channel.

Any “adjacent” channels that are outside of this frequency window are not

included in the calculations. Select what is required for your system and then

choose OK.

Parameters

Figure 3-45: The Parameters dialog box

There are many different ways that test equipment can be set up. The configura-

tion tells CSS500 how your system is set up to retrieve the correct results. Find

this item under the Configure menu, Measurement Setups. There are setups that

affect all channels and some that are channel specific. The Measurement Setups

dialog box is shown in Figure 3-46.
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Measurement Setups

All Channels

- 2714/2715 :
Power Line

External

Attenuation{-]/ Preamp: Frequency:
Amplification{+): © On @ 60 Hz

dB @onr ©50uz2

| Zero Carmier Pulse TDC-10

Line: [13 | Field: [1 on

Center Location: [35 | uS ie) 1? dB

[ Selected Channels

Figure 3-46: The Measurement Setups dialog box

All Channels Group. The All Channels group allows you to customize measure-

ments. The All Channels group categories include Get Defaults, Save As

Defaults, Zero Carrier Pulse, TDC-10 and 2714/2715.

Get Defaults. This command button loads all of the previously saved default

values into the All Channels group text boxes and option buttons.

Save As Defaults. This command button saves all of the current text box and

option button settings as the default values. The default values are automatically

loaded whenever a new worksheet is created. They are also available through the

Get Defaults command button.

@ 2714/2715 Sub-group. This group allows you to set up the software to

match your equipment setup.
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External Attenuation/Amplification. Enter the necessary attenuation or

amplification (in dB) needed to compensate for losses or gains in your

system in this text box. For example, if a measurement is being made at a

20 dB down test point, enter —20 in the text box.

Power Line Frequency. Either 50 or 60 Hz.

Preamp. Select the On or Off option button to match your equipment setup.

The Preamp is generally “on” in low-level signal conditions to improve the

resolution of the measurements. Set the Preamp according to the specifica-

tions in the 2714 manual. The 2715 automatically uses the optimum preamp

setting and then resets it back to the value selected to this option button.

Carrier Level Mode. This setup specifies the mode used when making carrier

level measurements. The options are: Accurate Frequency and Amplitude,

Accurate Amplitude Only, and Fast Amplitude Only. The selection applies to

individual carrier level measurements as well as surveys.

NOTE. It is recommended that you use Accurate Frequency and Amplitude for

any FCC measurements.

= Zero Carrier Pulse Sub-group. This group allows you to set the parameters

related to the Zero Carrier Pulse.

Zero Carrier Pulse. The Zero Carrier Pulse is available from both fields on

lines 10 through 25. The VM700A uses this as a timing reference. Make sure

that the reference set here is the same as the reference set by internal jumpers

in the 1450A or the TV1350.

= TDC-10 Sub-group. This group allows you to set the amplification used by

the TDC-10.

NOTE. The TDC-10 selection is not available if the TV1350 or EMPF Demodu-

lator is selected.

Preamp. The Preamp allows improved sensitivity when measuring low-level

signals. Select the RF preamplification according to the specifications in the

TDC-10 manual.

Selected Channels Group. The Selected Channels Group allows you to continue

customizing measurements down to the individual channel. The categories found

under Selected Channels are: Carrier to Noise, VM700A VITS, VM700A

Measurements, Modulation Depth, CSO, CTB, and In-Channel Response.

Edit the individual channels by choosing the Edit Setups command button. The

dialog box is shown in Figure 3-47.
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Carrier to Noise Group. Select the Auto, Auto with Pause, or Gated option

button. Auto with Pause requires that the carrier be turned off in order to make

the measurement. The measurement will stop and prompt you to turn off the

carrier and wait for you to respond that the carrier is off before it will continue

making measurements. Auto makes the measurement without taking the channel

out of service or requiring any operator interface. Gated makes the measurement

on a non-modulated line, therefore there is no requirement to turn the carrier off

or take the channel out of service. Gated is only available for the 2715.

Enter the bandwidth for the noise calculation in the Noise Bandwidth text box.

Modulation Depth Group. Select either Baseband or RF option buttons for how

to make the Modulation Depth measurement. If Baseband, the VM700A makes

the measurement. If RF, then the 271X makes the measurement.

VM 700A Measurements Group. Select either Source A, C or Source B as the

rear panel connection where the VM700A should look for the input signal.
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NOTE. ICPM measurements cannot be made if Source B is selected.

ACL Group. Measures the power in the channels adjacent to the channel under

test. This is a headend test with the 2715 connected to the test port of the

modulator. Select Upper to measure the power in the upper adjacent channel

only, Lower to measure the lower adjacent channel only, or Both to measure both

the upper and lower channels.

In-Channel Response Group. Selects how you want the In-Channel Response

(ICR) measurement executed.

Select either the Baseband (Sin(x)/x) or RF option button. The baseband option

uses the VM700A while the RF uses the 271 X to make the ICR measurement.

Sometimes, you only have one or the other piece of equipment available and this

measurement can be made either way.

If you select the RF option you can also make that measurement Gated. Gated is

called “in service” on the 2715 instruments. This allows measurements to be

made on-line with no modulation.

Whichever option button you select, enter the relative frequencies where you

want the measurement calculated (up to six locations for RF and seven locations

for Baseband) in the Test Locations text boxes.

CSO Group. Select the way you want the CSO measurement performed by

selecting Auto, Auto with Pause, Single Sweep, or Gated option Buttons. For

digital channels, only Auto with Pause is available. Gated is called “in service”

on the 271X instruments. This allows measurements to be made on-line with no

modulation.

Enter up to five relative test locations for the CSO measurement in the Test

Locations text boxes. Be sure to take into consideration the way that the 271X

handles CSO and CTB measurements if you are doing a measurement setup for a

UDP.

See the following discussion on Distinguishing 2714 CTB and CSO Measure-

ment Results in the UDP.

CTB Group. Select the way you want the CTB measurement made using the

Auto, Auto with Pause, or Single Sweep option buttons. For digital channels,

only Auto with Pause is available.

Enter up to five test locations for the CTB measurement in the Test Locations

text boxes. Select either the Rel (relative) or Abs (absolute) option buttons for

each test location. Again, be sure to take into consideration the way that the

271X handles CSO and CTB measurements if you are doing a measurement

setup for a UDP. See the following discussion on Distinguishing 2714 CTB and

CSO Measurement Results in the UDP.
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Distinguishing 2714 CTB and CSO Measurement Results. The following is a

description of how the CSS500 splits the generic 2714 distortion results into

separate CTB and CSO results.

NOTE. This discussion applies only to the Get Stored Results from the 2714/2715

function, from the Measure menu. Early versions of the 2714 firmware (06.05.92

and 01.05.93) had CTB and CSO combined into a single test called CTB/CSO.

CSS500 keeps CTB and CSO test results separate. When a user gets stored

results from a 2714 with early firmware, CSS500 must make a determination as

to whether each CTB/CSO result from the 2714 should be treated as a CTB

result or a CSO result. The paragraphs below describe how CSS500 makes this

determination, based on the value of the test frequency and whether the

frequency was specified as relative or absolute.

Begin with a default CTB and CSO Measurement Setup of:

CSO: +1.25MHZ (Rel), +0.75MHz (Rel), CTB: OMHz (Rel).

The Measurement Setup of CSO and CTB is done from Measurement Setups in

the Configure menu (see page 3-70). Since the 2714 uses a single generic

distortion measurement to measure both second and third order beats and

distinguishes the two only by the specified test locations, the software uses the

following rule to separate results from the 2714 generic distortion measurement:

Results measured at an absolute (Abs) frequency location or a relative (Rel)

frequency location that lies within a frequency range determined by the CTB

Measurement Setup are designated as CTB results. Results measured at a

relative frequency location outside this frequency range are designated as

CSO results.

The frequency range is determined from the current CSS500 CTB Measurement

Setup for the channel as follows:

CTB Result Range = OMHz + (Max CTB Test Location + Search

Ambiguity)

where,

Max CTB Test Location = The maximum absolute value of all the CTB relative

test locations, as defined in the CSS500 CTB Measurement Setup for the result

channel.

Search Ambiguity = The maximum frequency range over which the 2714

searches for beat maximums relative to the actual given test location. This is set

to 100 kHz in the 2714.

CTB and CSO Measurement Setup Restrictions. To make the above scheme

consistent, CTB and CSO test locations should not be allowed to overlap.

Therefore, the CSO Measurement Setup is restricted as follows:
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The allowed CSO test locations must lie outside the frequency range defined by

the CTB Measurement Setup. This frequency range is determined as specified

above except that the Search Ambiguity is doubled to 200 kHz (see Figure

3-48). This is because, in the worst case, a CTB signal may be found 100 kHz

above the specified test location and a CSO signal may be found 100 kHz below

another test location. This would result in an overlap of the CTB frequency range

unless a 200 kHz ambiguity range (guard band) is enforced. Also, Absolute

(Abs) test locations are allowed only in the CTB Measurement Setup.

| Visual carrier frequency for this channel

CSO setup range CTB setup range | CSO setup range

|

200 kHz OkHz 200kHz

CTB location range Maximum CTB test location

Figure 3-48: CTB/CSO measurement results distribution and the CSO setup

restrictions

VITS Group (NTSC). It is important that the locations of the VITS signals are

correct. In NTSC, if the locations are not correct, the VM700A will search for

them, first using the VITS ID and then using a VITS Search. (The VITS Search

has a wider search range than the VITS ID.) This slows down the measurement

process. The VM700A will automatically enter the location of VITS when it

finds them, so it will only have to search for them once. If the VITS cannot be

found, the default line numbers are left alone and a note is placed in the Notes

field (of the Results Detail Display) that the VITS line could not be found for

this measurement.

NOTE. For the ICR measurement, if the VM700A cannot find Sin(x)/x using the

VITS ID it then switches to looking for Multiburst during the VITS Search.

VMZ700A VITS Group (PAL). (See Figure 3-49.)
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- ¥M 7004 VITS

Figure 3-49: The VITS group for a PAL system

If the Channel Table specifies that you have a PAL system, the VITS group will

only have an Edit PAL VITS command button in the VM700A VITS group box.

The PAL version of the VM700A does not have a VITS ID application like the

NTSC version does. The PAL VM700A does have a VITS search capability in

individual measurement mode applications. The VITS search feature cannot be

used in the same manner as the VITS ID application. This is because rather than

identifying VITS and writing the results to one file, as VITS ID is designed to

do, the VITS search feature is unique to each application and only looks for the

proper test signal for each individual application. If a “correct” signal is found,

the measurement begins and returns valid data. If the VITS search does not turn

up a valid signal type, the application returns erroneous data along with an

unpredictable test signal type. In other words, the VITS search feature can only

be used to find the test signal for which the application was written.

The CSS500 baseband measurements are arranged into seven groups, with each

group requiring a particular test signal as given in Table 3-10.

Table 3-10: Required test signal for each measurement

Group Required Test Signal

Waveform Distortion Group Any one of lines 10-23 or 320-335. Identified as “Compos-

ite” in Diff Gain/Diff Phase application.

Baseband Group Any one of lines 10-23 or 320-335. Identified as “Pulse” in

Chroma/Luma Gain Delay application for Chroma-Luma

Gain and Delay, and then another identified in DGDP

application for Diff Gain and Phase.

In-Channel Response Group Any one of lines 10-23 or 320-335. Multiburst. Identified as
“multiburst” in Multiburst application. Sin(x)/x not used when

searching.

Modulation Depth Any one of lines 10-23 or 320-335. Luminance Bar and Zero

Carrier. Zero Carrier position fixed, and Bar identified as

“Bar” in Bar LineTime application.
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Table 3-10: Required test signal for each measurement (Cont.) ©

Group Required Test Signal VU

Multiburst Group Any one of lines 10-23 or 320-335. Identified as “Multiburst”

in Multiburst application.

Signal to Noise Group Any one of lines 6-23 or 320-335. Identify as “pedestal” in U
Noise Spectrum application. Needs to be done before any

measurement has been taken. No way for measurement to

tell whether a line is quiet or not. VU
ICPM Any one of lines 10-23 or 320-335. Staircase signal, either

modulated or unmodulated. Identified as “Composite” in the VU

Diff Gain/Diff Phase application.

Choose the command button to edit the VITS lines and display the Edit PAL ©
VITS dialog box as shown in Figure 3-50. ©
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Figure 3-50: The Edit PAL VITS dialog box

See the VM700A opt 11 manual for more detailed explanations on these values.

Command Buttons for the Edit Setups for Channel XX Dialog Box. There are

three special command buttons located on the upper right hand corner of the Edit

Setups for Channel dialog box. They are Get Defaults, Save as Defaults, and

Copy to All Channels.

Get Defaults. The Get Defaults command button takes the default values and

places them in the text boxes. It also sets the option buttons to the default values.

The dialog box below appears, allowing you to decide what measurements

should get the default values. (See Figure 3-51.)
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Get Defaults

CL] vits

L] cso

] CIB

x} in-Channel Response:

_] Adjacent Channel Lkg

Figure 3-51: Get Defaults dialog box

Save as Defaults. This command button takes the current entries in the text boxes

and selected check boxes and stores them as the default values. Load these

default values into selected channels using the Get Defaults command button

when you are editing the setups for those channels. These become the default

values whenever a new worksheet is created. (See Figure 3-52.)

Save As Defaults

CJ Carrier to Noise

Cc] Modulation Depth

(_] ¥M700A Measurements

C] In-Channel Response

C] Adjacent Channel Lkg

Figure 3-52: Save As Defaults dialog box

Copy to All Channels. The Copy to All Channels command button takes all of

the settings for the selected measurements and copies the current values to all

channels. (See Figure 3-53.) Note that CSO and CTB settings are handled in a

special way. If the current channel is digital, CSO and CTB setups are copied

only to digital channels. Similarly, if the current channel is analog, CSO and

CTB setups are copied only to analog channels.
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=| Copy to All Channels

C] Carrier to Noise

Modulation Depth

CJ VH700A Measurements

C] vits

[] ct

[_] In-Channel Response

] Adjacent Channel Lkg

The Connections dialog box sets up the GPIB and RS-232 control connections

for CSS500. The allowable GPIB addresses are from 0 to 29. Figure 3-54 shows

the Connections dialog box when the TDC-10/1450A is selected as the demodu-

lator. If any other demodulator is selected, it is reflected in the Demodulator

group. If None is selected, then the whole Demodulator group is grayed out.

CAUTION. To ensure proper operation and prevent software conflicts, verify that

no two instruments are assigned to the same port or GPIB address. This applies

even if an instrument is not connected or used.
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[271472715 Spectrum Analyzer

© GPIB GPIB Address: [0 |

Baud Rate:

Demodulator

GPIB Address: [1 | | IDC-10 GPIB Address: [2 |

| Switcher Control Port

COM Port:

Figure 3-54: The Connections dialog box

2714/2715 Spectrum Analyzer Group

= GPIB. If your system uses the GPIB, enter the address of the 271X in the

GPIB Address text box.

m RS-232. If your 271X uses RS-232 instead of GPIB, select the correct Com

port (1 — 4) from the Com Port list box and the correct baud rate from the

Baud Rate list box.

VM700A Group

= GPIB Address. The GPIB address of the VM700A.

Demodulator Group

= GPIB Address. The GPIB address of the demodulator. The contents and

availability of this group are determined by the selection made in Demodula-

tor from the Configure menu.

Switcher Control Port Group. This group contains all of the parameters required to

communicate with a switcher. See the documentation provided with the switcher

for how these should be set. The Delay parameter is in seconds. For more

information on using the switcher, please see Switcher Control String in

Appendix C, on page C-31.
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Demodulator

RS-232 Violations Reporting Group. This group sets the parameter for a port that

will receive error messages from the CSS500 if one of the measurements is in a

“non-standard condition”. Select the Com Port and the Baud Rate. For more

information on the RS-232 Violations report, please see page 3-55.

The Demodulator command selects between the supported demodulators (see

Figure 3-55).

¥ IDC-10 7 1450A

T¥1350...

Rohde & Schwarz EMFP...

None

Demodulator

Figure 3-55: The Demodulator menu item

If None is selected, then during measurement execution, no checking is made for

a demodulator. If a demodulator is selected, then during measurements the

following occurs:

= If making an RF measurement, CSS500 will try to talk to demodulator, if it

fails, no errors are reported and the measurements continue.

= If making a baseband measurement and the specified demodulator is not

found, an error message is displayed and the measurement is terminated.

If either the TV1350 or the EMFP is selected, then an additional dialog box

appears, as shown in Figure 3-56.

Demodulator Setups

© Sound Off

| Level Zero Ref Pulse

@® 75 Ohms || @ Low @ On

© 50 Ohms || © High © off

Figure 3-56: The Demodulator Setups dialog box
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Execute

Help

Channel Table Editor

Contents

Set these values as required for your system. These values automatically override

the front panel instrument settings.

The Execute menu allows you to launch the Channel Table Editor without

leaving the CSS500 application.

The Channel Table Editor is a separate application that allows you to edit and

create Channel Tables to load into the instruments. This command launches this

application or, if it is already started, this command switches to it. For more

information on this application, please see Appendix C.

The Help menu (see Figure 3—57) provides access to the CSS500 online help.

te a
Contents...

About...

Figure 3-57: The Help menu

Contents lists all of the available help topics (see Figure 3-58). These topics are

accessed by scrolling until the desired topic is highlighted and then choosing the

OK button or double clicking on the name. There are some general topics, then

all the menus and their associated commands are listed. At the end of the list are

the measurement help files. The measurement help files give a brief description

of the measurement, and the files have room for you to add your own notes about

the measurements. For details on editing these Help files, see Adding Informa-

tion to the Help Files, in Appendix E, on page E-3.

CSS500 Cable Television System Software User Manual

@9eeoeed TM@ ®e
@9e@eesd ®@
C

@©ee0e08e8ee



en ee

®eee0e

e©e2ee0e000000
2 »D

Menu Bar

Help Contents

List of Measurements (User Help Files}

Adjacent Channel Leakage

Audio Measurement

Aural Deviation

Average Power

Carnier Levels and Frequencies

Carer to Noise Ratio

Cross Modulation

cso

CTB

Figure 3-58: The Help Contents dialog box

These same topics are available from the Help command buttons in most dialog

boxes.

Make sure that you close the Help dialog box when you are finished. CSS500

will allow only one open dialog box at a time. Close the Help dialog boxes by

choosing Close from the Help Window Control Box or by pressing ALT+F4.

About = The About dialog box gives the version number of CSS500 and other informa-

tion (see Figure 3-59). Choose the OK command button to leave this dialog box.
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The same as Open in the File menu on the Menu Bar. (See page 3-13.)

The same as Save in the File menu on the Menu Bar. (See page 3-13.)

The same as Global View in the View menu on the Menu Bar. (See page 3-39.)

The same as Results Detail in the View menu on the Menu Bar. (See page 3-32.)

Same as the Status Report in the View menu on the Menu Bar. (See page 3-26.)

Same as Current Selection in the Measure menu on the Menu Bar. (See

page 3-45.)

Same as Measurement Sequence in the Measure menu on the Menu Bar. (See

page 3-46)

Same as Test ID in the Configure menu on the Menu Bar. (See page 3-52.)

Same as Measurement Setups in the Configure menu on the Menu Bar. (See

page 3-70.)

Same as Measurement Limits from the Configure menu on the Menu Bar. (See

page 3-64.)

Same as Print in the File menu on the Menu Bar. (See page 3-17.)
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This chapter is a quick reference to all of the commands available from the

CSS500 Menu Bar along with a brief description of what they do.

Table A-1: CSS500 Menu Bar menu map

Menu Command Description

File New Creates a new worksheet. All Measurement Setups and Limits files are automatical-

ly set to defaults, instead of what is in the current worksheet.

Open Opens an existing worksheet and makes it active.

Save Saves all changes made to the current worksheet.

Save As Saves the current worksheet under a new name.

Import Imports data from stored results files into the current worksheet.

Export Exports the worksheet results data out to a “.wsr’” file so that applications (such as

Excel) can process the data.

Print Prints the worksheet on the selected printer.

Print Setup Sets up the printer.

Exit Exits the CSS500 application.

Edit Copy Copies the contents of the selected cells into the Windows Clipboard.

Clear Deletes the current value and/or all history for the selected cells.

Select All Selects all of the cells in the spreadsheet.

View Status Report The Status Report lists the extremes for all of the measurement results.

Results Detail The Results Detail dialog box displays more information about a measurement than

can be contained in a cell on the spreadsheet. Also used to summarize individual

measurements and channels.

Global View This is a condensed view of the standard spreadsheet display.

2714/2715 Screen Displays a copy of what is displayed on the 2714/2715 screen.

Picture The Picture command displays a video picture of what is presently on a given chan-

nel. (Requires video display hardware.)

Measurements and Channels This is a View Filter that determines which channels and measurements are on the

spreadsheet. (Hides rows and columns on the spreadsheet.)

Measurement Sequence

Results

This is a View Filter that displays only those measurements made with the most

recent Measurement Sequence execution.

Test ID Results This is a View Filter that displays only cells that have measurements tagged with the

currently selected Test ID.

Row Header Fields This command determines what channel information is given in the row header. It

can include any combination of the following: Channel Number and Tag, Program

Name, or Channel Frequency.

CSS500 Cable Television System Software User Manual A-1



Appendix A: Menu Map

Table A-1: CSS500 Menu Bar menu map (Cont.)

Menu Command Description

Measure Current Selection Executes measurements for the currently selected cells.

Sequence Executes the currently defined Measurement Sequence.

Tune to Channel Tunes the instruments to the selected channel.

Get Stored Results from Retrieves all the CATV measurement results currently stored in the NVRAM of the

2714/2715 connected 2714 or 2715.

Configure Worksheet Info Enables you to specify worksheet Info such as the Site, Channel Table, and descrip-

tion for the current worksheet.

Test ID Brings up a dialog box that enables you to specify a test identifier such as Techni-

cian Name, Test Number, etc. There are two groups in the dialog box: All Test IDs

and Worksheet Test ID. The All Test IDs group lists all of the Test IDs that have ever

been used. The Worksheet Test IDs are the IDs used in the current worksheet.

Preferences Enables you to set preferences in the way results are collected and displayed.

Measurement Sequence Brings up a dialog box that enables you to program a set of measurements that will

be executed as a Measurement Sequence. This allows a regularly used set of mea-

surements to be called with a single keystroke.

Measurement Limits Brings up a dialog box that enables you to define the Alarm and Caution levels for

the measurement results.

Measurement Setups Brings up a dialog box that enables you to control how measurements are executed

in the instruments.

Connections Brings up a dialog box that enables you to set the GPIB and RS-232 control connec-

tions.

Demodulator This command selects which demodulator to use.

Execute Channel Table Editor Allows you to switch to or start the Channel Table Editor application.

Help Contents Lists all of the available help topics.

About Displays the CSS500 version number and other information.
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The tables in this appendix explain the various types of messages you may

encounter when using CSS500. In the following tables, the term XX represents

information that is dependent on the situation. In practice, XX is replaced by an

instrument name, filename, or number, as appropriate.

Error Messages

Error messages tell you when CSS500 was unable to complete a task as required.

These messages can occur because of equipment malfunctions, corrupted files, or

missing information that must be supplied before CSS500 can continue.

Table B-1: Error messages

Error

Number Error Message Explanation

E61 No GPIBO Board Found GPIB is not installed or the name of the GPIB board is not “GPIBO”.

E62 GPIB is not System Control GPIB card is not configured for System Controller.

E63 GPIB Write Error A device on the GPIB has prevented data transfer. Check all instruments.

E64 GPIB Read Error A device on the GPIB has prevented data transfer. Check all instruments.

E65 No Listener on Bus No GPIB devices are connected to the controller or they are all turned off.

E66 GPIB Timeout, device not responding Device too slow in responding to command. Instrument may need to be

initialized.

E67 GPIB DOS Error GPIB.DLL not found or incorrect version.

E68 GPIB General Failure Problem with GPIB driver. Refer to National Instrument’s GPIB manual for

troubleshooting and possible reinstallation.

E103 RS-232 Write Error Unable to write to the RS-232 device. Check Cable and device RS-232

settings.

E104 RS-232 Read Error Unable to read from the RS-232 device. Check Cable and device RS-232

settings.

E105 RS-232 Timeout, device not responding RS-232 device not responding in sufficient time. Device may need to be

reinitialized.

E106 RS-232 port not available for this RS-232 is in use by another application. Close down all other applications

application. that use RS-232.

E220 Cannot communicate with XX. Cannot communicate with specified instrument. Check that the settings in

the Connections dialog match match the instrument. Check that the cabling

is correct.

E221 Unknown 2714/2715 firmware version. The firmware version of the 2714 or 2715 is not recognized by the CSS500

software and therefore the current operation cannot proceed. Obtain the

correct firmware version.
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Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E222 Cannot allocate memory for 2714 /2715 System running low on memory. Try closing other applications.

stored results

E223 Stored results in 2714/2715 are corrupt The results file(s) in the 2714/2715 are corrupt. The results could not be

retrieved. You may need to delete all stored results from the 2714/2715.

E224 Existing 2714/2715 stored results partially | Some, not all, existing 2714/2715 stored results were successfully loaded

loaded from the instrument. Usually indicates corrupt stored results. Remove the

stored results from the 2714/2715.

E225 Cannot load existing 2714/2715 stored None of the stored results currently found in the 2714/2715 could be loaded.

results Usually indicates corrupt stored results. Remove the stored results from the

2714/2715.

E226 The selected channel cannot be set in the | 2714/2715 failed to tune to the channel requested. Channel Table may be

2714/2715 incorrect.

E227 The selected channel cannot be set in the | TDC-10 failed to tune to the channel requested. Channel Table may be
TDC-10 incorrect.

E228 The selected channel table cannot be set | Problem occurred in loading a Channel Table to the 2714/2715. Verify
in the 2714/2715 Channel Table with the Channel Table Editor (CTLOADE) application. Either

the channel table is invalid, or there is no available slot in the instrument.

E229 The selected channel table cannot be set | Problem occurred in loading a Channel Table to the TDC-10. Verify Channel

in the TDC-10 Table with the Channel Table Editor (CTLOADE) application.

E230 You must manually delete duplicate UDP | There already is a UDP with that name loaded into the 2714/2715. If you
title: °XX’ first and then retry really want to use that name delete the old name first.

E231 The UDP menu is full. You must manually | The 2714/2715 only has room for 9 UDPs. Delete one or more before trying
delete a UDP from the 2714/2715 first to load the UDP again.

and then retry.

E232 Reserved

E233 UDP is too large to load, aborting There is a limit on the number of measurements that can be in a UDP.
operation Delete some of the measurements and try to reload.

E234 UDP may be too large to execute in the Delete the UDP from the 2714/2715, remove some of the measurements
2714/2715 from the Measurement Sequence, then reload the UDP.

E235 Gated setup option not available with Gated Carrier to Noise and CSO measurements can only be made on the

2714. Use Auto instead? 2715. Enter Yes to run in Auto mode instead.

E236 Gated setup option not available with Gated In Channel Response measurements can only be made on the 2715.

2714. Turn gated off? Enter Yes to run without Gated mode.

E237 Reserved
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Appendix B: Error, Warning, and Informational Messages

Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E239 The following problems were found in the

Measurement Sequence:

The Gated setup option is not supported | When creating a 2714 UDP, one or more Carrier to Noise, CSO, or In

by 2714s. C/N, CSO and ICR willbe run | Channel Response measurements specified Gated measurement setups.

in the non-gated mode Since this is not supported by the 2714, the setup was changed to run

without the gated option.

Digital measurements are not supported _| One or more Average Power, Desired to Undesired, or Adjacent Channel

by the attached 2714/2715. All digital Leakage measurements were requested. These digital tests are not

tests (Avg Pwr, D/U and ACL) will be supported by 2714s and are not supported by 2715s with Firmware Version

skipped 09.30.94 or earlier. The UDP may still be generated, but the digital

measurements will be skipped.

Only RF measurements are supported by

the 2714s and 2715s. All non-RF

measurements (FCC Baseband, S/N,

Wfm Dist, Multiburst, ICPM, and Audio)

will be skipped

See the Create 2714/2715 UDP help

topic for additional details

E240 Reserved

E241 Reserved

E242 Unknown response received from 271X The content of the query response was not what was expected. Try the

operation again.

E300 Error initializing CSS500. The file has become corrupted. Try reloading the application from the

master disk.

E301 271X_SW or CSS500 already running. Only one copy of the 271X_SW or CSS500 software can be run ata time.

Either use the software that is already open, or exit it before continuing.

E302 Error creating window. Running low on memory. Try closing other applications.

E303 Memory allocation error, operation Running low on memory. Try closing other applications.

canceled.

E304 Instrument connections could not be Check the instrument's connections and the cabling. Make sure that the

initialized. address is correct.

E305 Error opening file: XX. The file is corrupt or not in the proper format. File cannot be found.

E306 Error closing file: XX The file as been corrupted or the computer is out of memory space.

E307 Error writing file: XX Possibly out of disk Free some disk space and then try again.

space.

E308 Corrupted data in file: XX. The file is not in the correct format.

" £309 End of file encountered in file: XX. The file has been corrupted.

CSS500 Cable Television System Software User Manual B-3



Appendix B: Error, Warning, and Informational Messages

Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E310 XX file XX is not valid The file is corrupt or the wrong file type. File is found but it is the wrong file

type.

E311 One or more Limits files not found or The limits files requested in the current worksheet either are not in the

invalid correct directory, in the correct format, or don’t exist. Limits files must be in

the Limits sub-directory of the executable file.

E312 Error writing CSS500.INI file Out of memory or the application is corrupted.

E313 Error writing WIN.INI file File has been corrupted.

E314 Invalid number The text box is expecting either a number or a letter and received the other.

Retry with valid data.

E315 Number out of range. Enter a number Enter a valid number.

between XX and YY

E316 CSO offset fell within CTB range of +/- Change the CSO offset so that it is outside of the CTB range or change the

XX MHz CTB range.

E317 Site cannot be blank Blank is not a valid Site name. Enter one or select <undefined>.

E318 Test ID cannot be blank Blank is not a valid test ID. Enter one or select <undefined>.

E319 UDP title cannot contain commas or Change the UDP title in the text box to remove the invalid characters.

semicolons, and cannot be blank

E320 Undefined measurement ID The measurement ID does not exist.

E321 Creation and loading of UDP ’XX’ failed The UDP could not load. Check the 2714/2715 for adequate UDP (NVRAM)
space.

E322 Maximum number of measurements A Worksheet will only hold 16,000 measurements. Any measurements

stored in Worksheet, operation canceled _| previously made have been loaded. Create a new Worksheet or delete

some measurements before continuing.

E323 Maximum amount of clipboard datahas —_| Try using the Export command instead of the Copy command to move data

been exceeded into other applications, or select smaller blocks of data to copy.

E324 An error occurred while copying data to The clipboard data is invalid. Try again.

the clipboard

E325 An error occurred while clearing measure- | The measurements could not be cleared.

ment for row XX column XX

E326 Select a cell, entire column, or entire row | The Results Detail display needs to know what information you want.

E327 No Limits file selected Select a Limits file from the combination box, before choosing Select Limits
File.

E328 Select at least one measurement and The View Filter will not allow a blank data display. Pick at least one

channel for viewing measurement and one channel from the selections.

E329 No stored results selected Select one of the stored results directory entries from the 271X to export.

E330 Error initializing help Files are corrupted.

E331 Only 1 help window may be open at a Close the open help window before trying to open another one. The Help

time window may be under another window.
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Appendix B: Error, Warning, and Informational Messages

Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E332 Help topic not found The Help file has been lost. Make sure that there is a help sub-directory in

the CSS500 executable directory. Check to see if there are any *.hlp files in

that sub-directory.

E333 Video driver XX not active The Video driver must be running before Picture, from the View menu, can

activate. Make sure that your Video driver is one that is supported by this

application. Make sure that the Video driver title from the Switch To window

for the Video driver is the same name as is in the CSS500.INI file.

E334 Channel Table Editor not found The Channel Table Editor application (CTLOADE) is not in the CSS500

executable directory.

E335 Error printing report An error occurred printing a report. Ensure that print options were

appropriately selected and the printer is correctly connected to the PC.

E336 Channel Table file XX not found or is The Channel Table requested either cannot be found or is corrupt. Request
invalid another Channel Table and try again.

E337 Default Channel Table file ‘XX’ is not The default Channel Table either cannot be found or is corrupt. Request
found or is invalid another Channel Table and try again.

E338 No Audio Limits file selected Select an Audio Limits filename for the combination box before selecting

Select Audio Limits.

E339 Cannot communicate with VM700A. When attempting to request a list of audio files from the VM700A, the
Audio Limits files not updated. instrument could not be found.

E340 Limits relationship violated: XX >= YY Caution and Alarm lower and upper limits must adhere to the relationship:

Alarm lower limit < Caution lower limit < Caution upper limit < Alarm upper

limit.

E341 Select one or more check boxes Select at least one check box to indicate which item(s) should be used.

E1000 Error opening file: XX’ The file is corrupt or not in the proper format.

E1001 Memory allocation error, operation Running low on memory. Try closing other applications.
canceled

E1011 Number out of range. Enter a number Enter a number between the stated limits.
between XX and YY

E1012 Error writing file: XX Possibly out of disk _| The stated file could not be written.

space

E1013 XX file XX is not valid The stated file is corrupt or of the wrong type.

E1014 Error initializing help Help files are corrupted.

E1015 Only 1 help window may be open at a Close the open Help window before trying to open another one. The Help
time window may be under another window.

E1016 Help topic not found The Help file has been lost. Make sure that there is a help sub-directory in

the CSS500 executable directory. Check to see if there are any *.hlp files in

that sub-directory.

E1017 Error creating window Running low on memory. Try closing other applications.

E1018 Error writing CTLOADE.INI file Out of memory or the application is corrupted.

E1019 Error writing WIN.INI file File has been corrupted.
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Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E1020 CTLOADE already running Only one copy of CTLOADE can be run at a time. Use the copy that is

already open.

E1023 Error printing spreadsheet An error occurred printing a report. Ensure that print options were selected

appropriately, and that the printer is properly connected to the PC.

E1024 Invalid channel table name The channel table filename specified is not valid.

E1025 Attempted write to read-only file The Channel Table file is write protected. Select a different save file name.

E1026 Table Info was incomplete in the selected | A Channel Table file must have table information for at least one channel.

file The file may be corrupt.

E1027 Selected file has too many channels — The Channel Table file has more channels than the application can handle.
truncated All possible channels were loaded.

E1028 Error initializing CTLOADE One or more executable files have become corrupted. Try reloading the
application from the master disk.

E1029 Select at least one item or press CAN- This dialog requires a selection.

CEL

E1030 Selected table name is too long or A Channel Table being read into the application from an instrument has a
contains incompatible characters name which cannot be converted into a DOS-compatible file name.

E1031 No channel tables found in instrument For Transfer:Delete operation, there are no Channel Tables in the specified
instrument which can be deleted. For Transfer:From operation, there are no

Channel Tables in the instrument of any type.

E1032 GPIB is non-functional or not installed GPIB was selected for communicating with the selected instrument, but is
not installed for Windows.

E1033 Cannot expand table further (500 The application cannot handle more channels.

Channels Max)

E1034 No filename has been defined — Save CTLOADE cannot send a Channel Table to an instrument until a filename
file first has been defined (since this is where the table name is derived from). Save

the Channel Table to a file first, then transfer to an instrument.

E1035 Channel Table ’XX’ contains one or more__| When opening the Channel Table file, one or more fields were found to not
invalid fields. Use Limit Check to verify. meet the limits or data type requirements. Use Limit Check to find out which

field(s) were invalid.

E1040 Channel Table File Read Error: XX The Channel Table is corrupt at the specified line and column.

E1041 Directory read error in XX Could not read the Channel Table directory in the specified instrument.

E1042 Attempted write to read-only table in XX —_| The specified Channel Table cannot be overwritten. Select a new file name,
from which the instrument Channel Table name is derived.

E1043 All channel table slots used in XX. Delete | Cannot send a table to the specified instrument, since all Channel Table
a table first slots are used.

E1045 Channel Table name too long for XX (YY__ | The Channel Table name is too long for the specified instrument. Select a

characters max) shorter file name and retry.

E1046 Incompatible video standard for XX The Video Standard for the stated channel is incompatible with the stated
instrument.
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Appendix B: Error, Warning, and Informational Messages

Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E1047 Incompatible channel width for XX. Enter | The Channel Width for the stated channel is incompatible with the stated

a number between XX and YY instrument.

E1048 Incompatible aural offset for XX. Entera | The Aural Offset for the stated channel is incompatible with the stated

number between XX and YY instrument.

E1049 Incompatible channel number for XX. The Channel Number for the stated channel is incompatible with the stated

(record YY) Enter anumber between XX _| instrument.

and YY

E1050 Incompatible visual frequency for XX. The Visual Carrier Frequency for the stated channel is incompatible with the

(record YY) Enter a number between XX __| stated instrument.

and YY

E1051 Incompatible lower channel edge for XX. | The lower channel edge for the stated channel is incompatible with the

(record YY) Enter a number between XX __| stated instrument. The lower channel edge is calculated by adding the

and YY Channel Edge parameter with the Visual Carrier Frequency parameter.

E1052 Incompatible channel type for XX. (record | The Channel Type for the stated channel is incompatible with the stated

YY) instrument.

E1053 Incompatible test pulse offset frequency —_| The test pulse offset frequency for the stated channel is incompatible with

for XX. (record YY) Enter a number the stated instrument.

between XX and YY

E1054 Incompatible channel-specific aural offset | The Aural Offset for the stated channel is incompatible with the stated

for XX. (record YY) instrument.

E1055 Channel Edge out of range for XX. The channel edge for the stated channel is incompatible with the stated

(record YY) Enter a number between XX __| instrument.

and YY

E1056 Incompatible channel tag for XX. (record _| The tag for the stated channel is incompatible with the stated instrument.
YY) For a 2721A, every channel must have a tag and must consist of characters

‘A’ through ‘Z’ and ‘0’ through ‘9’ only.

E1057 Incompatible second aural offset for XX. | An invalid value was detected for the second aural offset. Enter a valid

(record YY) Enter a number between XX __| selection.

and YY

E1058 Incompatible C/N bandwidth for XX. The C/N bandwidth for the stated channel is incompatible with the stated

(record YY) Enter a number between XX __| instrument.

and YY

E1059 Incompatible amplitude offset for XX. The amplitude offset for the stated channel is incompatible with the stated

(record YY) Enter a number between XX _| instrument.

and YY

E1060 Channels must be in frequency order for _| All channels for the stated instrument must be listed in order of ascending

XX. (record YY) visual carrier frequency. The stated channel (at least) is out of order.

E1061 Too many channels in XX, table XX The Channel Table in the specified instrument contains more channels than

the application can handle.

E1062 Too many channels in file XX The Channel Table file has more channels than the application can handle.

E1063 Too many channels for XX The specified instrument cannot store all of the channels in the current

Channel Table.
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Table B-1: Error messages (Cont.)

Error

Number Error Message Explanation

E1064 Incomplete channel table information The application read all of the Channel Table information possible, but was
not able to read all channels.

E1065 Channel Table XX is unavailable. Select it | The read-only channel tables in the 2714/2715 are not readable via RS-232

inthe YY and try again or GPIB unless they are selected first. Select the table via the 2714/2715
menu system and try again.

E1066 Transfer was incomplete — Unknown The channel table was transmitted to the instrument, but was not found in

Error the instrument when checked at a later time.

E1067 Invalid GPIB Address for XX Check the Connections information for the instrument in the Transfer:
Connections menu selection.

E1068 Channel Table is in use in instrument XX __| Select a different table in the instrument before attempting to delete or

and cannot be deleted or overwritten overwrite the table.

E1069 Channel Table name is incompatible with | Some of the characters in the Channel Table name are inappropriate for the

XX stated instrument. For a 2721A, only characters A-Z, 0-9, and underscore
are allowed.

E1070 Channel Tables in the XX are incompat- All channel tables in the stated instrument are incompatible with the current

ible with this version version of CTLOADE.

E1071 Channel Table XX already exists. Delete | When attempting to transfer a channel table to an instrument, a channel

it first table with the same name was found. Delete it from the instrument first.

E1072 Cannot overwrite an XX NVRAM Fixed When attempting to transfer a channel table to an instrument, a fixed

table channel table of the same name was found. Enter a different name to
transfer the table to the instrument.

E1073 Incompatible second aural offset for XX. For the 2714/2715, the second aural offset must be a number within the

(record YY) acceptable range.

E1074 Incompatible quiet line with XX. (record Enter a number within range.

YY) Enter a number between XX and YY

E1075 Incompatible white line with XX. (record Enter a number within range.

YY) Enter a number between XX and YY

E1076 Incompatible ICR test line with XX. Enter a number within range.

(record YY) Enter a number between XX

and YY

E1077 More than 200 Include in Transfer Only 200 channels in the channel table can be marked include in transfer

channels entered for file ‘XX’ since this is a limitation of all the instruments which support channel tables.
500 are allowed as long as 300 are marked not include in transfer. These

would be used to specify control strings to switchers.

E1078 Duplicate channel numbers are not Assign unique channel numbers to each channel.

allowed for XX. (There are duplicate

channel number YY’s.)

E1080 Multiple channel widths are incompatible | 2714 and 2715 instruments with firmware versions 09.29.94 and earlier will

with THIS 2714/2715 (1st difference at not accept multiple channel widths. Use the Copy Field to End command to

record nnn) make all widths the same.
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Appendix B: Error, Warning, and Informational Messages

Warning Messages

Warning messages tell you when CSS500 needs additional information from you

before it can continue or that, if you continue, there may be a loss of information

or settings because of the action being taken.

Table B-2: Warning Messages

Warning

Number Warning Message Explanation

W350 Worksheet has changed. Do you wish to | Save your changes or they will be deleted.

save it?

W351 Limits have changed. Do you wish to Save the changes or they will be deleted and the Limits file will revert to its

save them? previous values.

W352 Attempt to save the Worksheet and exit Memory is getting full. Save what you can and exit CSS500. Then attempt

the application to restart the application.

W353 Selected items will be copied to all Whatever was previously in those channels will be overwritten.

channels. Proceed?

W354 Import site: XX does not match worksheet | All of the data being imported will be given the current worksheet Site if the

site: XX Continue importing results? import continues.

W355 Should worksheet site: XX be changed to | You can change the worksheet Site name to match the import site name. If

import site: YY ? you do, any data previously in the worksheet will be associated with the new

Site name.

W356 Import channel table: XX does not match | The results will be loaded into any channel numbers that match. Data

worksheet channel table: YY Continue without a channel match in the worksheet is ignored.

importing results?

W357 Do you want to turn the Sequence view The Sequence View Filter will allow you to see only the results of the

filter on? Measurement Sequence and not the entire spreadsheet.

W358 Do you want to turn measurement history | Older data will be overwritten if the Measurement History collection is not

collection on? turned on.

W359 If you have edited your worksheet The Channel Table was edited and has changed (although the name has not

Channel Table, changes will not take changed); you should put the edited Channel Table in a new Worksheet.

effect until you create a new worksheet

W360 No channels found which match the This would occur if the Channel Table included all analog channels and you

specified Carrier Level Difference selected the Digital Channels Only from the Parameters dialog box. It

Parameters affects the Max, Min, and Max-Min values which would be displayed as

blanks.

W361 No channels found which match the This would occur if either no adjacent channels fell within the specified

specified Adjacent Channel Difference adjacent channel window, or if there weren't two channels within the range

Parameters which were of the specified channel type. The results will be displayed as
blanks.

W362 If you edit your worksheet channel table, | When making most changes to the worksheet channel table, it is necessary

changes will not take effect until you

create a new worksheet

to create a new worksheet to have those changes take effect.
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Table B-2: Warning Messages (Cont.)

Warning

Number Warning Message Explanation

W363 Carrier levels have been selected on all

channels. Run Survey instead?

Your measurement selection includes carrier levels on all channels. You can

run a Survey substantially faster. Possible drawbacks are that all results

have the same date/time stamp and the spreadsheet is not updated until the

survey completes. Select Yes to run the Survey, or No to run individual

carrier level measurements on each channel.

W1100 Channel Table changed. Do you wish to __| Answer YES, if the current Channel Table is to be saved to a file.

save it?

W1101 Multiple channel widths are incompatible | The channel table contains more than one channel width. 2714 and 2715

with some 2714/2715 (first difference at

record nnn)

instruments with firmware versions 09.29.94 or earlier will not accept a

channel table with multiple channel widths. (See error 1080 on page B-8.)

Informational Messages

Informational messages tell you when something has changed; for example,

when a file import has been completed.

Table B-3: Informational Messages

Message Explanation

Instrument connections have been changed. The connection information of the equipment has been changed in the Channel

Table Editor.

Import complete. XX results imported. The data has been loaded into the worksheet.

Import complete. XX results imported.

Note: Some results were not imported due to

Channel Header Mismatch.

This message appears at the end of an import. It only appears if there were

mismatches in the Channel Table Header (channel number, frequency, tag, or

program). For most of these cases, mismatches are flagged during the import

process and you are allowed to overwrite any mismatches. The exception is

channel number. If the channel number does not match, then it is simply

skipped and you are not flagged except for this message.

There are no measurements for the selected view. The View Filter must have some valid measurements and channels before it is

allowed to be enabled.

There are no more measurements for the selected

view. Removing View Filter.

After clearing the selected cells, the View Filter is no longer valid. It will revert

back to normal view.

A tunable channel cannot be determined from

current selection.

More than one channel has been selected. Select one cell, then try again.

No stored results were retrieved from the 2714/2715. No results files or they were empty.

Only a sequence may be executed when the

sequence view filter is active.

No other measurement can be made.

A sequence has not been defined. You cannot run a Measurement Sequence. Use Measurement Sequence, from

the Configure menu, to create a Measurement Sequence.
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Table B-3: Informational Messages (Cont.)

Message Explanation

Some of the imported results may not be displayed

due to an active view filter.

You may have imported more data than is displayed. Turn the View Filter off to

display all of the data.

Default Limits file XX not found or invalid. Create a new Limits default file by choosing the Save As Default Limits

command button, from the Edit Limits File dialog box

Limit check passed for all specified instruments. All parameters in the Channel Table were within limits for all selected

instruments.

No remote Channel Table delete on a 2721A. See

2721A/2722A manual for delete instructions.
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The purpose of Channel Table Editor is to create and edit Channel Tables, not

only for CSS500 but also for CSS150 and other instruments. You create Channel

Tables in the Channel Table Editor and then load them into the test equipment

for automated testing and measurement gathering. Although CSS500 can call the

Channel Table Editor, it is also a standalone application.

What’s in this appendix:

m Starting the Channel Table Editor

=# Creating anew Channel Table

mTM Editing an existing Channel Table

= Loading a Channel Table into the test equipment

= Notes on usage

= Channel Tables provided with CSS500

= Overview of the Channel Table Editor commands
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Appendix C: Channel Table Editor

Starting the Channel Table Editor

To start the Channel Table Editor, select Channel Table Editor from the Execute

menu or Create/Edit Channel Table from the Worksheet Info dialog box of the

Configure menu. The Create/Edit Channel Table command button calls the

Channel Table Editor. (It can be called independently from the Program

Manager, using CTLOADE.EXE.)

NOTE. When starting from the Worksheet Info dialog box, it is not good practice

to type a name into the combo box on the Worksheet Info dialog box before going

into the Channel Table Editor. Select a name from the list provided. You can

change Channel Tables once you’ve entered the Channel Table Editor. Always

include the “.cht” filename extension.

The results (with the standard Channel Table std.cht loaded) are in Figure C-—1.
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Figure C-1: The main window of the Channel Table Editor
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Appendix C: Channel Table Editor

Creating a New Channel Table

Use the following procedure to create a new channel table which is not based on

an existing channel table.

Clear the Channel Table — From the File menu, choose New. This clears the Channel Information and loads

the default values into the Table Information.

Edit the Table Information 1. Choose the Edit Table Information command button from the Button Bar.

This displays the Edit Table Information dialog box as shown in Figure C—2.

Edit lable Information

Table Name: [

Number of Channels:

Video Standard

| @NISC © PAL

, TBC-10

Aural Offset: MHz

Figure C-2: The Edit Table Information dialog box

2. Enter a name for the new Channel Table in the Table Name text box. (For

this example, use “test].cht.”)

3. Enter the number of channels.

4. Edit the Aural Offset and Channel Width text boxes with the appropriate

values for your system.

5. Select the correct Video Standard option button, either NTSC or PAL.

6. If you plan to use the Channel Table with a TDC-10, select the TDC-10

Aural Offset from the drop-down list box.

7. Choose the OK command button to save the changes and exit the Edit Table

Information dialog box.
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EditaChannel 1. Start with the first channel as shown in Figure C-3.

“7.250000 CATY 145

250000 CATV [#INTSC [elas [& 0.00 None [#

1.250000 caTV « [#INTSC [elas fe 0.00 None

{NTSC 5

Figure C-3: The test1.cht Channel Table before beginning the edits

2. Enter the Number, Visual Frequency, Tag, and Program text boxes.

3. Fill in the rest of the data by selecting the cell and either selecting from the

drop-down list box or entering data in the text box. (See page C—29 for more

details on the various Channel Table fields.)

NOTE. If you are using the keyboard, use ALT +\ to open the field’s drop-down

list boxes.

4. Choose the OK command button to save the changes. The application

window now looks similar to Figure C4.

se OR NE ie 2SODOG 1.280000 CATV EI 14 0.00 None |
6.000 1.250000 CATV 5 [€} 0.00 None |

6.000 1.250000 CATV FRINTSC [#145 [$} 0.00 None |

Figure C-4: The Channel Table Editor with one channel’s data entered
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Appendix C: Channel Table Editor

Creating a Channel Table from an Existing Channel Table

In the previous section you learned how to edit a Channel Table. While you can

create a channel table from scratch, it would take a long time to do so, editing

one channel at a time. It is much easier to take an existing Channel Table and

edit it to conform to your needs.

Editing an Existing 1. From the File menu, choose Open. The dialog box shown in Figure C—5

Channel Table appears.

CTLOADE Warning Wf1101

Figure C-5: Warning that you have made changes and not saved them

2. Choose the No button (you don’t need to save the practice work). Next, the

Open dialog box appears. See Figure C-6.

File Name: Directories:

std.cht | c:\css500

eur_il.cht ck
hre.cht

irc.cht E> css500
japan-m.cht help
japan_m.cht limits

stdofst.cht

stndrd_cht

Figure C-6: The Open dialog box

3. Select “std.cht” from the File Name list box. This Channel Table comes with

the CSS500 application.
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File Edit View Transfer

4, Choose the OK command button. The Channel Table will load and will

appear similar to Figure C—7.

Channel Table Editor - [std.cht]

~55,250000°2

3 61250000:
4 ee 87,250000.

5 7.250000

& - 83.250000
95 AS 91.250000.

36 Ag 97. 250000

a7 a3 102.250000

98 a2 103,250000

“1.250000 CATV

6.000 -1.250000 CAT¥

6.000 1.250000 CATY

6.000 -1. 250000 CaTY

6.000 © -1.250000 CATV

6.000 -1.250000 CATY

6.000 = -1.250000 CATY

6.000 = -1. 250000 CATV

Bs ee

#INTSC
SANTSC

SINTSC

((ei45 G.00 None [&INo |& 407

B45 | 0.00 None RINo [Fz 40

S145 [& 0.00 None [#jNo |* 4.0

#145 ls 6.00 None [¥INo [& 4.0

#145 0.00 None [No (8! 40

B45 jas 0.00 None REINO {[* 4.0

S45 [ee 0.00 None RINo | 4.0

$145 0.00 None [¥iNo [¥ 4.0

a5 [ee 3 400.00 None [#]No

Riser ee

Figure C-7: The std.cht Channel Table (with all fields shown)

5. From the File menu, choose Save As. The dialog box looks similar to

Figure C-8.
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Appendix C: Channel Table Editor

File Name:

flearners. cht _|

Save As

Directories:

c:4css500

suri chet

euge bap ahd

eit ich

ues 2) anbel

hic. cht

Hoch

japan cht

paaaeey ae ache

ck

fs css500

&y help

(£9 limits

OC] Read Only

Drives:

c: tektronix

Figure C-8: The Save As dialog box

6. Enter “learners” in the File Name text box.

NOTE. The Channel Table Editor automatically adds the “.cht” filename

extension.

7. Choose the OK command button to save the changes and leave the Save As

dialog box. Changes are made in your learners.cht and not the std.cht file.

8. Select the first channel and make any changes that might be required for

your system.

9. Repeat these steps for all channels in your system.

10. If any fields are the same for all channels, choose the Copy Fields command

button from the Button Bar. Figure C-9 shows the resulting dialog box.
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Selected Fields

Copy Fields to End

2714/2715 Channel Type: CATY

RFM150 Channel Type: NTSC

Available Fields

Visual or Center Freq: 55.250000

Channel Width: 6.000

Scramble: No Channel Edge: -1.250000

2714/2715 Channel Type: CATY

RFM150 Channel Type: NTSC

Aural Offset: 4.5

2714/2715 2nd Aural Carer. 0.00

RFM150 2nd Aural Offset: None

Scramble: No

C/N Bandwidth: 4.0

Amplitude Offset: 0.0

Dwell Time: Short

Use White: No

White Line: 0t——____— = =
Figure C-9: The Copy Fields to End dialog box

11. Select all of the fields you want to be the same as the channel that you are

editing.

12. Choose the OK command button to copy these fields to all channels below it

in the Channel Table.

13. If there are any channels that are not in your system, select the channel (by

clicking on the REC # cell) and choose the Delete command button to

remove them.

14. From the File menu, choose Save to save the edited Channel Table.
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Appendix C: Channel Table Editor

Loading a Channel Table into the Test Equipment

Cautions

Matching Channel Tables

in the CSS500, Test

Equipment, and the

Now that you have created a custom Channel Table for your system, you must

load it into the test equipment.

1. From the Transfer menu, choose To. The dialog box shown in Figure C-10

appears.

Figure C-10: The To dialog box

2. Select the option button of the instrument that you want to download the

Channel Table to. The example selects the 2714/2715.

3. Choose the OK command button to download the Channel Table.

4. Repeat these steps for the other instruments so that all of the equipment has

the same Channel Table.

These are the basics that you need to use the Channel Table Editor application

with the CSS500 application.

When creating or using a channel table, follow these cautions to ensure that the

software functions properly.

The Channel Table used by the software must match the Channel Table in the

equipment. Also, the Channel Tables used by the software and the equipment

must match the cable system connected to the equipment. If any of the three do

Cable System -t match, measurements you take will be incorrect, errors will be returned, or

the software will behave unpredictably.

The 2714 will not run digital measurements, but uses the same channel table

format as the 2715. If the software attempts to take a measurement on digital

channels using the 2714, measurements returned will be incorrect, errors will be

returned, or the software will behave unpredictably.
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Channel Table Names

C-10

For the CSS500 measurements to execute properly, the corresponding Channel

Tables in both the TDC-10 and the 271X must be identical to the Channel Table

specified in the CSS500 Worksheet Header. (If they are selected as the demodu-

lator.) If the CSS500 software finds that the Channel Table in the TDC-10 or the

271X does not match, by NAME, the channel table that the CSS500 is using, the

CSS500 loads the Channel Table it is using into the TDC-10 and 271X.

This scheme allows you to easily switch to different named Channel Tables as

follows:

1. Choose Worksheet Info, from the Configure menu.

2. Inthe Channel Table group, select a new table from the combo box.

3. Choose the OK command button to end the worksheet Info dialog. At this

point a new worksheet is created. A message appears, allowing you to save

the old worksheet.

4. When a measurement executes on this new worksheet, CSS500 will

automatically select the new Channel Table in both the TDC-10 and the

271X. If the named Channel Table does not exist in either piece of equip-

ment, the Channel Table loads into the instrument(s) before making the

measurement.

CSS500 detects Channel Table mismatches by comparing the Channel Table

name only. It does not compare the contents of the Channel Tables. Therefore,

use caution when editing named Channel Tables. For instance, assume the

current worksheet is using a Channel Table named MYSYSTEM.CHT and that

this Table exists in both the TDC-10 and the 271X. Now suppose the Channel

Table is edited, using the Channel Table Editor to add channel 78, and then saved

under the same name, MYSYSTEM.CHT. Upon returning to the CSS500

worksheet, notice that the new channel is not present in the spreadsheet. Also

notice that the new channel will not be present in the MYSYSTEM tables in

either the TDC-10 or the 271 X. So that even if a new worksheet is created,

which includes the edited Channel Table, the new channel will still not be

accessible in the instruments for the measurements. This is because the CSS500

compares Channel Table names and not contents.

Use the following guidelines for editing existing Channel Tables:

If an existing Channel Table is edited in any way, it is easiest to save it under a

different name. Then create a new worksheet to use this Channel Table.

If an existing Channel Table must be edited and saved to the same name, perform

the following steps:

1. Start with the Channel Table as the current one in the worksheet. (Its name is

in the Worksheet Header.)
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Out of Bounds Limits

Independent Operation

Channel Table Names

2. Choose Worksheet Info, from the Configure menu. The current Channel

Table is already selected in the Channel Table Group combo box.

3. Choose the Create/Edit Channel Table command button to start the Channel

Table Editor.

4. The Current Table is in the editing buffer of the Channel Table Editor. Edit

the Table as required and then save the Channel Table, using the same name.

5. IfaChannel Table using the same name currently exists in the instrument,

delete it.

6. Use To, from the Transfer menu, to transfer the edited Channel Table to both

the TDC-10 and the 271X.

7. Exit the Channel Table Editor and return to the CSS500 Worksheet Info

dialog box.

8. Choose the Cancel button to return to the CSS500 worksheet.

9. Choose New, from the file menu, to create a new worksheet to use the

“edited” Channel Table.

The Channel Table fields have limits. If these limits are exceeded you will be

able to open the Channel Table but will be given a warning that there is a

problem with the file. Use the Limits Check, from the Transfer menu, to find the

problems and correct them.

The Channel Table Editor is an application that can be used independently of the

CSS500. However, do not perform any Channel Table Loader operations while

measurements are taking place using CSS500. Do not change or load a Channel

Table while an instrument is using the table.

If you enter the Channel Table Editor from CSS500 via the Create/Edit Channel

Table command button and you make a new Channel Table, the Channel Table

list is not immediately updated in the Worksheet Info dialog box when you

return to CSS500. You must close the dialog box and open it again before the

new Channel Table appears in the list.

CSS500 will not make changes to the Channel Table unless you create a new

worksheet. This prevents you from corrupting data on the current worksheet.
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T-Channels

Downloading Channel

Tables to a TDC-10 via

RS-232

TV1350, EMFP, and

Channel Tables

The 271X’s standard contains T-Channels (channels below 50 MHz) but

CSS500’s std.cht does not contain T-Channels. (The TDC-10 cannot handle

T-Channels, so CSS500’s std.cht does not have them.) Due to the way CSS500

compares Channel Tables, even if T-Channel measurements are made with the

271X they cannot be loaded into CSS500. (The std.cht would not recognize the

channels and skip over the data in them.) If you want to make measurements

using the T-Channels, you need to define a new Channel Table, load it into the

271X, and make the measurements using it.

The following are the TDC-10 settings that must be used when downloading

Channel Tables from a PC to a TDC-10 via the TDC-10’s RS-232 port.

Status OnLine

Baud Rate (Same as selected in the Connections dialog box.

See page C—26)

Parity None

Flow Control Hard

Output Term. CR/LF or LF

Echo Mode Off

Use a NULL-modem cable between the PC and the TDC-10. Check your PC and

TDC-10 manuals to make sure that the cabling is compatible.

You cannot download Channel Tables into the TV1350 or the EMFP. When the

instrument needs a channel frequency it looks it up and then uses the “Tune to

Channel” command to tune the demodulator to the required frequency. Any

changes made to a Channel Table are immediately reflected in the measurements

made with the TV1350 or EMFP.

Channel Tables Provided

C-12

Channel Tables provided with CSS500 are read-only, since they represent

Channel Tables pre-loaded in the equipment (271X, TDC-10, and 2721A). This

prevents you from throwing off the alignment between a worksheet Channel

Table and an instrument Channel Table. The only exception is STDOFST.CHT,

which is not associated with any instrument. If you must edit a Channel Table,

you should rename it, being careful not to use a name from the list below.

Table C-1 is a list of the standard Channel Tables provided with the Channel

Table Editor.
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Appendix C: Channel Table Editor

Table C-1: Channel Tables provided with CSS500

From What Channel Table

Instrument Name Contents/Function

TDC-10 B’CAST.CHT North America VHF/UHF Broadcast channels

CATV-STD.CHT United States CATV standard channels (no

T-Channels)

CATV-HRC.CHT United States CATV HRC (Harmonically Related

carriers) channels

CATV-IRC.CHT United States CATV IRC (Increment-Related Carriers)

channels

EUR-BG.CHT European system B/G UHF/VHF and CATV

EUR-|.CHT European system | UHF

JAPAN-M.CHT Japan system M UHF/UHF

CHINA-DK.CHT China system D/K UHF/VHF

2714/2715 STD.CHT! United States CATV standard channels (no

T-Channels, frequency limited to channel 94)

HRC.CHT United States CATV HRC (Harmonically Related

Carriers) channels

IRC.CHT United States CATV IRC (Increment-Related Carriers)

channels

2721A STNDRD.CHT United States CATV standard channels (no

T-Channels, frequency limited to channel 94)

JAPAN_M.CHT Japan system M UHF/UHF

EUR_BG.CHT European system B/G UHF/VHF and CATV

EUR_I.CHT European system | UHF

EUR_I1.CHT European system | UHF

CHIN_DK.CHT China system D/K UHF/VHF

none SDTOFST.CHT United States CATV standard channels with common

frequency offsets applied

1 Note that the T-channels are not included in this Channel Table but they are included
in the Channel Table with the same name in the 271X. This is because the TDC-10

cannot make measurements on the T-Channels. If you want to make measurements

on the T-Channel using CSS500, you need to make a new Channel Table that

includes the T-Channels and make the measurements using that Channel Table.
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Overview

C-14

Control Box

This section goes through each of the menu commands and gives a brief

description of what they are and how they work.

Restore

Move

Size

Minimize

Maximize

Close Alt+F4

Switch To... CtrltEsc

Figure C-11: The Control Box menu

Restore. The Restore command returns the Channel Table Editor application

window to its previous size and position. It is often used to change an icon back

into a window. It will also change the window between two different sizes and

positions. It performs the same functions as the Restore command button (small

box with both up and down arrows) on the upper right hand corner of the

worksheet.

Move. Move allows different placements of the Channel Table Editor window.

This is equivalent to clicking on the Title Bar and holding down the left mouse

button to reposition the display. The Move command is only allowed if the

application window is not at its maximum size.

To use Move with the keyboard:

1. Choose Move. (Press ALT+spacebar, then type m.)

2. Press the arrow keys until the window is in the desired position.

3. Press ESC to stop moving the window.

Size. Size allows you to change the size of the application window.

Minimize. The Minimize command changes the application to an icon. The

application is still running but it is no longer the active window. Channel Table

Editor stays in exactly the same operating state as when it was converted to an

icon. This performs the same function as the Minimize button (small box with
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the down arrow) on the upper right hand corner of the worksheet. (See Fig-

ure 3—1 on page 3-3.)

Maximize. The Maximize command changes the application from an icon back to

the active window. This also changes a sized window into one that fills the entire

display area. Maximize performs the same function as the Maximize command

button (small box with an up arrow) on the upper right corner of the worksheet.

Exit. Closes the Channel Table Editor application window.

Switch To. The Switch To command changes from one running application to

another.

Menu Bar = The Menu Bar of the Channel Table Editor (see Figure C—12) provides access to

all of the Channel Table Editor’s functions.

File Edit View Transfer Help

Figure C-12: The Menu Bar

File. The File menu (see Figure C—13) contains the basic Windows file manipula-

tion commands, described in the following paragraphs.

New

Open...

Save

Save As...

Print...

Print Setup...

Exit

Figure C-13: The File menu

= New. New empties the Channel Table and gives you a blank Channel Table.

New prompts for save if the current Channel Table has been modified.

= Open. Open loads a previously existing Channel Table. A dialog box

prompts for a file. See Figure C-14.
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japan_m.cht ner

learners.cht €) limits
std.cht

stdofst.cht

stndrd.cht

Drives:

| dc: tektronix

Figure C-14: The Open dialog box

m Save. Save the changes made to the Channel Table to the file specified in the

main Window caption. If the Channel Table has no name, it will prompt you

for one.

m= Save As. Save As saves a Channel Table under a new name. See Fig-

ure C-15.

Save As

File Name: Directories:

F-che | c:\css500

SF tS chit : feS c:4

b‘castecht css500

cate-hic.cht —

caty-Ho.cht jnep
caty-std cht limits
chr: dk cht

ohine-wk. cht

sur-iey cht

CL] Read Only

Drives:

| a c: tektronix

Figure C-15: The Save As dialog box

= Print. Prints out the current Channel Table. See the Windows manual for

more information on this dialog box. See Figure C—16.
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Appendix C: Channel Table Editor

[ Print Range

farhee tie

Print Quality: |High Copies: [i]

C] Print to File _] Collate Copies

Figure C-16: The Print dialog box

m= Print Setup. The Print Setup dialog box allows you to configure the printer

as required. See Figure C-17. This is the same dialog box accessed through

the Setup command button in the Print dialog box.

Print Setup

. Printer

© Default Printer

(currently PostScript (QMS) on tolpd@byv58s1 @servers (LPT1:))

[PostScript (QMS) on tolpd@bv58s1 @servers (LPT1:)

[ Orientation ———_ | | Paper

® Portrait Size: _|Letter 8 1/2 x 11 in

Al ©) Landscape Source: [Upper Tray

Figure C-17: The Print Setup dialog box

m= Exit. Closes the Channel Table Editor application. Prompts for confirmation

if the current Channel Table has been modified.

Edit. The Edit menu (see Figure C—18) contains the commands used to modify

the Channel Table. They are: Insert, Delete, Append, Copy Fields to End, Edit

Table Info, and Sort.
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Selected Fields

Insert Ins

Delete Del

Append

Copy Fields to End...

Edit Table Info...

Sort >

Figure C-18: The Edit menu

Insert. The same as Insert from the Button Bar. Insert places a blank row into

the Channel Table (only the default values are filled in). The channel is

placed just before the selected (active) channel.

Delete. Removes the selected channel from the Channel Table. Same as

Delete from the Button Bar. This command is only available when a channel

has been selected.

Append. Functions the same as Insert, except it adds the new channel to the

end of the Channel Table.

Copy Fields to End. This command allows you to copy the selected channel

fields to all of the channels below the selected one in the Channel Table. See

Figure C—19. Use this command to quickly make “universal” changes. This

dialog box does take the View Fields into account. If a field is not in view,

then it is not listed in the Available Fields list box.

Available Fields

2714/2715 Channel Type: CATY

RFM150 Channel Type: NTSC

Scramble: No

Yisual or Center Freq: 55.250000

Channel Width: 6.000

Channel Edge: -1.250000

2714/2715 Channel Type: CATV

RFH150 Channel Type: NTSC

Aural Offset: 4.5

271472715 2nd Aural Canier. 0.00

RFM150 2nd Aural Offset: None

Scramble: No

C/N Bandwidth: 4.0

Amplitude Offset: 0.0

Dwell Time: Short

Use White: No

White Line: 0

Figure C-19: The Copy Fields to End dialog box
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= Edit Table Info. Edit Table Info opens the Edit Table Information dialog box

filled with the information that is standard throughout the Channel Table.

See Figure C—20.

Edit Table Information

Table Name: [|

Humber of Channels:

2714/2715

Aural Offset: |4.500000 KHz

ie Standard

@ NTSC © PAL

Figure C-20: The Edit Table Information dialog box

Table Name. The name of the Channel Table.

Number of Channels. The number of channels in the Channel Table. If you

edit this number to increase the number of channels, blank channels are

added to the end of the Channel Table. The maximum number of channels

available is 500. If you decrease the number of channels, the channels are

deleted beginning with the last channel in the Channel Table and working

backward.

NOTE. The maximum number of channels that the instruments can handle is 200.

Therefore, you can have 200 channels marked for Include in Transfer (see

page C-31) and 300 more just for switcher information.

Aural Offset. The nominal difference between the visual and aural carriers.

The 271X uses this parameter.

Channel Width. The width of the frequency allocation for a single channel.

Video Standard. Either NTSC or PAL.

TDC-10 Aural Offset. The nominal difference between the visual and aural

carriers. The TDC-10 uses this number.

CSS500 Cable Television System Software User Manual C-19



Appendix C: Channel Table Editor

C-20

m= Sort. You can sort the channel table three ways:

By Channel Number. Sorts the entire Channel Table using the channel

number as the sort key.

By Frequency. Sorts the entire Channel Table by frequency.

By Program. Sorts the entire Channel Table by program.

View. This menu allows you to set the Channel Table Editor to display only the

fields that are of current interest.

= Channel Table Fields. This dialog box allows you to view only the Channel

Table Fields that are of interest to you and hide the fields that are not

relevant. Figure C—21 shows the dialog box and Table C—2 lists the fields

available under each choice. You can mix and match fields to match your

requirements. If no fields are selected, then only the fields that are always

displayed are shown.

View Channel Table Fields

View 2714/2715 Fields:

J View 2721A Fields

EJ View RFM150 Fields

>] View Control Port Fields

Figure C-21: The View Channel Table Fields dialog box

CSS500 Cable Television System Software User Manual @®eoeoeoeooeoeoeoeoeeeeetg@esegeoe@esd see



Appendix C: Channel Table Editor

Table C-2: The Channel Table fields available from each group

2714/ Control

2715 TDC-10 |2721A | RFM150 | Port none

Channel Number X X X x X X

Visual Frequency X X X X Xx X

Tag X X Xx X X X

Program X X x X “4 x

Channel Edge X Xx

RFM150 Channel Type x

Aural Offset Xx X

RFM150 Second Aural X

Offset

2714/2715 Second Aural | x

Offset

Scramble X Xx

RFM150 Carrier/Noise x

Bandwidth

Amplitude Offset Xx

Dwell Time X

2714/2715 Channel Type | x

Use White Xx

White Line X

Use Quiet X

Quiet Line X

Use ICR X

ICR Test Line X

Video Polarity X

Sync Polarity Xx

Test Pulse Offset X

Offset Frequency X

Include in Transfer X

Switcher Control String X

Transfer. The Transfer menu loads the Channel Table into the test equipment and

can also extract or delete Channel Tables from the instruments. The commands

in the Transfer menu are shown in Figure C—22.
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Transfer

To...

From...

Delete...

Select...

Limit Check...

Switcher Control String

Connections...

Figure C-22: The Transfer menu

@ To. Takes the current Channel Table and loads it into the selected test

instrument. See Figure C—23.

Figure C-23: The To dialog box

NOTE. If the Channel Table is currently in use by the instrument, this command

will be refused.

= From. Extracts an existing Channel Table from a piece of test equipment and

puts it in a format the Channel Table editor can use. It prompts for confirma-

tion if the current Channel Table has been modified, but not saved to a file,

since it will be overwritten during this operation. See Figure C—24.
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© TDC-10

© 2721A

© RFM150

Figure C-24: The From dialog box

After an instrument has been selected, the dialog box shown in Figure C—25

appears. It lists all of the Channel Tables currently in the instrument. Select

which Channel Table you want copied from the instrument, then OK. The

Channel Table is then copied from the instrument to the Channel Table

Editor window.

From (Select Table)

Figure C—25: The From (Select Table) dialog box

= Delete. Deletes a Channel Table from an instrument. See Figure C—26.

Delete

Figure C-26: The Delete dialog box
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C-24

Once an instrument is selected, then the dialog box shown in Figure C—27

appears. Notice this list is different than the one in Figure C—26 for the From

command. The From command list all of the Channel Tables, while the

Delete command only lists user-created Channel Tables. This prevents

accidentally erasing built-in Channel Tables.

NOTE. If the Channel Table is currently in use by the instrument, this command

will be refused.

Figure C-27: The Delete (Select Table) dialog box

NOTE. The 2721A will not delete a Channel Table except from its front panel.

= Select. This command allows you to make a specific Channel Table in an

instrument active. First you select the instrument from the Select dialog box.

Then you are given a list of the current Channel Tables in that instrument.

You select the desired Channel Table from that list.

Select

Figure C-28: The Select dialog box
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To update a channel table that is in use:

1.

2.

3.

4.

Select a channel table other than the one in use.

Delete the channel table you intend to update from the instrument (not

from the computer).

Send the updated channel table to the instrument.

Select the updated channel table in the instrument.

= Limit Check. Limit Check checks all of the Channel Table data for compati-

bility with one or more instruments. If any problems are found with the

Channel Table data, a message box is displayed, describing the first problem

found. See Figure C—29, Figure C-30 and Figure C-31.

LC] 27214

L] RFM150

Figure C-29: The Limit Check dialog box

%

CTLOADE Warning W1101

Multiple channel widths are incompatible with

SOME 2714/2715s [1st difference at record 2}.

Figure C-30: The Message box warning that multiple channel widths are

incompatible with some 2714 and 2715 instruments
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CTLOADE Message

Figure C-31: Limit Check passed message

Switcher Control String. The Switcher Control String command allows you

to test the command string entered in the Switcher Control String field for

the selected channels. When you select this command it runs the command

in the Switcher Control String field. You can then check your switcher’s

control panel to make sure that the appropriate switches took place.

Please see the description of the Switcher Control Field on page C—31 for

more information on controlling a switcher.

Connections. Use the Connections dialog box (shown in Figure C—32) to set

the GPIB and RS-232 port addresses for the instruments in the Channel

Table Editor. These addresses are for loading and retrieving Channel Tables

in the test equipment’s NVRAM and for controlling the switcher. If the

switcher settings were correct in the CSS500 application they will not need

to be edited here. (Any changes in this dialog box affect both applications.).

the addresses set in the instruments. The ports and addresses must be unique for

i. CAUTION. Make sure that all ports and GPIB addresses are unique and match

both the Cable TV Software and the Channel Table Editor, because the connec-

tions menus interact. If the ports and addresses are not unique, the software will

not work correctly.
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Appendix C: Channel Table Editor

Connections

- 2714/2715 Spectrum Analyzer

PIE Address:

@'RS-232' Baud Rate: | 4800

- TDC-10 Downconverter

© §Pin OPH Address:

@ RS-232 Baud Rate: |9600

| 2721A Sweeper

COM Port:

Stop Bits:

Figure C-32: The Connections dialog box

Help. The Help menu contains access for on-line help.

Contents. Contents displays information about Channel Table Editor,

including a description of the main window.

About. Displays the version number and copyright information. See

Figure C—33.
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Button Bar

Open

Save

Insert

Delete

Copy Fields

Edit Table

Info

View Fields

Opens an existing Channel Table. Same as Open from the File menu. (See

page C-15.)

Updates the Channel Table information. Same as Save from the File menu. (See

page C-16.)

The same as Insert from the Edit menu. (See page C—18.)

The same as Delete from the Edit menu. (See page C—18.)

The same as Copy Fields to End from the Edit menu. (See page C18.)

This is the information that is the same for every channel of a Channel Table: the

Aural Offset, Channel Width, and the Color System. For example, you cannot

have both NTSC and PAL channels in one Channel Table. This command button

is the same as double-clicking on the Table Information list box or choosing Edit

Table Info, from the Edit menu. (See page C—19.)

Same as Channel Table Fields from the View menu. (See page C—20).
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Channel Table Fields

Chan #. The commonly known number of this channel.

Program. A 6-character identifier for the channel, used for the channel’s call

letters or abbreviated name.

Tag. A 3-character designation for the channel, such as “AAA” or “2 B”. This is

used by the 2721A. It must be uppercase alphanumeric (0-9 and A-Z, space is

OK as long as there are additional valid characters).

Visual or Center Freq. The visual carrier frequency in MHz.

Channel Width. The width of the channel. In 2714 or 2715 instruments with

firmware version 09.29.94 or earlier, only one channel width can be specified

and it applies to all channels. To unambiguously determine a channel width

when sending to one of these instruments, all channel widths must be the same.

You can use the Copy Field to End command to make all channel widths the

same.

Channel Edge. The frequency difference between the visual or center frequency

and the lower bound of the frequency allocation. For example, for analog

channel 2 in the USA, the Visual or Center Freq is set to 55.25 MHz, the

Channel Edge is set to —1.25 MHz, and the Channel Width is set to 6.0 MHz.

For digital channels, the Channel Edge should be one-half of the Channel Width.

For example, a digital channel centered between 57 and 60 MHz should have the

following values in the channel table: Visual or Center Freq set to 58.5 MHz,

Channel Width set to 3 MHz, and Channel Edge set to —1.5 MHz.

2714/2715 Channel Type. The type of signals transmitted on this channel: CATV,

FM, Pilot, or Digital. This field is just for the 2714/2715.

RFM150 Channel Type. The type of signals transmitted on this channel: NTSC,

PAL, SECAM, or Digital. This field is just for the RFM-150.

Aural Offset. The nominal difference between the visual and aural carriers. This is

a single channel aural offset.

2714/2715 Second Aural. The offset between the visual carrier and the second

aural carriers. This value must be at least 200 kHz above the first aural carrier
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C-30

and below the channel edge. Only used by the 2715 and firmware version

1.12.94 and later of the 2714.

RFM150 Second Aural Offset. The nominal difference between the visual and aural

carriers. This is the second channel aural offset. Only used by the RFM-150.

Scramble. Whether or not this channel is scrambled.

RFM150 CN BW. The RFM150 Carrier-to-Noise bandwidth. This is the bandwidth

used to compute the Carrier to Noise calculations. Only used by the RFM-150.

Amplitude Offset. The offset applied to the Visual Carrier Level readings on this

channel.

Dwell Time. The amount of time that should be spent gathering data. Video format

determines the dwell time.

Use White. Selects whether the white line or the whole field should be used in the

amplitude measurements.

White Line. The location of the white line.

Use Quiet. Selects whether the quiet line or the whole field should be used in the

Carrier to Noise and CSO measurements. If Use Quiet Line is NO, then the

instrument will auto search for unmodulated lines on which to make Carrier to

Noise and CSO measurements. If Use Quiet Line is YES, then the instrument

will use the line number supplied in the Quiet Line field (below). (2715 only.)

Quiet Line. The quiet line in the video signal used for making the Carrier to Noise

and CSO measurements. It must be between 4 and 1023 (4 is the lower limit for

PAL and 7 is the lower limit for NTSC). (2715 only.)

Use ICR. The ICR measurement should be made using the specified test line. If

Use ICR is NO, then this measurement is skipped. If you attempt to make a

measurement on a channel with Use ICR set to NO, the instrument will try to

execute the measurement, but color the results cell blue to indicate that there was

a problem with the measurement. (2715 only.)

ICR Test Line. The location of the ICR test line in the video signal. This line

number is placed in the Notes field for the measurement results. The test line can

be either multiburst or Philips ghost canceling signal. You can change the ICR
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Appendix C: Channel Table Editor

Test Line from the 2715’s front panel and the value will be stored in the

instrument’s Channel Table. (2715 only.)

Video Polarity. Polarity of the video signal.

Sync Polarity. Polarity of the sync pulse.

Test Pulse Offset. The frequency offset applied to the test pulses from the 2721A

in MHz. (Used by the 2721A only.)

Offset Frequency. Indicates whether the indicated visual carrier frequency is at,

above, or below the nominal visual carrier level.

Include in Xfer. Include in Transfer. If this field is marked yes, then the channel

information is transferred to the RF instrument during a Channel Table load. All

measurements are available. If this field is marked no, then this channel is not

loaded in the RF instrument and the RF measurements are not available from the

CSS500. These cells are grayed out as shown in Figure C—34. (Channel 2 was

not included in transfer. Notice the number of grayed cells.)

No View Filter is On

Figure C-34: The Global View from the CSS500 application

Switcher Control String. This string is used to control a connected switcher, with a

maximum of 110 characters. If there are any commands in this string, they are

executed prior to CSS500 making any measurements. CSS500 supports Pesa and

Grass Valley Group switchers (and others). Both switchers require slightly

different control strings.

The key to the switcher string is that a backslash and the next two numbers are

always the ASCII character values in hex. For example: \02 is control B
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(important for the GVG switcher), \27 is Escape (important for the Pesa), and \13

is Return or Enter. All characters can be entered as ASCII strings if desired.

Another important code is \FF. This is the Pause Delimiter. Whenever this code

is encountered the switcher pauses for the amount of time set in the Connections

dialog box (see page C—26).

GVG Switcher Control. For a GVG switcher, a typical command string

looks like:

\020094

\02 is control B, telling the switcher to switch. It must be this value.

00 is the address of the switcher. It is always 2 bytes.

9 is the video switch. It is always one byte.

4 is the audio switch. It is always one byte.

Pesa Switcher Control. When sending controls to a Pesa, remember that you

are emulating a terminal and that you are working blind. Because the Pesa

switcher uses a hierarchical menu scheme, the typical Pesa string is more

complex. For a Pesa switcher, the typical string looks like:

\27N\27N\27N\27N\27N\27N\27N\27N\27N\27N\27N\27 YA 3B\ 1 33\1 34\13

\27N is Escape and No. The long string of \27N is to guarantee that you are

at the top of the menu hierarchy before you begin to give commands. When

writing your own strings, you should use at least 15 of these to avoid

problems.

\27Y tells the switcher that you are ready to start.

NOTE. Although it is not shown here, a user name and password could be

entered here because you are at the initial login screen. This is not always

necessary; it depends on how your particular switcher is set up.

C-32

\13 is an ASCII return.

B is the command for switch.

\13 is an ASCII return to accept the switch command.

3 tells the switch the destination line, this case it is line 3. (This could be any

number.)

\13 accepts the destination line
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4 tells the switcher the source line; in this case it is line 4. (This could be any

number.)

\13 accepts the line and the switch is complete.
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NOTE. The methods given in this chapter are just suggestions. It is the operator’s

responsibility to comply with FCC requirements.

This chapter discusses how to perform FCC Headend and Field measurements.

Most of the information is not applicable outside of the Unites States. Use it as a

starting point to help you define your own procedures to meet FCC Measurement

requirements. This chapter assumes you are familiar with the following concepts:

= Configuring Worksheets

m Defining Measurement Sequences

mTM Generating 2714/2715 UDPs

@ Getting 2714/2715 Stored Results

= Importing/Exporting Measurement Results

@ Viewing Results

= Using the Clipboard

Organizing Worksheets and Measurement Results

The FCC testing requirements result in large numbers of measurement results,

even for modest systems. Organizing these results in a reasonable way allows for

quick access to the results for verification, analysis, and reporting. The directory

structure shown in Figure D-1 is a good example of how to organize FCC

performance test results. The remainder of this chapter describes how to create

this structure, fill it with test results, and access the results for verification,

analysis, and reporting.

For example, create the directory structure shown in Figure D-1, using the

Windows File Manager. You can place this directory tree anywhere, but not in

your LIMITS directory for CSS500. It is good practice not to put anything in the

Limits directory except Limits files.
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3.

HEADEND.WRK

HEADEND

HEADEND.WSR

Figure D-1: Organization of files for logical record keeping

D-2

FCCTESTS is a directory that contains all of the FCC type measurement

results.

Group each test session by the month and year performed. A test session is

defined as all the FCC required twice-yearly performance tests for a

particular system.

JULY95 is a sub-directory of the FCCTESTS directory that contains all of

the measurement results for July of 1995.

Group the performance tests by those required at the Headend (output of

modulating or processing equipment) and those required at the field test sites

(for example, subscribers’ terminals).

HEADEND is a sub-directory of JULY95 that contains the results of the

Headend measurements for that month. (Notice that there are no files above

this level — only directories.)

FIELD is a sub-directory of JULY95 that contains all of the field measure-

ments made that month. (Again, notice that there are no files above this level

— only directories.)

HEADEND.WRK is the worksheet used to define, control, and collect

results for this Headend test session.

HEADEND.WSR contains the actual results from this Headend test session.

CSSS500 Cable Television System Software User Manual

©®eeeoeee?eeée
@©®eoeeee?ee@ ®e
eeeece



@9eeqoeoeeeeqe@eged?e@ee se
Appendix D: FCC Measurements

7. FIELD.WRK is the worksheet used to define, control, and collect results for

this field test session.

8. The rest of the files are the actual measurement results from the TP132 and

TP146 test Sites (Test IDs) collected during this session.

FCC Headend Measurements

Configure a New

Worksheet

Define the Measurement

Sequence

The FCC Headend measurement requirements consist of a series of RF and

baseband measurements taken on a set of channels at the Headend.

The following describes how to use a Measurement Sequence to perform all the

required Headend measurements and how to collect and present the measurement

results.

Configure a new worksheet to match the system and testing methods.

1. Choose New, from the File menu.

m= Set the Channel Table and Site name to match the system. For example,

use STD.CHT for Channel Table and Headend name for Site.

2. Set up the worksheet items listed below from the Configure menu:

m= Test ID — Set to a test session identifier or operator name such as

“Headend Test 7-16-1995”.

m= Preferences — Measurement History is not required for this example, so

set it to Keep Last Result Only.

= Measurement Limits

= Measurement Setups

Define the Measurement Sequence used to execute the required measurements.

1. Choose Measurement Sequence from the Configure menu.

2. Define the measurements by choosing the FCC Headend Msmts command

button. This provides a method to easily select the required measurements.

Carrier Levels and Frequencies are automatically selected for all channels.

3. Select specific test channels for the FCC Baseband measurements (which

includes chroma-luma delay, chroma-luma gain, differential gain, and

differential phase) using the Select command button. These are the system-

specific test channels chosen to comply with the FCC regulations on number

of test channels based on system frequency limit.
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Summarize the

Measurement Sequence

Results

a a
10.

s

A a > &

Select the OK button when the selected test channel list is correct. The

Measurement Sequence dialog box displays the selected FCC Headend

measurements.

Define the Measurement Sequence execution time parameters by choosing

the Edit Time Parameters command button.

Set it up to run immediately, | time.

Select OK to return to the Measurement Sequence dialog.

Select OK to return to the worksheet.

Execute the Measurement Sequence using the Exec Seq command button on

the Button Bar, or Measurement Sequence, from the Measure menu.

The Measurement Sequence executes the FCC Headend measurements.

When the sequence is complete, answer Yes to turn on the Measurement

Sequence View filter. The worksheet displays only the results from the

Measurement Sequence just completed (that is, the FCC Headend perfor-

mance tests).

Choose Global View, from the View menu, to look for measurement cautions

and/or alarms.

Display a Status Report by selecting all of the cells in the Global View and

choose the Results Detail command button.

If you wish, print the report using the Print button.

Choose Close to leave the Status Report.

Choose Close to leave the Global View.

Choose Export, from the File menu, to save the measurement results to a

results file for archiving and importing to other report tools.

a. In the directory list box select: FCCTESTS/JULY95/HEADEND.

b. In the File Name, enter HEADEND.WSR.

c. Choose OK to export the results.

Optionally, use Select All and then Copy, from the Edit menu, to copy the

results to the Clipboard for transfer to other tools, (for example, MS-Excel,

or MS-Word). Once the results are exported or copied, use other data

analysis tools (such as MS Excel) to generate complete FCC Proof Reports.
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Save the Worksheet Use Save As, from the File menu, to save the worksheet for future reference.

1. Choose Save As from the File menu.

2. In the directory list box, select FCCTESTS/JULY95/HEADEND.

3. In the File Name box, enter HEADEND.WRK.

4 Select OK to save the worksheet.

FCC Field Measurements

The FCC field measurement requirements consist of a series of, primarily, RF

measurements taken on a channel set at various points in the system. Since the

2714/2715 Spectrum Analyzer can make all of the required measurements, the

following describes how to define and use 2714/2715 User Defined Programs

(UDPs from Measurement Sequences) to perform the field measurements and

how to collect and present the measurement results.

FCC field testing uses three separate UDPs: one for the pre-converter perfor-

mance tests, one for the post-converter performance tests, and one for the visual

carrier 24-hour variation and 30M Carrier Level Performance Test.

NOTE. The CMP/CSS500 package is transportable to field test sites for

collection of performance test results at RF and Baseband using a Measurement

Sequence. This is a direct extension of the procedures explained in previous

chapters and further discussion is not included.

Use the three UDPs at each of the required test Sites. Note that since the

measurement setup parameters (for example, external attenuation/amplification)

are loaded into the UDPs, these parameters are set the same for each test Site. If

each Site needs different parameters, create separate UDPs for each test Site. For

example, the external attenuation/amplification setup defines the test point loss

for the Carrier to Noise measurements. The FCC requires levels measured at the

subscriber terminals and at the end of cable drops (locations with O dB offset).

Using the UDP measurement method described, remove the 2714/2715 from the

CMP/CSS500 package and take it to the various test Sites for measurement

execution and storage of results (in the 2714/2715 NVRAM). Later, reconnect

the 2714/2715 to the CMP/CSS500 package for results collection and presenta-

tion.
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Define the FCC Field

Measurements

Post-Converter Worksheet

Define the Post-Converter

UDP

Configure a new worksheet to match the system and testing methods used for the

FCC Post-Converter measurements. Use File/New and set up the worksheet

items listed below.

1. Inthe Worksheet Info dialog box, select the Post-Converter Channel Table,

STD_PC.CHT, in the Worksheet Info dialog.

NOTE. Measurements taken at the output of the converter require a Channel

Table that retains the channel identifier (that is, channel number) but has the

visual carrier frequency for each channel set to the output visual carrier of the

converter. The procedures below assume that the STD.CHT Channel Table is the

primary table and the post-converter table exists as STD_PC.CHT (Standard

Table, Post-Converter). You must create STD_PC.CHT to fit your own needs.

Define the Site name later from the 2714/2715 front panel at each test Site.

2. Inthe Preferences dialog box, the Pause on New Channel preference can be

used to allow manual tuning of the set top converter for each new test

channel.

3. Use the Measurement Setups dialog box to specify whatever is required for

your system and test methods.

NOTE. This worksheet is only used to define the FCC Post-Converter UDP and

will not be saved (it is not necessary to save the file to create the UDP).

Therefore, it is not necessary to define measurement limits at this time.

1. Set the Test ID for the worksheet to “FCC Post-Converter” using the Test ID

button on the Button Bar or the Test ID selection from the Configure menu.

2. Choose Measurement Sequence, from the Configure menu.

3. Define the measurements by selecting the FCC Post-Converter button.

a. Carrier Levels and Frequencies are automatically selected for all

channels.

b. Select the specific test channels in the Select Channels group using the

Select command button. These are the system specific test channels

chosen to comply with the FCC regulations on number of test channels

based on system frequency limit. Select the channels that require these

additional measurements:

TM Carrier to Noise

= CTB

CSS500 Cable Television System Software User Manual @®eoeoeoeoeeo eoeoeegeeoeeen1e1sdeoede@ee ee



Appendix D: FCC Measurements

a CSO

® Cross-Modulation (coherent disturbances)

= Hum

c. Select the OK button when the selected test channel list is complete. The

Measurement Sequence dialog box displays the selected FCC Post-Con-

verter measurements.

4. Define the Measurement Sequence execution time parameters by selecting

the Edit Time Parameters command button.

a. Set to run immediately, | time.

b. Select OK to return to the Measurement Sequence dialog.

5. Create a 2714/2715 UDP from the current Worksheet and Measurement

Sequence setup using the Create 2714/2715 UDP button.

a. Enter FCC Post-Converter for the UDP title and select OK.

b. The UDP is created and loaded into the 2714/2715.

c. Verify that the selected Channel Table (STD_PC.CHT) exists in the

2714/2715. This is not done automatically at UDP generation time — it

must be explicitly done using the Channel Table Loader (see Appen-

dix C).

d. Select OK to return to the Worksheet.

Define the Pre-Converter © Use New, from the File menu, to select the STD.CHT Channel Table. This will

Worksheet __ result in a new worksheet being created (the worksheet used to define the FCC

Post-Converter UDP was only necessary for that task and does not need to be

saved). Configure the items listed below for the new worksheet to match the

system and testing methods:

1. Create a new worksheet by selecting New from the File menu.

2. Inthe Worksheet Info dialog box, select the Pre-Converter Channel Table,

STD_PC.CHT, in the Worksheet Info dialog.

3. Define the measurements from the Measurement Sequence dialog box by

selecting the FCC Pre-Converter button.

4. Set preferences as required in the Preferences dialog box. (For example,

select “Pause on New Channel” if an external preselector is used. This

allows for manual tuning of the preselector for each channel.)
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Specify the Measurement Limits. Limits are not formally part of the

generated UDP but are defined here to support importing the measurement

results.

Specify the Measurement Setups (select Edit Setups from the measurement

Setups dialog box). Verify that the required test channels have In-Channel

Response set to RF measurement method.

NOTE. Define the Site name later from the 2714/2715 front panel at each test

Site.

Define the Pre-Converter 1.

UDP

Set the Test ID for the worksheet to FCC Pre-Converter using the Test ID

button on the button bar or Test ID selection, from the Configure menu.

Select Measurement Sequence from the Configure menu.

Select the Clear Sequence command button.

Define the measurements by selecting the FCC Pre-Converter button. This

selection provides an easy method to select the required measurements:

a. Carrier Levels and Frequencies are automatically selected for all

channels.

b. The FCC Amplitude Characteristic measurement is selected for all the

test channels in the Selected Channels list box. This measurement can be

made at RF or at baseband. Hence, an Amplitude Characteristic selection

group is displayed. Since we are setting up a UDP, select In-Channel

Response. (Verify that the In-Channel Response measurement setup is

RF for each of the required test channels.)

Select the specific test channels in the Select Channels group using the

Select button. These are the system specific test channels chosen to comply

with the FCC regulations on number of test channels based on system

frequency limit.

Choose the OK button when the selected test channel list is correct. The

Measurement Sequence dialog box now displays the selected FCC Pre-Con-

verter measurements.

Define the Measurement Sequence execution time parameters by selecting

the Edit Time Parameters command button. Set to run immediately, | time.

Select OK to return to the Measurement Sequence dialog.
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9. Create a 2714/2715 UDP from the current Worksheet and Measurement

Sequence setup using the Create 2714/2715 UDP button.

a. Enter “FCC Pre-Converter” for the UDP title and select OK. This creates

the 2714/2715 UDP and loads it into the 2714/2715.

b. Verify that the selected Channel Table (STD) exists in the 2714/2715.

This is not done automatically at UDP generation time — it must be

explicitly done using the Channel Table Loader (see Appendix C).

c. Select OK to return to the Worksheet.

Define the UDP for Visual Define the Measurement Sequence for the visual carrier level and level variation

Carrier Level and Level (30M cable) measurement.

Variation (30M)

Measurements
1. Set the Test ID for the worksheet to “FCC Visual Level/Var (30M)” using

the Test ID button on the Button Bar or the Test ID item, from the Configure

menu.

Optionally, if any measurement setups or preferences need changing (based

on system test methods), enter the new parameters using Measurement

Setups and Preferences, from the Configure menu. For example, the Pause

for New Channel preference may have been selected for the pre-converter

measurements (assuming the use of an external preselector). Now, for the

visual level and level variation measurements, you are not likely to want to

pause on each new channel.

Choose Measurement Sequence, from the Configure menu.

Choose the Clear Sequence command button.

Define the measurements by choosing the 24 Hour Test command button.

This selection provides easy selection of the required measurements. (Carrier

Levels and Frequencies are selected for all channels)

Define the Measurement Sequence execution time parameters by selecting

the Edit Time Parameters command button.

Verify that Run Immediately, Run 4 Times, and Repeat Interval = 6 Hours

are selected. These parameters are set automatically when using the 24 Hour

Test button.

Select OK to return to the Measurement Sequence dialog.

Create a 2714/2715 UDP from the current Worksheet and Measurement

Sequence setup using the Create 2714/2715 UDP command button.

a. Enter “FCC Visual Level/Var (30M)” for the UDP title and select OK.

This creates the UDP and loads it into the 2714/2715.
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Execute the UDPs at Each

D-10

Test Site

b. Verify that the selected Channel Table (STD) is loaded in the 2714/2715.

This is not done automatically at UDP generation time — it must be

explicitly done using the Channel Table Loader (see Appendix C).

c. Select OK to return to the Worksheet.

10. Use Save As, from the File menu, to save the worksheet for future reference.

a. In the directory list box select FCCTESTS/JUL95/FIELD

b. In the File Name box enter FIELD.WRK.

c. Select OK to save the worksheet.

Once the UDPs are defined and loaded, the 2714/2715 can be removed from the

CMP/CSS500 package and taken independently to each test Site for measure-

ment execution and results collection. (Remember to load the correct Channel

Tables into the 2714/2715.)

The 2714/2715 has limited on-board results storage capacity. Therefore, it may

be desirable to remove all currently stored measurement results before executing

the UDP at the first test Site. See the 2714/2715 manual for more information on

its measurement storage capacity. Also, in order to provide more on-board

storage capacity, remove additional items such as stored settings and waveforms,

unused Channel Tables, etc., from the 2714/2715 NVRAM. See the 2714/2715

user manual for specifics on these operations.

1. Ateach test Site, first enter the Site name into the 2714/2715 using the

2714/2715’s front panel keys (see the 2714/2715 user manual for specifics

on this operation). This allows tagging each measurement result with the

correct measurement Site. Use these Site name tags to encapsulate measure-

ment results by individual Sites. For this example, we are collecting results

at only two test Sites (TP132 and TP146). The FCC requires a minimum of

six test Sites; for explanation purposes we are only using two. Enter Site

name “TP132” before starting any UDPs at the first Site, and “TP146” at the

second Site.

2. After entering the Site name, execute each UDP, by selecting the UDP name

in the 2714/2715 USER DEF menu. The 2714/2715 will sequence through

the measurements and store the results. (The UDP automatically stores all

measurement results in the 2714/2715 NVRAM.) Depending on the chosen

preferences and measurement setups, the 2714/2715 may present various

prompts for user action during the execution of the UDP.

3. Repeat step 2 for the second test Site. Remember to enter the new Site name

in the 2714/2715.
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Collecting and Presenting

Measurement Results

1. When finished collecting data at the test Sites, re-connect the 2714/2715 to

the CMP/CSS500 package.

Open the Worksheet used to create the FCC field test UDPs using Open,

from the File menu.

a. In the directory list box, select FCCTESTS/JUL95/FIELD.

b. In the File Name box, enter FIELD.WRK.

c. Select OK to open the worksheet. Check that the Channel Table is

STD.CHT. If it is not, select that Channel Table before continuing. Also,

for the importing of results, as described below, enable Measurement

History. Select the Collect History button in the Measurement History

group of the Preferences dialog box, from the Configure menu.

Retrieve the Stored Results Use the following procedure to retrieve stored results:

1. Retrieve the stored FCC field test results from 2714/2715 using Get Stored

Results from 2714/2715, from the Measure menu.

The CSS500 software will retrieve all measurement results from the

2714/2715 and present a directory of results grouped by Site name and

Channel Table name. The listed Sites should match the two test Sites (TP132

and TP146) and the Channel Table names should match the system (STD

and STD_PC.CHT for this example).

Use the Export button to save each group of results into separate results files,

as shown in Table D-1, for later importing into the worksheet or other

programs.

Table D-1: How the results are exported from the 2714/2715

Site Channel Table Results File

TP132 STD TP132.WSR!

TP132 STD_PC TP132_PC.WSR?

TP146 STD TP146.WSR3

TP146 STD_PC TP145_PC.WSR?

1

2

3

FCC Pre-Converter and Visual Level/Var (30M) results for TP132.

FCC Post-Converter results for TP132.

FCC Pre-Converter and Visual Level/Var (30M results for TP146.

FCC Post-Converter results fro TP146.
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D-12

Export the results groups as follows:

From the directory list box, select FCCTESTS/JUL95/FIELD.

In the File Name box, enter the Results File names as shown in

Table D—1 for each results group.

Note that the Import button can be used to load results into the work-

sheet after the results have been exported to a results file. (Import, from

the File menu, can be used the same way.)

= Worksheets always contain results for a single Site and single

Channel Table. This effectively encapsulates the results into the

particular measurements taken at a particular Site.

= Grouping of results on a per Site basis implies that results from

several Sites must be imported and summarized individually on a

Site by Site basis.

For this example, we will use the File/Import menu item to load,

analyze, and report the measurement results. Select Close to return to the

worksheet.

Now that the FCC field test results have been retrieved from the 2714/2715

and stored into results files, we have all the measurement results analysis and

summarization capabilities of the CSS500 at our disposal. First, import the

results from TP132 using File/Import.

a.

b.

Choose Import, from the File menu.

From the directory list box, select FCCTESTS/JUL95/FIELD.

In the File Name box, enter TP132.WSR.

Select OK to import the results.

m= =We want to make the worksheet Site name match the Site name of

the results we are importing. Therefore, select Yes when prompted

about changing worksheet Site to match import Site. (This prompt

will appear only if the worksheet Site does not match the Site of the

results being imported.)

@ The 2714/2715 stores only the channel number as a channel ID. The

CSS500 stores Channel Number, Letter (Tag), Program Name, and

Nominal Visual Carrier Frequency. Therefore, a channel mismatch

message is displayed. Select the “Use blank channel information as

wildcards” option button in the Import Channel Criteria group. This

will allow importing of all appropriate results without further

prompts. Select the Use Channel Results button to continue.
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e. The results from TP132.WSR are loaded into the worksheet. These are

the FCC Pre-Converter and FCC Visual Level/Var (30M) results. To

import the FCC Post-Converter results, repeat steps 4, a-d above using

File Name TP132_PC.WSR. Note that the Site name override prompts

are not presented since the Site name is the same as the results previous-

ly imported.

f. Answer Yes to the prompt about Channel Table name mismatch. We

want to import the results regardless of whether they were generated

with std.cht or std-pce.cht.

NOTE. The FCC Post-Converter results were generated using the special

post-converter Channel Table as described above. Here we are importing those

results into a worksheet that uses the normal STD Channel Table. This is

acceptable because the 2714/2715 stores only the channel number as the channel

identifier and therefore all the results are placed into the correct spreadsheet

cells without conflict. However, since the “Post-Converter” Channel Table we

used had all the visual carrier frequencies set to a single value, the counted

visual carrier frequencies for the FCC Post-Converter results will reflect that

one single channel frequency value and will not match the STD Channel Table

values. This will result in alarm status for the visual carrier frequency results for

the Post-Converter measurements. Therefore, a worksheet status report done

without any Test ID Results view filter in place will result in unwarranted alarms

for the visual carrier frequency results. The remainder of the procedure describes

how to use the Test ID Results view filter to prevent this situation.

5. At this point, all the measurement results for Site TP132 have been loaded

into the worksheet. Remember that each set of results (as generated by the

FCC Pre-Converter, FCC Post-Converter, and FCC Visual Level/Var (30M)

UDPs) has been tagged with a different Test ID. The results from each UDP

can be viewed separately using the View/Test ID Results menu item.

6. Select FCC Pre-Converter for the worksheet Test ID.

7. Use View/Test ID Results to enable the Test ID Results view filter.

8. The displayed results are now only those generated from the FCC Pre-Con-

verter UDP at test Site TP132.

9. The Global View (from the View menu) can be used to pinpoint trouble

channels. The Status Report and Results Detail screens can be used to further

analyze data. Copy, from the Edit menu, and Export, from the File menu, can

be used to transfer data or results files to other analysis tools.

10. Once the results are copied or exported, other data analysis tools (such as

MS Excel or MS Word) can be used to generate complete FCC Proof

Reports.
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11. Steps 3 through 10 can be repeated as needed for each set of results.

Results from other test Sites can be imported and analyzed using the same

procedure.
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This appendix covers the following topics:

Approximate File Sizes

Approximate file sizes

Naming conventions

Starting CSS500 with special worksheets

Adding information to the Help files

Using worksheets from older versions of the CSS500

Using CSS500 and CSS150 together

How to archive worksheets

The CSS500.INI file

Table E-1 lists the approximate file sizes of the different CSS500 files.

Table E-1: CSS500 files and their approximate sizes

File Type Contents Size (in bytes)

Worksheet (*.wrk) | One measurement for each of the 20 measurement 364 K

types for 200 channels.

Channel Table 200 channels (no Switcher Strings). 55 K

(*.cht)

Limits (*.lim) All measurements have Caution and Alarms values. 1.4K

Where appropriate, they are for Upper, Lower, or both

Limit values.

The maximum allowable worksheet size is approximately 2 MB. Note that the

amount of other information contained in the worksheet, such as measurement

notes or large worksheet descriptions, reduces the number of possible measure-

ments.
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File Naming Conventions

User Aids

E~2

Start CSS500 with a

Specific Worksheet

CSS500 has very few restrictions on its file names. However, there are defaults,

and it is good practice to use them to avoid confusion. All worksheets should

end in “.wrk” and all exported data results should end in “.wsr”. Table E-2 gives

the general conventions.

Table E-2: Types of files associated with CSS500 and

their naming conventions

Type of File Naming Conventions

Worksheet * wrk

Exported Results File * wsr

Limits File *lim

Channel Table File *cht

There are a few methods that you can use to make using CSS500 quicker and

easier for your application.

You can have CSS500 start with a worksheet already loaded. This is ideal if you

like to start each session with a new worksheet to keep the measurements

separate. The problem is that many of your channels have special Limits files

assigned to them and different Measurement Setups. You don’t want to take the

time to remember which ones they are and set them. Make a “template”

worksheet that defines all these things and then automatically load it every time

CSS500 runs.

Do this from the Windows Run line or using the icons.

First, create the template.wrk worksheet.

From Run Line:

1. Choose Run, from the File menu in the Windows Program Manager.

2. Type “CSS500.EXE template.wrk” in the text box, where “template.wrk” is

the name of the worksheet that you want to load.

From Windows Icon:

1. From the Windows Program Manager, select the CSS500 icon.

2. Choose Properties, from the File menu.
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Adding Information to the

Help Files

3. On the Command Line, after CSS500.EXE, type: “template.wrk”.

4. Choose OK.

The next time you start CSS500 from that icon, your template worksheet,

“template.wrk”, will automatically load and be ready to run. (Make sure that you

save it under a new file name right away to avoid changing template.wrk

unexpectedly.) You could define several CSS500 icons, each one with a different

template ready to go for the different uses. For example, you can have one for

getting stored results from the 271X and one for local data gathering.

The help files are completely editable using a basic text editor. (They were

created using Notebook from Windows.) The only restriction is that only 80

characters per line are allowed.

There are several reasons why you might want to edit the help files, for example:

= To put acheck list in the UDP help text to make sure that all of the

appropriate preferences are set before the UDP is generated.

= To put reminders of which channels need to have special Limits files

attached to them in the Limits file dialog box.

There are also help topics at the end of Contents in the Help menu for you to fill

in with your own information. These are the help files for the measurements.

They are there for you to note how the tests are to be performed, how often, what

time of day, and so forth—whatever you might need to put in these files. The

help topics and the files that you need to edit for each topic are listed in

Table E-3.

Table E-3: Help topics and their associated files

Help Topics File to Edit

Carrier Levels and Frequencies levfreq.hlp

CSO cso.hlp

CTB ctb.hlp

Cross Modulation crossmod.hlp

Carrier to Noise carnoise.hlp

FCC Baseband fecbase.hlp

Hum/LFD hum.hip

ICPM icpm.hip

In Channel Response icr.hlp

Modulation Depth moddepth.hlp

Multiburst multibur.hlp
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The MSMTSTUB.DLL File

Using Worksheets

Created with Older

CSS500 Versions

Using CSS500 and

CSS150 Together

E-4

Table E-3: Help topics and their associated files (Cont.)

Help Topics File to Edit

Signal to Noise signoise.hlp

Waveform distortions wimdist.hlp

Aural deviation aurdev.hlp

Audio audio.hlp

Sometimes you may want to use CSS500 for demonstrations or training without

any equipment installed. It would also be nice if some results (even if they are

meaningless) were generated. CSS500 has a “dummy” MSMT.DLL file

available that will generate somewhat random numbers for results. That file is

called MSMTSTUB.DLL. To use it, delete the current MSMT.DLL file and

make a copy of MSMTSTUB.DLL called MSMT.DLL. When you are ready to

use instruments again, delete MSMT.DLL and make a copy of

MSMTREAL.DLL called MSMT.DLL.

NOTE. You cannot make any measurements using instruments as long as

MSMTSTUB.DLL is being used as the MSMT.DLL file.

You can use worksheets created with older versions of CSS500. Once the newer

version uses them, the old version will no longer be able to recognize them.

(They are not downward compatible.)

If you want data collected from an older version of CSS500 and data collected

with the new version in the same worksheet, the safest route would be to use

Export and Import.

1. Open the old data worksheet.

Export the desired data to a .wsr file.2

3. Close the old worksheet.

4. Open the new worksheet.

5 Import the data (currently in a .wsr file).

CSS500 and CSS150 are used separately. The software must be put into separate

directories. The only thing that CSS500 and CSS150 can and should share is the

Channel Table files. If you want the two applications to share Channel Table

files, move them out of the application directories and into a separate directory.

Then the two applications can share the same files without confusion.
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How to Archive a Worksheet

Which Files to Save

There are times when you want to save a worksheet someplace other than where

you have been working with it, either for archiving purposes or to send the

results or setups to someone else.

For example: an MSO (Multiple System Operator) may want to define particular

Limits files and Measurement Sequences for the individual operators to use.

There could be one worksheet for the Pre-converter Measurements, one for the

Post-converter measurement, and another for 24 Hour Variation. These could be

the “master worksheets” so that the individual operators don’t have to waste time

creating them. Also, when the results return to the MSO, the data will drop right

into their worksheet for evaluation.

To properly archive a worksheet, you must save several files. The following is a

list of files required to properly save and then completely reconstruct a work-

sheet.

The Worksheet File. It should end in “.wrk”. It is the name in the Worksheet entry

in the Worksheet Header.

The Channel Table File. It should end in “.cht’”. Find the name in the Channel

Table entry in the Worksheet Header.

All Attached Limits Files. Find them in the sub-directory “limits” under the

directory that contains the CSS500.EXE file. You can find the needed Limits

files by scrolling through the Channel - Limits list box in the Measurement

Limits dialog box.

NOTE. When you reconstruct a worksheet from archived files, make sure that the

limit files are placed into a sub-directory called “limits” under the directory that

contains the CSS500.EXE file.

CAUTION. Make sure you don't overwrite any existing files during reconstruction.
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The WIN.INI File

The C$S500.INI File

The Cable TV Software and the Channel Table Editor place initialization settings

in the WIN.INI file under the heading of CSS500 Connections. Initialization

settings are only inserted in the file when necessary.

If the initialization settings in the WIN.INI file become corrupt for some reason,

the CSS500 Connections section of the file can be completely deleted (but not

while the application is running). The next time the software is run it will create

anew CSS500 Connections section in the WIN.INI file when necessary.

This section lists all of the lines in a typical CSS500.INI file, how they affect the

application, and where they are editable. They can always be edited at the

CSS500.INI file itself, but that is not a good practice, because it is error prone

and CSS500 provides access to most of the parameters anyway. Unless that

particular field can only be edited in the CSS500.INI file, edit them in the

CSS500 application. (An example is the Demodulator topics that can only be

edited via the CSS500.INI file.)

If the CSS500.INI file does become corrupt for some reason, it can be complete-

ly deleted (not while the application is running, though). The next time that

CSS500 is run it will create a new CSSS5O00.INI file. Some defaults may then

need to be recreated to match your preferences.

Table E-4: Contents of the CSS500.INI file

Line in CSS500.INI File Description

[CS$500] General control of the CSS500 application window

Maximized=0 0 = Main window not maximized

1 = Main window maximized

Position=172,28,797,498 The last location of the upper left and lower right corners of the main application

window in xy coordinates

[Sites] This topic lists all of the Sites. This list of Sites continues to grow as you add

more Sites in the Worksheet Info dialog box. The only way to remove Sites is to

delete them from this file.

Num Sites=2 Total number of Sites in the list

Site Index=0 Which Site is loaded whenever a new worksheet is created or CSS500 is initially

loaded

SiteO= Site names

Site1=Tektronix

[Test ID] This topic lists all of the Test IDs in your list. This list of Test IDs continues to

grow as you add more Test IDs in the Test ID dialog box. The only way to

remove Test IDs is to delete them from this file.
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Table E-4: Contents of the CSS500.INI file (Cont.)

Line in CSS500.INI File Description

Num Test IDs=4 Number of Test IDs in the list

Test ID Index=0 Which Test ID is the default. The default is loaded for all new worksheets or

when CSS500 is first started.

Test IDO=Learner’s Permit Test ID names

Test ID1=

Test ID2=Training Wheels

Test ID3=TP888

[File Defaults] Default Channel Table file and Picture driver

Channel Table File=c:\css500\std.cht This is the Channel Table file used for new worksheets. Update this with the

Worksheet Info dialog box (under the Configure Menu).

Video Driver=VIDEO KIT Used by View Picture. It can only be edited here. The Video Driver should be in

the caption displayed by the Program Manager. This is the name of the Video

Blaster board.

[Preferences] These remember the last settings from the Preference dialog box (in the

Configure menu).

Units=0 0=dBmV

1=dBV

History=1 0 = Save only most recent measurement

1 = Save History

Signal Connect=0 0 = Do not prompt for signal connection

1 = Prompt for signal connection

Pause on Channel=0 0 = Do not pause on new channel

1 = Pause on new channel

Pause on Alarm=0 0 = Do not pause on measurement alarm

1 = Pause on measurement alarm

Pause on Caution=0 0 = Do not pause on measurement caution

1 = Pause on measurement caution

Pause on Error=0 0 = Do not pause on measurement error

1 = Pause on measurement error

Execute VM700A Function on Error=0 0 = Do not execute VM700A function on measurement error

1 = Execute VM700A function on measurement error

Execute VM700A Function on Alarm=0 0 = Do not execute VM700A function on measurement alarm

1 = Execute VM700A function on measurement alarm

Execute VM700A Function on Caution=0 0 = Do not execute VM700A function on measurement caution

1 = Execute VM700A function on measurement caution

Report out RS232 on Error=0 0 = Do not report out the RS-232 port on measurement error

1 = Report out the RS-232 port on measurement error

Report out RS232 on Alarm=0 0 = Do not report out the RS-232 port on measurement alarm

1 = Report out the RS-232 port on measurement alarm
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Table E-4: Contents of the CSS500.INI file (Cont.)

Line in CSS500.INI File Description

Report out RS232 on Caution=0 0 = Do not report out the RS-232 port on measurement caution

1 = Report out the RS-232 port on measurement caution

[Measurement Limits] Edit these from the Configure menu, Measurement Limits.

Default Limits File=ntsc.lim Can update via the Save As Defaults command button in the Edit Limits dialog

box

Default Audio Limits File=System~Default The Default Audio limits file. You can only update this default value from the

CSS500.INI file.

Sys Vis Car Level Caution UL=6 Edit this in the Summary Limits in the Measurement Limit Dialog box using

Save As Defaults.

Sys Vis Car Level Alarm UL=10 Edit this in the Summary Limits in the Measurement Limit Dialog box using

Save As Defaults.

Adj Vis Car Level Caution UL=2 Edit this in the Summary Limits in the Measurement Limit Dialog box using

Save As Defaults.

Adj Vis Car Level Alarm UL=3 Edit this in the Summary Limits in the Measurement Limit Dialog box using

Save As Defaults.

[Measurement Setups] Edit these parameters using the Measurement Setups command from the

Configure menu. These values are the ones that have been stored using “Saved

As Default”.

Ext Atten Amp=0 The value in dB of the 2714 external attenuation/amplification

2714/2715 Preamp=0 0 =off

1=on

TDC-10 Preamp=0 0 =off

17=170B

27=270B

Power Line Freq=60 60 = 60 Hz

50 = 50 Hz

Carrier Levels Mode=0 0 = Accurate Frequency and Amplitude

1 = Accurate Amplitude only

2 = Fast Amplitude only

Zero Carrier Pulse Line=13 The line number where the Zero Carrier Pulse is found

Zero Carrier Pulse Field=1 The field where the Zero Carrier Pulse is found

Zero Carrier Pulse Center=3.5e-005 Location of the center of the Zero Carrier Pulse

Carrier Noise Mode=0 0 = Auto

1 = Auto with Pause

2 = Gated

Noise Bandwidth=4e+006 In Hz

CSO Mode=0 0 = Auto

1 = Auto with Pause

2 = Single Sweep

3 = Gated

CSO Loc1=-1.25e+006
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Table E-4: Contents of the CSS500.INI file (Cont.)

Line in CSS500.INI File Description

CSO Loc2=-750000

CSO Loc3=750000

CSO Loc4=1.25e+006

CSO Loc5=UNDEFINED

CTB Mode=0 0 = Auto

1 = Auto with Pause

2 = Single Sweep

CTB Loci=0

CTB Loc1 Abs/Rel=1 0 = Abs

1 = Rel

CTB Loc2=UNDEFINED

CTB Loc2 Abs/Rel=1 0 = Abs

1=Rel

CTB Loc3=UNDEFINED

CTB Loc3 Abs/Rel=1 0 = Abs

1 =Rel

CTB Loc4=UNDEFINED

CTB Loc4 Abs/Rel=1 0 =Abs

1=Rel

CTB Loc5=UNDEFINED

CTB Loc5 Abs/Rel=1 0 = Abs

1 = Rel

ICR Mode=0 0=RF

1 = baseband

ICR Gated=0 0 = not gated

1 = gated

ICR RF Loci=-500000

ICR RF Loc2=500000

ICR RF Loc3=1e+006

ICR RF Loc4=2e+006

ICR RF Loc5=3e+006

ICR RF Loc6=3.58e+006

ICR BB Loci=500000

ICR BB Loc2=1e+006

ICR BB Loc3=2.5e+006

ICR BB Loc4=3e+006

ICR BB Loc5=3.58e+006
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Table E-4: Contents of the CSS500.INI file (Cont.)

Line in CSS500.INI File Description

ICR BB Loc6=4e+006

ICR BB Loc7=4.18e+006

ACL Mode=2 0=Upper

1=Lower

2=Both

Modulation Depth Mode=0 0=RF

1 = baseband

VM700A Source=0 0 = Baseband source is Channel A or C

1 = Baseband source is Channel B

NTSC Multiburst Line=17 VITS information

NTSC Multiburst Field=1

NTSC Composite Line=18

NTSC Composite Field=1

NTSC Combination Line=17

NTSC Combination Field=2

NTSC Noise Line=12

NTSC Noise Field=1

NTSC Color Bars Line=17

NTSC Color Bars Field=2

PAL Luminance Bar Start Line=17

PAL Luminance Bar Start Center=1.2e-005

PAL Luminance Bar Width Center=1e-005

PAL Luminance Bar Reference Center=1.7e-005

PAL 2T Sine-Squared Pulse Line=17

PAL 2T Sine-Squared Pulse Center=1.2e-005

PAL 5-Riser Luminance Staircase Line=330

PAL 5-Riser Luminance Staircase Center=4e-005

PAL 5-Riser Modulated Staircase Line=330

PAL 5-Riser Modulated Staircase Center=4e-005

PAL Modulated 3 Step Line=331

PAL Quiet Line=22

PAL Multiburst Line=18

PAL Multiburst Flag Center=1.2e-005

PAL Multiburst Flag Width Center=8e-006

PAL Multiburst Packet 1 Center=1.45e-005

PAL Multiburst Packet 2 Center=2.05e-005
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Table E-4: Contents of the CSS500.INI file (Cont.)

Line in CSS500.INI File Description

PAL Multiburst Packet 3 Center=2.65e-005

PAL Multiburst Packet 4 Center=3.25e-005

PAL Multiburst Packet 5 Center=3.85e-005

PAL Multiburst Packet 6 Center=4.45e-005

PAL Sin X/X Line=16

[Demodulator]

Demod=1 0 = TDC-10/1450A

1 =TV1350

2 = EMFP

4=none

Attenuation=1 EMFP and r-s only This parameter is only for the EMFP and TV1350.

1 = Auto

0=0dB

10=10dB

20 = 20 dB

Input=75 This parameter is only for the EMFP and TV1350.

75 = 75 Ohms

50 = 50 Ohms

Level=0 This parameter is only for the EMFP and TV1350.

0 = Low (off)

1 = High (on)

Trap or SAW=0 This parameter is only for the EMFP and TV1350.

0=Trap

1=SAW

Sound=1 This parameter is only for the EMFP and TV1350.

Sound Trap (or SAW Filter)

1=on

0 =off

Zero Reference Pulse=1 This parameter is only for the EMFP and TV1350.

1=on

0 = off
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Figure F—1 is the wiring diagram for the CMP500 Cable Television Measure-

ment Package. Another way of wiring the equipment, using a TV1350, is given

in Figure F—2. Figure F—3 illustrates using an EMFP and Figure F—4 shows how

to use a switcher. CSS500 can operate with only some of the test equipment

connected, but it cannot make measurements requiring those instruments not

present. See Table F—1 for a list of equipment required to make measurements.

Table F-1: Equipment required for the measurement

Measurement RF! BB2

Carrier Levels and Frequencies X

Carrier to Noise X

CSO X

CTB Xx

Cross Modulation X

In-Channel Response? X X

Hum/LFD x

FCC Baseband X

Modulation Depth x x

Aural Deviation 4

Signal to Noise Xx

Waveform Distortion Xx

Multiburst X

ICPM Xx

Audio X

1 RF equipment includes the 2714 or 2715.

2 BB (Baseband) equipment includes: the VM700A and either the TDC-10/1450A

combination, a TV1350 Demodulator, or an EMPF.

3 If both are checked, use either RF or BB equipment to make the measurement.
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F-2

Monitor Keyboard

Printer Mouse

| |
a —N\ neu System

| ----— COM1-4 Controller
Video Display Card

| | >) Gri (Optional)***
| |
| |
| VM700A

| —N: ____/| GPIB CHANA —CHANC

| |
| |
| | Video Quadrature Video |
| | 2nd Video Out

| | 1450A RF IN

| | (50Q) | |

| | REMOTE AGCDATA IFIN RFOUT
| |

| |

| |
| | REMOTE AGCDATA RFOUT IFIN

| | IN

| | RF OUT |

| | } GPIB (50 Q)
| | : TDC-10 RF IN
ii! (750) |—] RF SPLITTER
oe | (OPTIONAL)*

a 1 Lon RF SIGNAL
| y Le GPIB* (DISTRIBUTED)

| ! ¥ REIN |_|
oe 271X (75 Q)

— — A

|. _____)_ RS-232"

*One, not both

**RF signal can be manually switched between the 271X and TDC-10

**Eor View Picture only

***COM Port only needed if 271X is RS-232

Figure F-1: Wiring diagram for CMP500
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Monitor Keyboard

Printer Mouse

|

--T- TT cota sett! —____, - Controller

! | Video Display Card
| | |) orte (Optional)

| |
| |
| | 

VM700A

| : 7 GPIB CHANG ~CHANA

I | 
L—_—__| |

| | Quadrature Video Video

| |
| | 

TV1350

| | Demodulator RF IN | _

: : ) GPIB (75 Q)

1 lot |
| | | |

| | | |
| | |
| | | Lox ‘
ee oa
| 

| 

om 

RFIN 
|_|

7.
i
j
.
 

(75 Q)

[.____,_ RS-232

*One, not both

RF SPLITTER

(OPTIONAL)*

RF SIGNAL

(DISTRIBUTED)

“RF signal can be manually switched between the 271X and TV1350

**Eor View Picture only

****COM Port only needed if 271X is RS-232

Figure F-2: Wiring diagram using the TV1350 instead of the TDC-10 and 1450A
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Monitor Keyboard

Printer Mouse

|

eee, ee —N\ COM1 Arete System| - ee - Controller

Video Display Card
: | fp GPIB (Optional)***

|

| |
| | 

VM700A

| | ), GPIB CHANC -CHANA

I | 
i_____| |

: | Quadrature Video Video

| |

| | 

RF IN L_

. | >| GPIB (50 Q)

|td | 
RF SPLITTER

o
n
 

, 

(OPTIONAL)**

q| | | Ls 
RF SIGNAL

| | —v 
RF IN |_|

Vf} 
271X 

(75 Q)

|. ____}- Rs-282"

“One, not both

“RF signal can be manually switched between the 271X and EMFP

“For View Picture only

“COM Port only needed if 271X is RS-232

“*EMIFP is only for PAL systems

Figure F-3: Using the EMFP
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Monitor Keyboard

Printer Mouse

| |

————————\] System
i COM PORT Controller

> GPIB

VM700A

| GPIB CHAN A

Video J |
Source

COM PORT

Video Switcher

Figure F—4: Using a switcher
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This section describes a method of using the CSS500 Cable TV System Software

to control a 271X analyzer remotely over modems. This section assumes you are

using the Windows Terminal program; however, you can use any equivalent

program. The Windows Terminal program is used to dial the modem and

establish communication with the remote modem and analyzer. The Terminal

program is then exited and the CSS500 Software is started. The Software doesn’t

know or care whether it is talking to the analyzer directly or if there are modems

in between. When the user is done using the Software, it is exited and the

Terminal program is restarted and used to hang up the modems.

To ensure reliable operation, you should use modems that support hardware flow

control and error correction. Some operations (for example, sending a large

channel table) send large binary files to the 271X. At baud rates of 2400 and

higher, the 271 X may not be able to keep up with the PC. If any data is lost or

corrupted, the 271 X may operate unpredictably. This is especially inconvenient if

the analyzer is at a remote location. Using hardware flow control and error

correction allows reliable performance.

The details of the setups for the PC, modems and 271X follow. The modem

commands listed are from the standard Hayes command set. If the commands for

your modems are different, use the appropriate commands to configure the

features as described below.

Terminal Program Settings

Set the Terminal communications settings as shown in Table G-1.

Table G-1: Settings for Windows Terminal

program

Communication Setting Value

Baud rate 9600

Data bits 8

Stop bits 1

Parity none

Flow control hardware

Parity check unchecked

Carrier detect unchecked

Connector com2
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A baud rate of 9600 is the fastest the 271 X can handle. The port can be set to use

whatever baud rate is available.

The CSS500 Software Connections settings must match the port and baud rate

selected in the Windows Terminal program.

Local Modem Settings

Set up the local modem with the commands shown in Table G—2.

Table G-2: Settings for local modem

Command Description

Baud rate Since the PC starts by sending “AT” commands to the modem, the modem

determines the rate of the incoming “AT” characters and communicates with

the PC at that rate. 9600 is recommended.

AT &F Start with known factory settings.

AT \N3 AutoReliable connection. Makes the fastest possible connection and uses

the best possible error correction and data compression. (Optional).

AT &K3 Enable RTS/CTS hardware flow control.

AT &Q5 Use asynchronous error correction mode.

AT &D0 Ignore on-to-off transitions of DTR. This keeps the modem from hanging up

when the Terminal program is exited and the PC drops DTR before the

CSS500 Software is started.

ATN1 Connect at the highest rate supported by both modems. (Optional).

AT &WO Write these settings in profile 0. This profile is loaded and used when the

modem is turned on.

Remote Modem Settings

Connect the remote modem to a terminal to establish these settings and store

them. Set up the modem with the following commands:

Table G-3: Settings for remote modem

Command Description

Baud rate The modem determines the rate based on the incoming “AT” commands

sent to it during configuration. The rate at which the terminal talks to the

modem during this configuration session is remembered by the modem and

is the rate at which the modem will communicate with the device at the

remote end. A baud rate of 9600 is recommended.

AT &F Start with known factory settings.
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Appendix G: Controlling a 2714/2715 Over a Modem

Table G-3: Settings for remote modem (Cont.)

Command Description

AT \N3 AutoReliable connection. Makes the fastest possible connection and uses

the best possible error correction and data compression. (Optional).

AT &K3 Enable RTS/CTS hardware flow control.

AT &Q5 Use asynchronous error correction mode.

AT N1 Connect at the highest rate supported by both modems. (Optional).

AT S0=n Sets the modem to auto-answer on the nth ring. Note that the “O” in “SO” is a

zero.

AT Q1 Disable results codes. The 271X does not understand results codes and will

generate syntax error messages if it receives them.

AT E0 Inhibit command echo. The 271X should not be sending anything to the

modem before the link is established, so this is just an added precaution.

AT &WO Write these settings in profile 0. This profile is loaded and used when the

modem is turned on.

271X Settings

Press the UTIL/4/0/2 keys to get to the RS-232 settings menu. Configure the

271X as shown in Table G4.

Table G-4: Settings for the 271X

Setting Value

0 STATUS ONLINE

1 BAUD Must match the remote modem setting

2 DATA BITS 8

3 PARITY NONE

4 EOL CRLF

5 FLOW CONTROL HARD (RTS/CTS)

6 ECHO OFF

7 VERBOSE OFF
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Accuracy

The closeness of the indicated value to the true value.

Adjacent Channel Leakage

The power in the channels adjacent to the channel under test that is due to

leakage from the channel under test.

Aural Deviation

The peak FM deviation measured for the selected channel.

Average Power

The integral of the power spectral density of all screen locations between the

edges of the channel.

Carrier Levels and Frequencies

Carrier levels is the peak amplitude with the preamp off. Carrier Frequencies

is the frequency measured against the frequency of the internal counter of the

instrument.

Carrier to Noise

The ratio of the carrier to noise amplitude with the default noise floor

normalized to 4 MHz relative to the visual carrier peak.

Cross Modulation

The peak fundamental component of 3rd order distortion at the horizontal

sync frequency (AM) measured on the unmodulated visual carrier.

CSO (Composite Second-Order)

Distortion from second-order intermodulation distortion.

CTB (Composite Third-Order or Triple Beat)

Distortion from third-order intermodulation distortion.

Desired to Undesired

The ratio of the average power of the desired signal to the average power of

undesired signals.

Hum/LFD

Hum/Low Frequency Disturbance is the power line frequency measured on

an unmodulated visual carrier and low frequency disturbance measured on

the modulated carrier.

In Channel Response

The maximum variance in amplitude within a specified frequency range

within a particular channel, given a flat input over that same range.
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Modulation Depth

The percent amplitude modulation measured from sync tip to the lowest

white level in 10 sweeps.

UDP (User Defined Program)

A measurement sequence loaded into a 271 X and run at a remote location.
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Symbols

* 3-30, 3-33

* cht, E-1, E-2

* hip, B-5

* lim, E-1, E-2

* wrk, E-1, E-2

* wsr, 2-66, 2-89, 2-90, 3-47, E-2

** 3-30, 3-33

<-Select Limits File, Measurement Limits, 3-64, 3-65

Numbers

1450A, Zero Carrier Pulse, 2-43

24 Hour Carrier Level Variation, 3-30

24 Hour Carrier Summary, 3-36

24 Hour Test, 2—31

2714

External Attenuation/Amplification, 3-72

Power Line Frequency, 3-72

Preamp, 3-72

2714/2715

External Attenuation/Amplification, 2-42

Power Line Frequency, 2-43

Preamp, 2-43

2714/2715 Channel Type, channel information, C—29

2714/2715 Screen, 3-40

2714/2715 Second Aural, channel information, C—29

2715, preamp, 2-43

271X, Aural Deviation, ‘‘Measurement Time”, 3-6

A

About, Channel Table Editor, C-27

About dialog box, 3-85

accuracy, Glossary—1

ACL Group, Edit Setups, 2-47, 3-74

Adjacent Channel Lkg, Glossary—1

Adjacent Limits, Visual Carrier Level Differences,

2-84

Adjacent Visual Carrier Level Difference, 3-69

Alarm, 2-55, 2-63, 3-39, 3-54

CSS500~ALARM_OFF, 3-54, 3-55

CSS500~ALARM_ON, 3-54, 3-55

Intercepting, 3-55

Limits, 3-64

Alarm Limits, 2-81

Amplitude Offset, Channel Information, C—30

Append, Channel Table Editor, C-18
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Audio Limits, 2-84, 3-68

Aural Carrier Offset, Limits, 3-66

Aural Deviation, Glossary—1

Aural Offset, B—7

Channel Table Information, C—29

Edit Table Info, C-19

Auto Selection, 3-57

Average Power, Glossary—1

Blue, 2—23, 3-30, 3-39

Button Bar, 3-86

Channel Table Editor, C—28

By Channel Number, Sort, C—20

By Frequency, Sort, C—20

By Program, Sort, C—20

C

C/N Bandwidth, Channel Information, C—30

Carrier Amplitude Units, Preferences, 3-54

Carrier Levels and Frequencies, Glossary—1

Carrier Levels Units, 2-54

Carrier Survey, 2-34

UDP, 3-45, 3-58

Carrier to Noise, 2-46, Glossary—1

Auto, 2-46

Auto with Pause, 2-46

Edit Setups, 3-73

Gated, 2-46

Caution, 2-63, 3-39

Limits, 3-64

Caution Limits, 2-81

Cell Color, 2-23

Chan Table, 2—5

Channel Edge, channel information, C—29

Channel Header, 3-5

Number, 3-5

Program, 3-5

Tag, 3-5

Visual Frequency, 3—5S

Channel Number, B—7

Channel Summary, 3-36

from Global View, 3-39

Channel Table, 2-49, 3-4, 3-12, B—2, B—5, B-9, B-11

Automatic Loading, C—10

Clear, C-3
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Create a New, C-3

Get 2714 Stored Results, 3-47

Get 2714/2715 Stored Results, 2—92

Loading, C-11

UDP, 3-60

Worksheet Info, 3-50

Channel Table Editor, C—1

TDC-—10 using RS—232, C-12

Channel Table Fields, View, C—20

Channel Table File, E—5

Channel Table Mismatches, C—10

Channel Table Names, C—10, C—11

Channel Tables, Provided, C—12

Channel Width, B—7

channel information, C—29

Edit Table Info, C-19

Channnel Number, Channel Information, C-29

Clear, 3-25

Clear Limits, Edit Limits File, 3-68

Clear Limits File, Measurement Limits, 3-65

Close, 3-10

Channel Table Editor, C-17

Help, 3-85

Configure, 3-49

Connections, 3-81

Channel Table Editor, C-26

Contents

Channel Table Editor, C-27

Help, 3-84

Control Menu Box, 3-9

Copy, 2—66, 3-23, B4

As Displayed, 2-68, 3-23

Compared to Export, 3-16

Export Format, 2-67, 3-23

into Excel, 2-68

Copy Fields to End, Channel Table Editor, C-8, C-18

Copy to All Channels, Edit Setups, 2-49, 3-80

Create/Edit Channel Table, 3-12, 3-51

Cross Modulation, Glossary—1

CSO, 2-47, B44, E-8, Glossary—1

2714 displaying CTB, 2-62

Distinguishing between CTB and CSO, 3-75

Edit Setups, 3-74

Get 2714 Stored Results, 3-48

Measurement Setup Restrictions, 3-75

CSS500 and CSS150, E4

CSS500.INI, 1-8, B+4, E-6

CSS500~ALARM_OFF, 2-55, 3-54, 3-55

CSS500~ALARM_ON, 2-55, 3-54, 3-55

CTB, 2-47, B44, E-9, Glossary—1

Distinguishing between CTB and CSO, 3-75

Edit Setups, 3-74

Get 2714 Stored Results, 3-48

Index-2

Measurement Setup Restrictions, 3—75

CTLOADE, B-5, C-2

Installation, 1-3

Current Selection, 2-17, 2-19, 3-45

Cursor, 3-8

Customer Support, xiii

D

delay flag, 1-8

Delete, Channel Table Editor, C-18, C—23

Demodulator, 3-83

CSS500.INI, E-11

Setup, 2-41

demodulator, 1-8

selecting, 1-8

setup, 1-10, 2-40

Demodulator Command, 3-83

Description, 3-12

Worksheet Info, 3-51

Desired to Undesired, Glossary—1

Dwell Time, Channel Information, C-30

E

Edit, 3-23

Channel Table Editor, C-17

Edit Channel Info, Channel Table Editor, C—28

Edit Limits File, Measurement Limits, 3-65

Edit Setups, Measurement Setups, 3-72

Edit Table Info, Channel Table Editor, C-3, C-19,

C-28

Edit Time Parameters

Measurement Sequence, 3-59

UDP, 2-86

EMFP, 1-5, 2-39

Channel Tables, 2-51, C-12

Selecting, 2-39

Error, 3-30

Get 2714 Stored Results, 3-48

Import, 3-15

Error Messages, B—1

Excel, 2-67, 2-69

Copying into, 2-68

Excel Limitations, 3-25

Exit, 3-22

Channel Table Editor, C-15

Expand Columns, 2-37, 3-17

printing, 3-17

Export, 2-71, 3-16, B4

Export Format, Copy, 3-23
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Export Results

Get 2714 Stored Results, 3-47

Get 2714/2715 Stored Results, 2-90

External Attenuation/Amplification, 2714 Measure-

ment Setups, 3—72

F

FCC 24 Hour Measurements, 3—57

FCC Field Measurements, D—5

Collecting and Presenting Measurement Results,

D-11

Defining, D-6

Execute UDPs, D-10

Post—Converter UDP, D-6

Pre—Converter UDP, D-8

Pre—Converter Worksheet, D—7

Visual Carrier Level & Level Variation (30M) UDPs,

D-9

FCC Headend Measurements, 2—31, 3-57, D-3

Summary, D-4

FCC Post—Converter, 2—31, 3-57

FCC Pre—Converter, 2-31, 3-57

File, 3-11

Channel Table Editor, C-15

Files, Naming Convention, E-2

From, Transfer, C—22

G

Gated

Carrier to Noise, 2-46

CSO, 2-47

Generate 2714 UDP, 3-60

Get 2714 Stored Results

Export Results, 3-47

Import Results, 3-47

Get Defaults

Edit Limits File, 3-67

Edit Setups, 3-79

Edit Setups , 2-48

Measurement Setups, 3-71

Get Stored Results from 2714, 3-46

Get Stored Results from 2714/2715, 2-89

Global, Button Bar, 3-86

Global View, 3—39

GPIB, 1-1, 1-10, 3-81, B—1, B—6, B—8, C—26

Address, 2-40

-GPIB Cables, 1—5

Gray, 2—23, 3-39

Green, 2—23, 3—30, 3-39

GVG Switcher Control, C-32
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Hardware Installation, CMP500, 1-4

Hardware Requirements, PC, 1-1

Help, 3-84, B-4, B-5

Channel Table Editor, C-27

Tektronix Help Line, xiii

Help Files, Adding Information, E-3

History, 2-52, 2-66, 2-72, B-9, E-7

Copy, 3-24

Import, 3-14

Limits Files, 3-65

Preferences, 3-53

Results Detail, 3-32

Navigation, 3—33

Status Report, 3-27

Horizontal Scroll Bar, 3-7

Hum/LFD, Glossary—1!

ICPM, 3-74

Restrictions, 2-47

ICR, E-9

ICR Test Line, Channel Information, C—30

Import, 3-14, B-9

Channel Number, 3—14

Channel Table, 3—14

Error, 3—15

History, 3-14

Site, 3-14

View Filter, 3-42

Import Channel Criteria, Get 2714/2715 Stored Results,

2-93

Import Results

Get 2714 Stored Results, 3-47

Get 2714/2715 Stored Results, 2-91

In Channel Response, 2-48, Glossary—1

Edit Setups, 3-74

Include in Transfer, Channel Information, C-31

Insert, Channel Table Editor, C-18

Intercepting an Alarm, 2-55, 3-55

L

Limit Check, Channel Table Editor, C-25

Limits

Button Bar, 3-86

Lower, 2-81, 3-66

Upper, 2-81

Visual Carrier Level Differences, 2-84

Limits command button, 2-80
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Limits File, 2-23, 2-79, 3-64, B-4, E-5

Attach to a Channel, 2-83

Edit, 2-83

Remove from a Channel, 2-83

Limits sub-directory, 3-66

Load a Channel Table, C-9

Maximize, 3-10

Channel Table Editor, C-15

Maximize Button, 3-4

Meas Sel, 2-17, 2-19

Button Bar, 3-86

Meas Seq, 3-46, 3-56

Button Bar, 3-86

Measure, 3-45

Measurement, Setups

Modulation Depth, 2-46

VM700A Source, 2-47

Measurement Execution, 2—54

Measurement Header, 3-6

Measurement Limits, 2-80, 3-64

Measurement Sequence, 2—78, 3-56, B—3, B—10

FCC Headend Measurements, D-—3

Generate 2714 UDP, 3-60

Switching to Other Applications, 2-29, 3-46

UDP, 2-88

View Filter, 2—30

Measurement Sequence Results, 2-76, 3-43

Disabled Commands, 3-43

Measurement Setups, 2-41, 3-70

Carrier to Noise, 2-46

CSO, 2-47

CTB, 2-47

In Channel Response, 2-48

UDP, 2-86

VITS, 2-47

Measurement Summary, 3-38

from Global View, 3-39

Results Detail, 3—33

Status Report, 3-27

Measurements, Switching to Other Applications, 2-20

Measurements and Channels, 2—73, 3-40

View Used, 3-42

Memory, B-3, B—9

Menu Bar, 3-11

Minimize, 3-10

Channel Table Editor, C-14

Minimize Button, 3-4

Modulation Depth, 2-46, Glossary—2

Edit Setups, 3-73

Index-4

Mouse, 3-8

Mouse Button

Double-—Click, Left, 3-45

Right, 2-22, 2-60, 2-65, 3-26, 3-32

Move, 3-9

Channel Table Editor, C-14

MSMT.DLL, E4

MSMTREAL.DLL, E4

MSMTSTUB.DLL, E+

N

Navigation, Results Detail, 3-32

New, 3-11

Channel Table, 3-12

Channel Table Editor, C-15

Description, 3-12

Site, 3-12

Non-US countries, Measurement Sequence changes,

2-31

Notes, 3-33

Number, 3-5

Number of Channels

Edit Table Info, C—19

maximum, C—19

fe)

Offset Frequency, Channel Information, C—31

Older CSS500 Versions, E-4

Open, 3-13

Button Bar, 3-86

Channel Table Editor, C—-15

Open Limits File, Edit Limits File, 3-67

Operator Input, UDP, 3-62

Organizing, D-1

Out of Bounds Limits, Channel Table Editor, C-11

Pp

PAL VITS, 2-47

Parameters, 2-85, 3—70

pasting into Word for Windows, 3-24

Pause Execution, 2-55

Pause on Measurement Alarm, E-7, E-8

Preferences, 3-54

Pause on New Channel, 2—54, E-7

Preferences, 3-54

Pesa Switcher Control, C—32

Picture, 2-35, 3-40, B—5

ports, C—26
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Power Line Frequency, E-8 S

2714 Measurement Setups, 3-72

Preamp Save, 3-13

2714 Measurement Setups, 3-72 Button Bar, 3-86

2715, 2-43 Channel Table Editor, C-16

TDC-—10 Measurement Setups, 3—72 Save As, 3-13

Preferences, 2-51, 3-52 Channel Table Editor, C-16

Carrier Levels Units, 2-54 Save as Default, Worksheet Info, 3-51

History, 2-52 Save as Defaults

Measurement Execution, 2—54 Edit Limits File, 3-67

Pause Execution, 2—55 Edit Setups, 2-49, 3-80

Pause on New Channel, 2-54 Measurement Setups, 3-71

Prompt for Signal Connection, 2—54 Save As Limits File, Edit Limits File, 3-67

UDP, 2-86, 3-60 SAW, E-11

Print, 2-35, 3-17 Scrambling, 2-18

Button Bar, 3-86 Channel Information, C—30

Channel Table Editor, C-16 Select

Portrait or Landscape, 2-36, 3-18 Channel Table Editor, C-24

Print Setup, 3-22 Column, 2-13

Channel Table Editor, C—17 Row, 2-13

Printing, Expand Columns, 2-37, 3-17 Select All, 3-25

Program, 3-5 Sequence, 3-46

Channel Information, C—29 Setup, command button, 2-41

Prompt for Signal Connection, 2-54, E-7 Setups, Button Bar, 3-86

Short Time Distortion, 3—7

Site, 2-5, 3-5, 3-12, 3-14, B+, E-6

Q Get 2714 Stored Results, 3-47
Loa, . UDP, 3-63, D-10

Quiet Line, Channel Information, C—30 Worksheet Info, 3-50

Size, 3-10

R Channel Table Editor, C-14

Software Installation, 1-2

Red, 2-23, 3-30, 3-39 Sort, Channel Table Editor, C-20

Repeat Interval, Measurement Sequence, 3-60 Start Time, Measurement Sequence, 3-59

Report out RS—232, Error, Caution, Alarm, 2-55 Status, 2-63, 3-26

Restore, 3-9 Button Bar, 3-86

Channel Table Editor, C—14 Status Report, 2-62, 3-26

Restore Button, 3-4 from Global View, 3-40

Result Detail, From Global View, 3-39 Measurement Summaries, 3—27

Results, 2-60, 2-65 Summary Limits, 2-84, 3-69

Button Bar, 3-86 Switch To, 3-10

Results Detail, 2-60, 3-32, B4 Channel Table Editor, C-15

Notes, 3-33 switcher, delay flag, 1-8

Results Detail Display, 2-60, 2-65 Switcher Control String, C—26

Navigation, 2-61 Channel Information, C—31

RFM150 Channel Type, Channel Information, C—29 Sync Polarity, Channel Information, C—31

RFM150 CN BW, Channel Information, C—30

RFM150 Second Aural Offset, Channel Information,

C-30 T
rene nto 3-82, Bo; 0-28 T-Channels, C-12, C-13

RS-—232 Violations Reporting, 1-10
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Table Information List Box, Channel Table Editor,

C29

Table Name, Edit Table Info, C-19

Tag, 3-5

Channel Information, C—29

TDC-10, 1-7

Preamp, 2-43, 3-72, E-8

TDC-—10 Aural Offset, Edit Table Info, C-19

Test ID, 2-5, 3-5, 3-52, B4, E-6

All Test IDs, 3-52

Button Bar, 3-86

Results, 2-78

UDP, 2-86, 3-60

View Filter, 3-44

Worksheet Test ID, 3-52

Test Pulse Offset, Channel Information, C—31

Title Bar, 3-3

To, Transfer, C-22

Transfer, B—-6

Channel Table Editor, C—21

To, C-9

Trap, E-11

Tune to Channel, 3-46

Picture, 2—35

TV 1350, 1-5

Channel Tables, 2-51, C—-12

Selecting, 2-39

Switch Signal Message, 2-21

Wiring Diagram, F—3

Zero Carrier Pulse, 3—72

U

UDP, 2-86, 3-60, B—2, B-4, Glossary—2

Defining, 2-86

Running, 2-88

Upper Limits, 3-66

Use ICR, Channel Information, C—30

Use Quiet, Channel Information, C—30

Use White, Channel Information, C—30

V

Vertical Scroll Bar, 3-7

Video Driver, 3-40

Video Polarity, Channel Information, C—31

Video Standard, B—6

Edit Table Info, C-19

View, 3-26

Channel Table Editor, C—20

View Fields, Channel Table Editor, C-28

Index-6

View Filter, 2-66, 2-73, 3-42, B4, B-9, B-10

Measurement Results, 3-70

Measurement Sequence Results, 2-30, 2-76, 3-43

Measurements and Channels, 2-73, 3-40

Status Box, 2—5, 3-5, 3-41, 3-43, 3-44

Test ID, 3-44

Test ID Results, 2-78

View Used, 3-42

View Results Detail

Status Report, 3-30

View Violations, 3-31

View Used, 3-42

Measurement and Channel View Filter, 2-37

View Violations, 2-63, 3-30

Status Report, 3-30

View Results Detail command button, 2-65

Violations Report, Report Out RS—232, 2-55

Violations Reporting, 1-10

Visual Carrier Frequency, B—7

Limits, 3-66

Visual Carrier Level Differences, 3-69

Visual Frequency, 3-5

Channel Information, C—29

VITS, 2-44, 2-47

NTSC, Edit Setups, 3-76

PAL, Edit Setups, 3-76

VM700A, 2-44

VM700A

Alarm Functions, 3—54

Alarms, 2—55

VITS, 2-44

VM700A Source, 2-47

VM700A Sources, ICPM, 3-74

W

White, 2—23, 3-30, 3-39

White Line, Channel Information, C—30

WIN.INI, E-6

Windows NT, I-1

Wiring Diagram, F—1, F—2

Worksheet, 2—3, 2-5, 3-4

Maximum Size, E-1

Worksheet File, E—5

Worksheet Header, 3-4

Chan Table, 3-4

Site, 3-5

Test ID, 3-5

Worksheet, 3-4

Worksheet Info, 3—50

UDP, 2-86
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Yellow, 2—23, 3-30, 3-39

Zero Carrier Pulse, 243, 3-72, E-8

TV 1350, 3-72

Zero Carrier Reference Pulse, TV 1350, 1-8
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